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Introduction

Read this book if you are new to COMSOL Multiphysics®. It provides an
overview of the COMSOL® environment with examples that show you how to use
the COMSOL Desktop® user interface and the Model Builder. It also provides a
quick introduction to creating applications using the Application Builder as well
as a quick introduction to the Model Manager.

If you have not yet installed the software, install it now according to the
instructions at www.comsol.com/product-download.

In addition to this book, an extensive documentation set is available after
installation. Tutorials can be found throughout the COMSOL website, including
in the Video Gallery at www.comsol.com/videos and on the COMSOL Blog at
www.comsol.com/blogs.


www.comsol.com/video/
www.comsol.com/blogs
http://www.comsol.com/product-download

COMSOL Desktop®

MODEL MANAGER — Click this button to switch to
the Model Manager for managing different versions of

your models.

APPLICATION BUILDER —
Click this button to switch to
the Application Builder and
start building an application
based on your model.

MODEL BUILDER
TOOLBAR

MODEL TREE — The model

tree gives an overview of the

model and all of the functionality
and operations needed for
building and solving a model as
well as processing the results.
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QUICK ACCESS TOOLBAR — Use these
buttons for access to functionality such as file
open/save, undo/redo, copy/paste, and delete.

- Home| Definitions Geometry ~Materials  Physics Mesh  Study Results  Developer

. a=Variables - = Import
A & P ) . =
= () Functions = calivelink + x
Application  Model  Compenent Parameters Build Add
Builder  Manager Component - - All Material
Workspace Model Definitions Geometry Materials
Maodel Builder - #|| Settings ~ * | Graphics
& Et- Elv S v Geometry @ a @~
4 4 Untitled.mph (root) uild Al
4 () Global Definitions
P Parameters 1 Label: Geometry 1 =
%) Materials .
4 @ Component 1 (comp1) - Unfis
» = Definitions [7] Scale values when changing units
pAfAiGeometryy) Length unit:
55 Materials
4 B Heat Transfer in Salids (ht) m -
Angular unit
Degrees -
2 Thermal Insulation 1
N
£ Mesh 1 ~ Advanced
4 o Study 1
[7= Step 1: Stationary Geometry representation:
> B Results CAD kernel -
[] Design Module Boolean operations
Default repair tolerance:
Automatic -

MODEL BUILDER —

The Model Builder window
with its model tree and the
associated toolbar buttons
gives you an overview of the
model. The modeling process
can be controlled from
context-sensitive menus
accessed by right-clicking a
node.

uild new operations automatically

Build automatically when leaving geametry

SETTINGS WINDOW —
Click any node in the model
tree to see its associated

Settings window displayed next z
to the Model Builder. V\L,x

Messages X

H;

Progress

n
eat Transfer  Add Buil
inSolids = Physics = Mes
Physics
LRGNy
Log Table



RIBBON — The ribbon tabs have buttons
and drop-down lists for controlling all
steps of the modeling process.

Untitled.mph - COMSOL Multiphysics

= b o &
iild  Mes| Compute Study Add Add Plot Add
esh 1+ 1+ Study Group - Predefined Plot

Mesh Study Results

Crlm- ®-@-

GRAPHICS WINDOW TOOLBAR

& 1

Windows _ R

es|

Layout

x2@- B EEe- @B

GRAPHICS WINDOW — The Graphics window presents
interactive graphics for the Geometry, Mesh, and Results nodes.
Operations include rotating, panning, zooming, and selecting.

INFORMATION WINDOWS — The Information windows will display vital
model information during the simulation, such as the solution time, solution
progress, mesh statistics, solver logs, and, when available, results tables.

1.01 GB | 1.37 GB
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The screenshot on the previous pages is what you will see when you first start
modeling in COMSOL Multiphysics using the Model Builder. The COMSOL
Desktop® user interface provides a complete and integrated environment for
physics modeling and simulation as well as application design, providing you with
the tools necessary to build a user-friendly interface for your models. You can
customize the desktop to your own needs. The windows can be resized, moved,
docked, and detached. Any changes you make to the layout will be saved when
you close the session and available again the next time you open COMSOL
Multiphysics. As you build your model, additional windows and widgets will be
added. (See page 28 for an example of a more developed desktop.) Among the
available windows and user interface components are the following;:

Quick Access Toolbar

The Quick Access Toolbar gives access to functionality such as Open, Save, Undo,
Redo, Copy, Paste, and Delete. You can customize its content from the Customize
Quick Access Toolbar list (the downward-facing arrow to the right of the toolbar).

Ribbon

The ribbon at the top of the desktop gives access to commands used to complete
most modeling tasks. The ribbon is only available in the Windows® version of the
COMSOL Desktop environment and is replaced by menus and toolbars in the
macOS and Linux® versions. Click the Application Builder button to switch from
the Model Builder to the Application Builder and start building an application
based on your model.

Settings Window

This is the main window for entering all of the specifications of the model,
including the dimensions of the geometry, properties of the materials, boundary
conditions and initial conditions, and any other information that the solver will
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need to carry out the simulation. The picture below shows the Settings window for
the Geometry node.

Model Builder ~ *|| Settings w1
® Er - = Geometry
4 4@ Untitled.mph (root) {58 Build All
4 () Global Definitions
Pi Parameters 1 Label: Geometry 1 =
Materials .
4 |§ Component1 (comp1) -~ UniE
L Definitions [] Scale values when changing units
I Geom.etry‘l Length unit:
2 Materials
4 [F Heat Transfer in Solids (ht) (L v
= Solid 1 Angular unit:
Dmm i
:3-' Initial Values 1 . o .
s Thermal Insulation 1
& Mesh 1 ¥ Advanced
4 o Study 1
[= step 1: Stationary Geormetry representation:
b B Results CAD kernel -
[] Design Medule Boolean operations
Default repair tolerance:
Automatic -
Build new operations automatically
Build automatically when leaving geometry
Plot Windows

These are the windows for graphical output. In addition to the Graphics window,
Plot windows are used for visualizing results. Several Plot windows can be used to
show multiple results simultancously. A special case is the Convergence Plot
window, an automatically generated Plot window that displays a graphical
indication of the convergence of the solution process while a model is running.

Information Windows
These are the windows for nongraphical information. They include:

* Messages: Various information about the current COMSOL Multiphysics
session is displayed in this window.

* Progress: Progress information from the solver in addition to stop buttons.

* Log: Information from the solver, such as the number of degrees of freedom,
solution time, and solver iteration data.

e Table: Numerical data in table format as defined in the Results node.

* External Process: Provides a control panel for cluster, cloud, and batch jobs.
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Other Windows
The Windows drop-down list in the Home tab of the ribbon gives you access to all
COMSOL Desktop windows. On macOS and Linux®, you will find this in the

Windows menu. In addition to the windows described earlier, you can access the
following windows:

Add Physics and Add Multiphysics: Expand the physics interfaces in a model.
Add Study: Change the type of study.

Add Predefined Plot: Add a predefined plot associated with a physics interface.
Predefined plots are only available for certain physics interfaces.

Add Material from Library and the Material Browser: Access the material
property libraries.

Application Libraries: Choose among the collections of MPH-files containing
tutorial models and runnable applications with accompanying documentation.

Part Libraries: Load one of the predefined parameterized geometry models.

Add-in Libraries: Load one of the add-ins that provides customized
functionality.

Selection List: Show a list of geometry objects, domains, boundaries, edges,
and points that are currently available for selection.

Properties: View model tree node properties.

Auxiliary Data: View auxiliary data associated with the model such as
interpolation files or CAD files.

Debug Log: Display debug information for methods.
Table: Display results in table format.

External Process: Control COMSOL Multiphysics processes running
separately.

Comparison Result: Compare the Model Builder and Application Builder
settings of two MPH-files.

Find and Replace: Enter a search string for finding it in the model’s settings,
tags, labels, tables, etc.

Versions: Display model versions stored in a Model Manager database.
Recovery Files: View recovery files.

Physics Builder Manager: Compile user-defined physics interfaces. This is only
visible if the Physics Builder has been activated in Preferences.

Progress Bar with Cancel Button

The Progress Bar with a button for canceling the current computation, if any, is
located in the lower right-hand corner of the COMSOL Desktop interface.
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Dynamic Help

The Help window provides context-dependent help texts about windows and
model tree nodes. If you have the Help window open in your desktop (by typing
F1, for example), you will get dynamic help (in English only) when you click a
node or a window. From the Help window, you can search for other topics, such
as menu items.

The Model Builder, the Application Builder, and the
Model Manager

The main components of the COMSOL Desktop environment are the Model
Builder, the Application Builder, and the Model Manager.

THE MODEL BUILDER

The Model Builder is the tool where you define the model and its components,
such as how to solve it, the analysis of results, and creating reports. You do that by
building a model tree. The model tree reflects the underlying data structure — the
model object — which stores the state of the model including settings for
geometry, mesh, physics, boundary conditions, studies, solvers, postprocessing,
and visualizations.

THE APPLICATION BUILDER

The Application Builder allows you to quickly create an application (also called an
app) with a specialized user interface that is easy to use. An application is typically
based on a model created with the Model Builder. The Application Builder
provides two important tools for creating applications: the Form Editor and the
Method Editor. In addition, an application can have a menu bar or a ribbon. The
Form Editor includes drag-and-drop capabilities to easily access and include user
interface components, such as input fields, graphics windows, and buttons. The
Method Editor is a programming environment that, for example, allows you to
modify the model represented by the model object data structure. You can also
use the Method Editor to add user interface logic and auxiliary functionality to an
application. The Java® programming language is used to write code in the Method
Editor, which means that all Java® syntax and Java® libraries can be used.

In the Method Editor, program code is stored in methods. A method is another
name for what is known in other programming languages as a subroutine,
function, or procedure. Methods can be used to modify the model object data
structure in the Model Builder and the Application Builder. A method can be used
both for modifying the model object of the current session and for modifying the



model object in a running application. For a quick introduction to the Application
Builder, see “Building an Application with the Application Builder” on page 109.

THE MODEL MANAGER

The Model Manager is a workspace for simulation data management. It allows you
to collaborate with other users and centrally organize models and apps. The
Model Manager provides version control to track changes and updates to your
files. It will aid you in storing only relevant data of MPH-file drafts and revisions.
The Model Manager includes an advanced search tool that allows you to search
the models and applications stored in a Model Manager database for contents
based on keywords or tags. Depending on your license type, you can connect to a
local or remote Model Manager database. For a quick introduction to the Model
Manager, see “Using the Model Manager” on page 178.

FURTHER READING

This book, Introduction to COMSOL Multiphysics, gives a detailed introduction
to using the Model Builder and a quick introduction to the Application Builder
and the Model Manager. For detailed information on how to use the Application
Builder, including the Form Editor and Method Editor, see Introduction to
Application Builder and the Application Programming Guide. For more
information on the Model Manager, see the Reference Manual and the Model
Manager Manual.

Applications, COMSOL Server™, and COMSOL
Compiler™

The Application Builder is included in the Windows® version of COMSOL
Multiphysics. With a COMSOL Multiphysics license, apps can be run from the
COMSOL Desktop environment. Although applications cannot be built with the
macOS or Linux® versions of the software, applications can still be run with
COMSOL Multiphysics on those platforms.

With a COMSOL Server™ license, applications can be run in major web browsers
on a variety of operating systems and hardware platforms. In addition, you can run
applications by connecting to COMSOL Server with an easy-to-install COMSOL
Client for Windows®.

The COMSOL Client for Windows® allows a user to run applications that require
a LiveLink™ product for CAD (this functionality is not available when running
applications with a web browser).
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Running applications in a web browser does not require any installation and no
web browser plug-ins are needed. Running an application in a web browser
supports interactive graphics in 1D, 2D, and 3D. In a web browser, graphics
rendering in 3D are based on WebGL™ technology, which comes with all major
web browsers. In addition, there is a COMSOL Client version for Android®
available in the Google Play™ store.

To create an application based on your model,

click the Application Builder button, accessible W Home  Definitions  Geometry

from the Home tab on the ribbon. A : &

By using COMSOL Compiler™ you can compile Application Model | Component

your application (MPH-file) to an executable file B”"'.jerl T I . C|°|”
Worl (space vicde

for Windows®, Linux®, and macOS. You can
freely distribute the executable and it can be run
without any license file.

For more information on creating COMSOL applications, refer to the section
“Building an Application with the Application Builder” on page 109 and the book
Introduction to Application Builder.
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Preferences

Preferences are settings that affect the modeling environment. Most are persistent
between modeling sessions, but some are saved with the model. You access the
preferences from the File menu by selecting Preferences.

@ Preferences X
= Graphics
I Application Builder Rendering: OpentL .
Client-Server
I Computing Optimizefor. |~ Quality -
b Email Antialiesing:  Medium -
I Files
I Geometry Detail: Normal -
4 Graphics Enable antialiasing for on-screen transparency effects
Defauit 30 View Showlogo on canvas
Display Format
Fonts Logo file: 15 Browse
4 Interaction Show mouse coordinates when drawing
Rotation Center [] Use software rendering for image export
Mouse
Selections
Clipping
Hovering
Toolbars
I Help
I Libraries
Mesh
I Model Builder
Model Manager
I Physics Builder
I Results
Save
b Security
Updates
I UserInterface
Factory Settings
Factory Settings for Al Import..  Export.. oK Cancel

In the Preferences window, you can change settings such as graphics rendering, the
number of displayed digits for results, the maximum number of CPU cores used
for computations, or paths to user-defined application libraries. Take a moment to
browse your current settings to familiarize yourself with the different options.

GRAPHICS AND PLOT WINDOWS

In the Graphics page, there are three graphics rendering options available:
0penGL®, DirectX®, and Software Rendering. The DirectX® option is not available
in macOS or Linux®, but is available in Windows® if you choose to install the
DirectX® runtime libraries during installation. If your computer does not have a
dedicated graphics card, you may have to switch to Software Rendering for slower
but fully functional graphics. A list of recommended graphics cards can be found
at:

www.comsol.com/system-requirements
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COLOR THEMES

In the User Interface > Color Themes page, there are three color theme preferences:

* Desktop color theme: Choose between a Default, Light, or Dark theme for the
COMSOL Desktop environment.

* Graphics color theme: Choose a color theme for the Graphics window.

 Image export color theme: Choose a color theme for exported images.

Color Themes

Desktop color theme: | Default - |
Graphics color theme: Light
|Dark |

Image export color theme:  poga

When using the Dark theme in Linux®, some controls take their color from the
operating system’s theme. You will get a better user experience by picking both a
dark-looking theme in Linux® and the Dark theme in the COMSOL Desktop

environment.

| 15



Opening and Saving Files from the File Menu

The File menu provides several options for opening and saving model files on the
COMSOL MPH-file format, as well as a few other supported formats.

eDE R » {

Home  Definitions  Geometry  Sketcl

[ New Ctrl+N
[ Run Application

& Open Ctrl+0

P Open From Ctrl+Shift+0
Recent r

[l Application Libraries

Save Ctrl+5

[ Save As

L2 SaveTo Ctrl+Shift+S
=] Revert to Saved

ek

Compact History

COMSOL Multiphysics Server 3
Help r
7 Licensed and Used Products

Preferences

Exit

* New lets you create a new model from scratch.

* Run Application opens and runs an application if a runnable application
definition is available in the chosen MPH-file.

* Open opens an existing file

. @ Open X
from the file system using ¢ 5 v B T s v s o ol o semcoma
the Open dialog box. Sgimo Dot > D C

# Quick access teme

[ This PC

& Network

e [ ] A1 COMSOLFies s "
o
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¢ Open From opens

ShEER >

an existing file Home Defntons Geomey Sech  MoteisPhyscs Meh Sty R Devloper
from either the file Open
System Or from a LD/‘ o 9 ¥ v 2of2results shown -
Model Manager Modeing Sampe st e
d b Oct 29, 2021, 9:00:52 AM (bjorn)
ata ase (See Add Datzbase |:| Structural analysis of a wrench
“Uslng thc Model r'ﬁmwse Oct 25, 2021, 4:51:03 PM (bjorn)
Manager” on page
178).

* Recent opens a recently opened file from the file system or from a Model
Manager database.

* Application Libraries opens a tutorial model or a runnable application from the
Application Libraries.

» Save saves the current file.

* Save As lets you save the
@ SaveAs x
current file to the file system | . ., s vosono » comar
with a new name using the Zmac R S

Name Datc

Save As dialog box. FOET e

@ OneDiive

0 This PC

& Network

< >

File name: | carburization_and_quenching_of . steel_gear.mph v

Save astype: | COMSOL Application (*.mph) v

 HideFldes e

* Save To lets you

SINhw £ >
save to a Model
Manager database. Save

Save version from draft

Modeling Example
Title: Structural analysis of a wrench

Comments:
Add Database

W& Browse

Save v

* Revert to Saved opens the last saved version of the file and reinitializes the
user interface.
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Creating a New Model

You can set up a model guided by the Model Wizard or start from a Blank Model as
shown in the figure below.

B hwe R

Home  Definitions  Geometry

Model
Wizard

Blank Model

CREATING A MODEL GUIDED BY THE MODEL WIZARD

The Model Wizard will guide you in setting up the space dimension, physics, and
study type in a few steps:

| Start by selecting the space dimension for your model component: 3D, 2D
Axisymmetric, 2D, 1D Axisymmetric, or 0D.

e hw R

File Home  Definitions  Geometry  Sketch  Materials  Physics  Mesh  Study

Select Space Dimension

m 9 | T | —

2D 1D
SU Axisymmetric EE Axisymmetric

2 Now, add one or more physics interfaces. These are organized in a number of
physics branches in order to make them easy to locate. These branches do not
directly correspond to products. When products are added to your COMSOL

18]



Multiphysics installation, one or more branches will be populated with
additional physics interfaces.

Home Definitions ~Geometry ~Sketch  Materials  Physics Mesh  Study Results Developer Temperature

Select Physics Review Physics Interface
Search Heat Transfer in Solids (ht)

b (D Recently Used .

b X AC/DC Dependent Variables

b)) Acoustics Temperature: [T

b #+2 Chemical Species Transport

bl Electrachemistry

[ == Fluid Flow

4 Heat Transfer

[0 Heat Transfer in Solids (ht)
Heat Transfer in Fluids (ht)
& Hesat Transfer in Solids and Fluids (ht)
b | Conjugate Heat Transfer
b (% Radiation
b 3| Electromagnetic Heating
£ Lumped Thermal System (Its)
& {[7] Thin Structures
I @ Heat and Moisture Transport
» {8 Porous Media
b |44 Metal Processing
1 Bioheat Transfer (ht)
2 Curing
Heat Transfer in Pipes (htp)
Thermoelectric Effect

b e Optics
b &) Plasma
Add
Added physics interfaces:
IF) Heat Transfer in Solids (ht)
Remove

@ Space Dimension e Study
Help 0 Cancel  [3] Done
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3 Select the Study type that represents the solver or set of solvers that will be used
for the computation.

File Home  Definitions  Geometry  Sketch  Materials  Physics

Select Study

4 ~db General Studies
E Stationary
[V Time Dependent

4 rcn Preset Studies for Selected Physics Interfaces
[ Thermal Perturbation, Eigenfrequency
[== Thermal Perturbation, Frequency Domain

[~ More Studies

~dt Empty Study

Added study:
[= Stationary

Added physics interfaces:
) Heat Transfer in Solids (ht)

e Physics
Help Q Cancel E’/Done

Finally, click Done. The desktop is now displayed with the model tree configured
according to the choices you made in the Model Wizard.

CREATING A BLANK MODEL

The Blank Model option will open the COMSOL Desktop interface without any
Component or Study. You can right-click the model tree to add a Component of a
certain space dimension, physics interface, or Study.
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File

A

The Ribbon, Quick Access Toolbar, and Graphics Menus

The ribbon tabs in the COMSOL Desktop environment reflect the modeling
workflow and give an overview of the functionality available for each modeling
step, including building simulation applications from your models.

Home  Definitions  Geometry Materials  Physics Mesh  Study Results Developer Temperature (ht)

a pp e, mETT d | X G BA =} W@

) Functions -

Application  Model ~ Component  Add Parameters Build Add Electric  Add Build Mesh  Compute Study Add  Temperature Add Plot Add
Build i - All h 1+ Study (ht) -

uilder

Manager Component - Material |~ Currents - Physics =~ Mesh 1+ Group ~ Predefined Plot

Workspace Model Definitions Geometry Materials Physics Mesh Study Resuts

File
]
Build
Al

Build

The Home tab contains buttons for the most common operations for making
changes to a model, running simulations, and for building and testing
applications. Examples include changing model parameters for a parameterized
geometry, reviewing material properties and physics, building the mesh, running
a study, and visualizing the simulation results.

There are standard tabs for each of the main steps in the modeling process. These
are ordered from left to right according to the workflow: Definitions, Geometry,
Materials, Physics, Mesh, Study, Results, and Developer.

Contextual tabs are shown only if they are needed, such as the 3D Plot Group tab,
which is shown when the corresponding plot group is added or when the node is
selected in the model tree.

GI Home Defintions Geometry Materials Physics Mesh Study Results Developer Temperature (it

W W Bne  Garoatioe Blimege (o g ) CutLine Direction 5 Second Pointfor Cut Plane Normsl
[ Arrow Volume [¥jlsosurface @ Contour K] Mesh Mg Deformation G selecn bl utline  pCutl Qe

™ Surface [B)Arrow Surface = Streamline 7] Annotation Plots + W Filter [ Transparency. Attributes - " Second Point for Cut Line [ First Point for Cut Plane Normal % Cut Plane Normal from Surface

Modal tabs are used for very specific operations, when other operations on the
ribbon may become temporarily irrelevant. An example is the Work Plane modal
tab. When working with work planes, other tabs are not shown, since they do not
present relevant operations.

Home WorkPlane  Sketch  Developer

[ Import ,  @Cide  [OSquae .- @ [ (7] Chamfer €. Cross Section A G FF'F
2 b = - . on ) o
= Export T @dHipse  /IPolygon e ¥ Fillet S Extract e " & X
Sketch ore Booleans and Transforms Conversions

Parts Programming Selections Colors Measure Delete
[E§jInsert Sequence ~ [CRectangle « Point  primitives - Partitions ~ . i " - .

2 Offset  ©, Tangent Delete Sequence

Import/Export Sketch Primitives Operations Other

THE RIBBON VvS. THE MODEL BUILDER

The ribbon gives quick access to available commands and complements the model
tree in the Model Builder window. Most of the functionality accessed from the
ribbon is also accessible from contextual menus by right-clicking nodes in the
model tree. Certain operations are only available from the ribbon, such as selecting
which desktop window to display. In the COMSOL Desktop interface for macOS
and Linux®, this functionality is available from toolbars, which replace the ribbon
on these platforms. There are also operations that are only available from the
model tree, such as reordering and disabling nodes.
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THE QuUICK ACCESS TOOLBAR

The Quick Access Toolbar contains a sct of commands that are independent of the
ribbon tab that is currently displayed. You can customize the Quick Access Toolbar
and add most commands available in the File menu, including commands for
undoing and redoing recent actions, as well as for copying, pasting, duplicating,
and deleting nodes in the model tree. You can also choose to position the Quick
Access Toolbar above or below the ribbon.

THE GRAPHICS MENUS

As an alternative to using the model tree or the ribbon, you can right-click in the
Graphics window to access context-dependent menus. The menus shown will
depend on which node is currently selected in the model tree. By using the Go To
option, when available, you can jump to a context menu for another node in the
model tree.

QaaA- el -k Cr B & @R

Defeaturing and Repair 3

Booleans and Partitions 3

Transforms 3 Array

Conversions v | B8 Copy
I%-' Extract 4 Mirror

Explicit Selection 4 Move

Ml Delete " Rigid Transform
YA Construction Geometry ) Rotate
" Zoom to Selection ”_ﬂ Scale
i Measure
% Hide
Geometric Entity Level 3
Clipping r
Go To r

MACOS AND LINUX®
In the COMSOL Desktop environment for macOS and Linux®, the ribbon is
replaced by a set of menus and toolbars.

File Edit Windows Options Tools Help
D®s =| - ~'g - Componentl v & v P v a= v fo v P, @ [ Ca v i ElectricCurrents » & @ [© @ Meshl v = Study1 v "% Temperature (ht) v & v
gETLavsPawea-B i evnbdeEm-

= Definitions A Geometry :i: Materials %% Physics 4 Mesh ~ Study [£] Results [Z] Developer [ Temperature () E-ARDERIEBED
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The instructions in this book are based on the Windows® version of the COMSOL
Desktop environment. However, running COMSOL Multiphysics and the
COMSOL Desktop environment in macOS and Linux® is very similar, keeping in
mind that the ribbon user interface components can instead be found in the
corresponding menus and toolbars. In addition, the Application Builder is only
available in the Windows® version. However, you can run apps in all supported
operating systems.

The Model Builder and the Model Tree

Using the Model Builder, you build a model by starting with the default model
tree, adding nodes, and editing the node settings.

All of the nodes in the default model tree are top-level parent nodes. You can
right-click on them to see a list of child nodes, or subnodes, that you can add
beneath them. This is the means by which nodes are added to the tree.

When you click on a child node, you will see its node settings in the Settings
window. It is here that you can edit node settings.

It is worth noting that if you have the Help window open, which is achieved either
by selecting Help from the File menu or by pressing the function key F1, then you
will also get dynamic help (in English only) when you click on a node.

THE ROOT, GLOBAL DEFINITIONS, AND RESULTS NODES

A model tree always has a root node (initially
labeled Untitled.mph), a Global Definitions Mode
node, and a Results node. The label on the root
node is the name of the multiphysics model file,
or MPH-file, to which the model is saved. The
root node has settings for author name, default
unit system, and more.

o
ounaer TR

' Stv Elv = v

(1) Global Definitions
@ Component 1 {comp1)
~do Study 1

& Results

4 & Untitled.mph (root)
[
[
[
[

The Global Definitions node has a Parameters and

a Materials subnode by default. The Global Definitions node is where you can,
among other things, define parameters, variables, functions, and couplings that
can be used throughout the model tree. They can be used, for example, to define
the values and functional dependencies of material properties, forces, geometry,
and other relevant features. The Global Definitions node itself has no settings, but
its child nodes have plenty of them. The Materials subnode stores material
properties that can be referenced in the Component nodes of a model.
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The Results node is where you access the solution after performing a simulation
and where you find tools for processing the data. The Results node initially has five
subnodes:

» Datasets, which contains a list of solutions

. Model Builder -3
you can work with. viodel bullde
. - TEELE -

» Derived Values, which defines values to be 4 % Untitiedmph (root)

derived from the solution using a number of b (&) Global Definitions

postprocessing tools. P 1M Component 1 {comp1)

[ ~do Study 1

* Tables, which is a convenient destination for 4 (Bl Results

ik Datasets
£ Derived Values

the Derived Values or for Results generated by
probes that monitor the solution in
real-time while the simulation is running.

. . 55 Reports
» Export, which defines numerical data,

images, and animations to be exported to
files.

* Reports, which collects reports about the model in the HTML, Microsoft®
Word, and Microsoft® PowerPoint formats.

To these five default subnodes, you may also add more Plot Group subnodes that
define graphs to be displayed in the Graphics window or in Plot windows. Some of
these may be created automatically, depending on the type of simulations you are
performing, but you may include additional figures by right-clicking on the Results
node and choosing from the list of plot types. In addition, you can add an
Evaluation Group node, which is similar to the Derived Values node but with tightly
associated Evaluation Group tables, and a Parameters node for parameters used
exclusively in Results.

THE COMPONENT AND STUDY NODES

In addition to the three nodes just described,

there are two additional top-level node types: Mode
Component nodes and Study nodes. These are e sE-E- &~
usually created by the Model Wizard when you
start a new model. After using the Model
Wizard to specify what type of physics you are
modeling and what type of Study (for example,
steady-state, time-dependent,
frequency-domain, or eigenfrequency analysis) you will carry out, the Model
Wizard automatically creates one node of each type and shows you their contents.

o
ounaer TR

(1) Global Definitions
Il Component 1 {comp 1)
[ ~do Study 1

I {8 Results

4 & Untitled.mph (root)
[
[
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It is also possible to add
more Component and Study
nodes as you develop the
model. A model can
contain multiple
Component and Study
nodes and it would be
confusing if they all had
the same name. Therefore,
these types of nodes can be
renamed to be descriptive
of their individual

purposes.

If a model has multiple
Component nodes, they can
be coupled to form a more
sophisticated sequence of
simulation steps.

Note that each Study node
may carry out a different
type of computation, so
each one has a separate
Compute button =.

Materials

= Definitions
Geormnetry 1

2 Materials

4 | Component 1 (comp1)
[
[

4

Y

4 [F Heat Transfer in Solid =

= Solid 1
= Initial Values 1

%= Thermal Insulatid

A Mesh 1
4 o Study 1
[= step 1: Stationary

b {8 Results

=

B

B HmL e @

Add Physics
Add Multiphysics
Insert Physics

Insert Physics From

Moving Mesh r
Deformed Geormetry r
Topology Optimization 3
Shape Optimization r
Parameter Estimation 3
Control Variables r
Add Mesh

Copy as Code to Clipboard 3
Copy

Delete — Del
Rename — F2
Settings

Properties

Help — Fl
Keyboard Shortcuts —

To be more specific, suppose that you build a model that simulates a coil assembly
that is made up of two parts: a coil and a coil housing. You can create two
Component nodes: one that models the coil and another that models the coil
housing. You can then rename each of the nodes with the name of the object.
Similarly, you can also create two Study nodes, the first simulating the stationary
or steady-state behavior of the assembly, and the second simulating the frequency
response. You can rename these two nodes to be Stationary and Frequency Domain.

When the model is complete, save it to a file named Coil Assembly.mph. At that
point, the model tree in the Model Builder looks like the figure below.

In this figure, the root node is named Coil
Assembly.mph, indicating the file in which the
model is saved. The Global Definitions node and
the Results node each have their default name.
Additionally, there are two Component nodes
and two Study nodes with the names chosen in

the previous paragraph.

Mode

—

] ~y
sullder

= =t -

* =fw

4 & Coil_Assembly.mph (root)

(1) Global Definitions

W Coil {comp?)

@ Coil Housing (comp2)
~db Stationary

~dt Frequency Domain

& Results
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PARAMETERS, VARIABLES, AND SCOPE

Global Parameters

Global parameters are user-defined constant scalars that are usable throughout the
model. That is to say, they are “global” in nature. Important uses are:

o Parameterizing geometric dimensions.

* Specifying mesh element sizes.

* Defining parametric sweeps (simulations that are repeated for a variety of
different values of a parameter such as a frequency or load).

A global parameter expression can contain numbers, global parameters, built-in
constants, built-in and user-defined functions with global parameter expressions
as arguments, and unary and binary operators. For a list of available operators, see
“Appendix C — Language Elements and Reserved Names” on page 225. Because
these expressions are evaluated before a simulation begins, global parameters
cannot depend on the time variable, t. Likewise, they cannot depend on spatial
variables like x, y, or z, nor on the dependent variables for which your equations
are solving.

It is important to know that the names of parameters are case sensitive.
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You define global parameters in the Parameters node in the model tree under
Global Definitions.

Model Builder v 1| Sett ngs -
- TE - Elv - || parameters
4 & busbar.mph (root)

; Label: Parameters 1 5

4 () Global Definitions
Fi Parameters 1

¥ Parameters
45 Default Model Inputs

i Materials [
4 i Component1 {camp1) MName Expression Value Description
b = Definitions L 9[em] 0.09m Length
/ Geometry 1 rad_1 6[mm] 0.006 m Bolt radius
/ : = Materials thb 3[mm] 0.005 m Thickness
I 3 Electric Currents (c) whb 5[em] 0.05m Widt.h :
b I Heat Transfer in Salids (ht) mh 3[mm] 0.003 m Maximum element size
I .y Multiphysics hitc SW/m*2/K] 5 W/(m*K) Heat transfer coefficient
b4 Mesh 1 Viot 20[mV] o.02v Applied voltage
4 ~db Study 1
[= Step 1: Stationary
I [fre Solver Configurations P \
i v o L] -
b {8 Results t # u
Marne:
Vot
Expression:
20[mV]
Description:

Applied voltage

Note that you can add multiple Parameters nodes and they will be named
Parameters |, Parameters 2, ctc. In addition, Parameters can be organized into
several cases and then swept over. For more information, see “Parametric Sweeps”
on page 159.

The following spread shows an example of a customized desktop with additional
windows.
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QUICK ACCESS
TOOLBAR

BEOEDI

Home Definitions  Geometry  Materials  Physics  Mesh

A m

Application  Model Component Add
Builder  Manager T+ Component~
MODEL BUILDER Workspace Medel
WINDOW — Model Builder g
- F St Zle e
4 4 autemetive_mufflermph (root)
4 (@ Global Definitions
Py Parameters 1
4 Default Model Inputs
5 Materials
4 [ Compenent 1 fcomp 1)
b = Definitions
» cometry 1
b 522 Materials
4 () Pressure Acoustics, Frequency Domain
B Pressure Acoustics 1
s Sound Hard Boundary (Wall) 1
B Initial Values 1
b (m Plane Wave Radiation 1
MODEL TREE i Plane Wave Radiation 2
i Interier Sound Hard Boundary (Wall
b A Mesh 1
b e Study 1
4 B Results
b % Datasets
£ Derived Values
b B Tables

b\ Acoustic Pressure (acpr)
4 il Sound Pressure Level (acpr)
™ Surface 1
> W Acoustic Pressure, lsosurfaces (acpr)
4 ~% Transmission Loss
& Global 1
Export
[# Reports
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GRAPHICS WINDOW

stomotive_muffler.mph - COMSOL Multiphysics

" & o

Seund Pressure  Add Plot Add
Level (acpr) = Group ~ Predefined

Results

~ "OE
Add
Study

Compute Study Win
1+

lot

Study

mOsG-ag

face: Total sound pressure level (dB)

= & M~

DYNAMIC HELP — Continuously updated with online access to the
Knowledge Base and Application Gallery. The Help window enables
easy browsing with extended search functionality.

=
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- Desktop ~
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INFORMATIONWINDOWS

PROGRESS BAR WITH CANCEL BUTTON

Help
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COMSOL Multiphysics > COMSOL Multiphysics Reference Manual
>The Pressure Acoustics Interface > Fundamentals of Acoustics
> Different Acoustic Interfaces

Different Acoustic Interfaces

Depending on the basic dependent variable used to model the
acoustic field, the acoustical interfaces can be divided into the

following main categories.

Pressure acoustics—The dependent variable is the acoustic
pressure p.

Acoustic-solid interaction—The dependent variables are the
pressure 7 and the displacement field u in the solid. This
type of problem requires the addition of the Acoustics
Module.

Poroelastic waves—The dependent variables are the
pressure p inside the saturating fluid and the total
displacement u of the porous matrix. This type of problem
requires the addition of the Acoustics Module. v

Previous Section Next Section »

Plot 1
aa-BUED &%

-ax
PLOT WINDOW —
The Plot window is

L c i=]

Global: Transmission loss

o
used to visualize

Transmission loss

1 Results quantities,

probes, and
convergence plots.
Several Plot windows
1 can be used to show
multiple results

Transmission loss (dB)

500
Frequency (Hz)

® J
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Results Parameters

For greater flexibility, it is possible to define parameters that are only used in the
Results node. Using these parameters does not require resolving the model.

Model Builder ~ *|| Settings M
&= = Ery Bl E~ Parameters
4 & busbar.mph (root)

b @ Global Definitions v Parameters

> @ Component {comp) "

[~ Study 1 Mame Expression Value Description

4

@ Results iso_level 309.5[K] 309.5K lsosurface level
i Parameters

Datasets
Derived Values
I E Tables

\ —
Result parameters may depend on other parameters and built-in functions.

Variables

Variables have associated Variables nodes in the model tree and can be defined
cither in the Global Definitions node or in the Definitions subnode of any Component
node.

er - 1

Mode

— = =t -

4 & busbar.mph (root)
(1) Global Definitions

b
4 |§ Component1 (comp1)
4 = Definitions
2= Variables 1
I+ g Selections
[:1;] Boundary System 1 {sys1)

b [ View 1

Naturally, the choice of where to define the variable depends on whether you want
it to be global (that is, usable throughout the model tree) or locally defined within
a single Component node. Like a parameter expression, a variable expression may
contain numbers, parameters, built-in constants, and unary and binary operators.
However, it may also contain variables like t, x, y, or z; functions with variable
expressions as arguments; and dependent variables that you are solving for, such
as temperature T or voltage V, in addition to their space and time derivatives.

If you have a model with many Variables nodes it may be useful to group them
together by using the Node Group feature, as shown below.

= Show More Options...

MNode Group
E Group by Type
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Node groups can be used to group nodes in Global Definitions, Definitions under a
Component, Geometry, Materials, physics interfaces, and results.

Variables Used in Applications

Model parameters and variables can be used in applications. For example, you can
let the user of an application change the value of a parameter. In addition, variables
to be used in applications can be defined in the Application Builder, in the
application tree under the Declarations node. Such variables can also be used in
model methods.

Scope

The “scope” of a parameter or variable is a statement about where it may be used
in an expression. All global parameters are defined in the Global Definitions node
of the model tree as a Parameters subnode. This means that they are global in
scope and can be used throughout the model tree.

A variable may also be defined in the Global Definitions node, as a Variables
subnode, and have global scope, but they are subject to other limitations. For
example, variables may not be used in Geometry, Mesh, or Study nodes (with the
one exception that a variable may be used in an expression that determines when
the simulation should stop).

A variable that is instead defined under the Definitions subnode of a Component
node has local scope and is intended for use in that particular Component (but,
again, not in the Geometry or Mesh nodes). They may be used, for example, to
specify material properties in the Materials subnode of a Component or to specify
boundary conditions or interactions. It is sometimes valuable to limit the scope of
the variable to only a certain part of the geometry, such as certain boundaries. For
that purpose, provisions are available in the settings for a variable to select whether
to apply the definition ecither to the entire geometry of the Component or only to
a Domain, Boundary, Edge, or Point.
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The figure below shows the definition of two variables, q_pin and R, for which the
scope is limited to just two boundaries identified by numbers 15 and 19.

Settings -a

Label: |Variables 2 =]
Geometric Entity Selection

Geometric entity level:  Boundary -

Selection: Manual -

15 L ]
= i

& 50 (i)

¥ Variables

W | e Unit Description
q_pin mu/sqrt(3*(1+mu”2))*(r_pin*emega) Ybar(T[1/K])[MPal*step] (T_melt D[I/K) | W/m* | Surface heat source, pin-workpiece interface
R sqrt(x 2y 2) m Distance in xy-plane from toel center axis

H- 550 -
Name:
q_pin
Expression:
mufsqrt(3*(1+ mu2))*(r_pin*emega) “Ybar(T[1/KD[MPa]*step] ((T_melt-T)[1/K])
Description:

Surface heat source, pin-workpiece interface

Such a group of numbers is called a Selection and can be named and then
referenced elsewhere in a model. This can be useful, for example, when defining
material properties or boundary conditions that will use the variable at certain
boundaries but not elsewhere. To give a name to the Selection, click the Create
Selection button ( %) to the right of the Selection list.

Although the variables defined in the Variables node under the Component >
Definitions subnode are intended to have local scope, they can still be accessed
outside of the Component node in the model tree by being sufficiently specific
about their identity. This is done by using a “dot notation”, where the variable
name is preceded by the name of the Component node in which it is defined and
the names are joined by a “dot”. In other words, if a variable named foo is defined
in a Component node named MyModel, then this variable can be accessed outside
of the Component node by using MyModel.foo. This can be useful, for example,
when you want to use the variable to make plots in the Results node. Variables
defined under the Declarations node in the Application Builder are available
globally in form objects and methods but cannot be used in the Model Builder.
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Built-In Constants, Variables, and Functions

COMSOL Multiphysics comes with many built-in constants, variables, and
functions. They have reserved names that cannot be redefined by the user. If you
use a reserved name for a user-defined variable, parameter, or function, the text
you enter will turn orange (a warning) or red (an error) and you will get a tooltip
message if you select the text string.

Some important examples are:
» Mathematical constants such as pi (3.14...) or the imaginary unit i or j

 Physical constants such as g_const (acceleration of gravity), c_const (speed
of light), or R_const (universal gas constant)

e The time variable, t

* First- and second-order derivatives of the dependent variables (the solution)
whose names are derived from the spatial coordinate names and dependent
variable names (which are user-defined variables)

e Mathematical functions such as cos, sin, exp, log, log10, and sqrt

See “Appendix C — Language Elements and Reserved Names” on page 225 for
more information.

The Application Libraries

The Application Libraries are collections of MPH-files containing tutorial models
and runnable applications with accompanying documentation. Tutorial models
show how to use the Model Builder and have documentation that includes
theoretical background and step-by-step instructions. Runnable applications have
instructions on how to use the application. You can readily inspect and edit all
tutorial models and applications to make them your own. Each physics-based
add-on module comes with its own application library with examples specific to its
applications and physics area. You can use the step-by-step instructions and the
MPH-files as a template for your own modeling.
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To open the Application Libraries window, select Application Libraries [ from the
Windows menu on the Home toolbar or from the File menu [. Then, search by
application name or browse under a module folder name.

Application Libraries

( Refresh [F] Update COMSOL Application Libraries () Application Gallery

b 3 COMSOL Multiphysics
b % AC/DC Module
b 9) Acoustics Madule
b 3 Battery Design Module
b [ CAD Import Module
4 fl= CFD Module
[ Applications
[fiil Fluid-Structure Interaction
iff High Mach Number Flow
i Multiphase Flow
iff Nonisothermal Flow
ifi Particle Tracing
ifi Shallow Water Equations
ifi Single-Phase Flow
® backstep
2 gylinder_flow_viscoelastic
O hydrocyclone
O rotating_disk
© turbulent_mixing
@ water_purification_reactor
b [l Thin-Film Flow
b i Verification Examples
b <sf Chemical Reaction Engineering Madule
I €2 Composite Materials Module
I ~=; Corrosion Module
b 3y Design Module
b [ ECAD Import Module
b 1LJf Electrochemistry Module

Avvvvvvw

Run Application [®] Open

@ Open PDF Document

Help €29 Close

Stationary Incompressible Flow over a Backstep

This example solves the incompre]
the size of the recirculation region

Neme
Used products
Physics interfaces

Created in

Computation time
Author

Last modified
Created

backstep

= COMSO
= CFD Mo

Laminar FI

COMSOL

8 seconds
COMSOL

Sep 23, 20
Sep 23, 20

Streamine: velocty feld

Figure 3: The recirculation region visualized using a velocity streamiline plo.

Application Library path: GF0_odule/Single-Phase_Tutorials/backstep

Modeling Instructions

From the File menu, choose New.

NEW
1 In the New window, click Model Wizard,

MODEL WIZARD

1 In the Model Wizard window, click 30.

2 In the Select physics t luid Flow>Single-Phase Flow>Laminar Flow (spf).
3 Click Add.

4 Click study.

Click Open [¢| , Run Application » , or Open PDF Document == . Alternatively,
select Help > Documentation from the File menu to search by application name or
browse by module. Note that the Run Application option is only available for
MPH-files that are runnable applications.

The MPH-files in the Application Libraries can have three formats — Solved
MPH-files, Compact MPH-files, or Preview MPH-files:
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Solved MPH-files, including all meshes and solutions. In the Application
Libraries window, these appear with the @ icon. If the MPH-file size
exceeds 25 MB, a tooltip with the text Large file and the file size appears
when you position the cursor at the model’s node in the Application
Libraries tree.

Compact MPH-files, with all settings for the model but without built
meshes and solution data to save space in the installation. Some MPH-files
have no solutions for other reasons such that the computation time is short
and the results are easily regenerated. You can open these to study the



settings and to mesh and re-solve. It is also possible to download the full
versions — with meshes and solutions — of most of these when you update
your Application Libraries. These appear in the Application Libraries window
with the 3 icon. If you position the cursor at a compact file in the
Application Libraries window, a No solutions stored message appears. A solved
version is available for download via the Application Library Update (except
in a few cases where the file is a template related to another, regular, model).

¢ Preview MPH-files, with only a model description and thumbnail image
available. These appear in the Application Libraries window with the icon.
The file is a preview of an application or a model file, including the model
description and information about used products and physics interfaces and
the computation time. Solved and compact versions are available for
download. Model documentation will be available if you have specified the
use of online help (see the Reference Manual for details on how to do this).

The Application Libraries are updated on a regular basis by COMSOL. To check
all available updates, click Update COMSOL Application Libraries [] at the top of the
Application Libraries window. You can also find this option from the File > Help
menu (Windows® users) or from the Help menu (macOS and Linux® users). This
connects you to the COMSOL website, where you can access new applications
and the latest updates.

Application Libraries

C* Refresh |} Update COMSOL Application Libraries| () Application Gallery
| Search

b [@ COMSOL Multiphysics
b % AC/DC Module
[ 1)) Acoustics Module

If your computer has internet connection, then you can click the Application
Gallery button to access a wide range of additional examples from the COMSOL
website.
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Workflow and Sequence of Operations

In the Model Builder window, every step of the modeling process, from defining
global variables to the final report of results, is displayed in the model tree.

r - 1

4 4 backstep.mph (root)
4 () Global Definitions
Fi Parameters 1
45 Default Model Inputs
= Materials
4 |§ Component1 (comp1)
[ = Definitions
Geormnetry 1
Materials

Laminar Flow (sgf)

s Fluid Properties 1
= Initial Values 1
T Wall1
= Inlet
= Symmetry 1
= Outlet 1
A Mesh 1
4 o Study 1
[= Step 1: Stationary
I [fre Solver Configurations
4 ([ Results
I #: Datasets
£ Derived Values
B Tables
I Ni@ Velocity (spf)
I Ni@ Pressure (spf)
4 @ Velocity, Streamlines
4 3= Streamline 1
5 Color Expression 1
Export
[# Reports

From top to bottom, the model tree defines an orderly sequence of operations.

In the following branches of the model tree, the node order makes a difference
and you can change the sequence of operations by moving the subnodes up or
down the model tree:

¢ Geometry

* Materials

¢ Physics

* Mesh

¢ Study

* Plot Groups
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Nodes may be reordered by these methods:

* Drag-and-drop

» Right-clicking the node and selecting Move Up or Move Down
¢+ Pressing Ctrl + Up arrow or Ctrl + Down arrow

In other branches, the ordering of nodes is not significant with respect to the
sequence of operations, but some nodes can be reordered for readability. Child
nodes to Global Definitions is one such example.

You can view the sequence of operations presented as program code statements by
saving the model as a Model File for MATLAB® or as a Model File for Java® after having
selected Compact History in the File menu. Note that the model history keeps a
complete record of the changes you make to a model as you build it. As such, it
includes all of your corrections, including changes to parameters and boundary
conditions and modifications of solver methods. Compacting this history removes
all of the overridden changes and leaves a clean copy of the most recent form of
the model steps. In the Application Builder, you can use the Record Method option
to view and edit program code statements in the Method Editor.

As you work with the COMSOL Desktop interface and the Model Builder, you
will grow to appreciate the organized and streamlined approach. However, any
description of a user interface is inadequate until you try it for yourself. In the next
chapters, you are invited to work through two examples to familiarize yourself
with the software.
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Example |: Structural Analysis of a Wrench

This simple example requires none of the add-on products to COMSOL
Multiphysics®. For more fully featured structural mechanics models, see the
Structural Mechanics Module application library.

At some point in your life, it is likely that you have tightened a bolt using a wrench.
This exercise takes you through a structural mechanics model that analyzes this
basic task from the perspective of the structural integrity of the wrench subjected
to a worst-case loading.

The wrench is, of course, made from steel, a ductile material. If the applied torque
is too high, the tool will be permanently deformed due to the steel’s elastoplastic
behavior when pushed beyond its yield stress level. To analyze whether the wrench
handle is appropriately dimensioned, you will check if the mechanical stress level
is within the yield stress limit.

This tutorial gives a quick introduction to the Model Builder workflow. It starts
with opening the Model Wizard and adding a physics option for solid mechanics.
Then a geometry is imported and steel is selected as the material. You then explore
the other key steps in creating a model by defining a parameter and boundary
condition for the load; selecting geometric entities in the Graphics window;
defining the Mesh and Study; and finally, examining the results numerically and
through visualization.

If you prefer to practice with a more advanced model, read this section to
familiarize yourself with some of the key features, and then go to the tutorial
“Example 2: The Busbar — A Multiphysics Model” on page 72.
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Model Wizard

I To start the software, double-click the COMSOL
Multiphysics icon on the desktop, which will take you to
the New window with two options for creating a new
model: Model Wizard or Blank Model.

If you select Blank Model, you can right-click the root node

in the model tree to manually add a Component and a Study.
For this tutorial, click the Model Wizard button. G Mol
If the COMSOL Desktop user interface is already open, Wizard
you can start the Model Wizard by selecting New from the

File menu. Choose the Model Wizard.

Blank Model
The Model Wizard will guide you through the first steps of
setting up a model. The next window lets you select the
dimension of the modeling space.

2 In the Select Space Dimension window, select 3D.

@ a -+ o -+ —

2D 1D
Axisymmetric 2E Axisymmetric e e
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3 In Select Physics, sclect
Structural Mechanics > Solid
Mechanics (solid) = . Click Add.

Without add-on modules, Solid
Mechanics is the only physics
interface available in the
Structural Mechanics folder. In
the picture to the right, part of
the Structural Mechanics folder
is shown as it appears when all
add-on modules are available.

Click Study © to continue.

Click Stationary i~ under General
Studies. Click Done & once you
have finished.

General Studies and other preset
studies have solver and equation
settings adapted to the selected
physics, which is, in this example,
Solid Mechanics. A Stationary
study is used in this case — there
are no time-varying loads or
material properties.

Any selection from the More Studies branch -« requires
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Select Physics

(D Recently Used
% AC/DC
1)) Acoustics
2% Chemical Species Transport
Il Electrochemistry
Fluid Flow
Heat Transfer
e Optics
@ Plasma
1 Radio Frequency
£ Semiconductor
4 53 Structural Mechanics
= Solid Mechanics (solid)
[ Shell shell)
€2 Layered Shell (Ishell)
[7] Membrane (mbrn)
i Beam (beam)
Truss (truss)
b, Wire (wire)
@2 Multibody Dynamics (mbd)

Added physics interfaces:
=5 Solid Mechanics (solid)

e Space Dimension
Help € Concel [ Done

Select Study

4 ~dv General Studies

[ Eigenfrequency
Frequency Damain

— Stationary
[V Tirme Dependent

Added study:
[= Stationary

Added physics interfaces:
£ Solid Mechanics (solid)

Search

©

Remove

€ o

manual settings.



Geometry

This tutorial uses a geometry that was previously created and stored in the
COMSOL native CAD format, .mphbin. To learn how to build your own
geometry, see “Appendix A — Building a Geometry” on page 201.

The location of the Application Library that contains the file used in this exercise
varies based on the software installation and operating system. In Windows®, the
file path will be similar to:

C:\Program Files\COMSOL\COMSOL61\Multiphysics\applications.
Now, import the ready-made geometry file as follows.

I In the Model Builder window, under Component I, right-click Geometry | 2 and
select Import =.

~
Builder =4

Mode

+~— = Et - E

il
—
4
4

4 & Untitled.mph (root)
4 () Global Definitions
Fi Parameters 1
2 Materials
4 |§ Component1 (comp1)
[
3

= Definitions
G Geometry 1
i Materials | B Build Al Fs
e @::hd.Mecha. 2 (i
imw Linear Eli
S Freel Livelink Interfaces »

= Initial Val & Block
A5 Mesh 1

4 b Study 1 Eone

As an alternative, you can use the ribbon and click Import = from the Geometry
tab.
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2 In the Settings window for Import, from the Source list, if not already selected,
select COMSOL Multiphysics file.

Settings
mpEort

[ Build Selected »  [E8 Build All Objects 2
Label: Import1

¥ Import

Source:

COMSOL Multiphysics file G

Filename:

C:\Program Files\COMSOL\COMSOLE1\Multiphysics_final\applications\ COMSOL_MultiphysicsiStructural_Mechanics\wrench.mphbin

W& Browse * [[& Import G

Include result from virtual operations

3 Click Browse and locate the file wrench.mphbin in the application library folder of
the COMSOL installation folder. Its default location in Windows® is

C:\Program Files\COMSOL\COMSOL61\Multiphysics\applications\
COMSOL_Multiphysics\Structural_Mechanics\wrench.mphbin

Double-click to add or click Open.
4 Click Import. The geometry is now displayed in the Graphics window.

In the Import section, there
are two options for locating
a file for import: Browse and
Browse From. The Browse
option lets you import a file
from the file system using
the Open dialog box. The
Browse From option lets you
browse from either the file
system or a Model Manager

database.
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Settings

rrRort

[ Build Selected = [E8 Build All Objects 2

Label: Import1

¥ Import
Source:
COMSOL Multiphysics file
Filename:
wrench.mphbin
W& Browse = [& Import
[ & Browse erations

] = Browse From lties
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5 Click the wrench geometry in the Graphics window and then experiment with
moving it around. As you point to or click the geometry, it changes color. Click
the Zoom In @, Zoom Out © , Go to Default 3D View ..., Zoom Extents [, and
Transparency & buttons on the Graphics window toolbar to see what happens to
the geometry:

- To rotate, click and drag anywhere in the Graphics window.
- To move, right-click and drag.

- To zoom in and out, click the mouse scroll wheel, continue holding it, and
drag.

- To get back to the original position, click the Go to Default 3D View .- button
on the toolbar.

Graphics -
Qa@- @@ LrkiEn - By @@ B 26 @ EDe-c@B o S-ad
o
%103 m
5

Rotate: Click and drag 10

Pan: Right-click and drag

Also see “Appendix B — Keyboard and Mouse Shortcuts” on page 218 for
additional information.

The imported model has two parts, or domains, corresponding to the bolt and the
wrench. In this exercise, the focus will be on analyzing the stress in the wrench.
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Materials

The Materials node = stores the material properties for all physics and all domains
in a Component node. Use the same generic steel material for both the bolt and
tool. Here is how to choose it in the Model Builder.

I Open the Add Materials window.

You can open the Add Materials
window in either of these two

ways:

- Right-click Component | >
Materials :: in the Model Builder
window and select Add Material
from Library :; .

G i Materials
A

=5 Solid Mec| ":i  Add Material from Library

05 Linear B Browse Materials
G Freel
B Initial | *a  Blank Material
£ Mesh 1 Layers .

- From the ribbon, select the Home tab and then click Add Material.

2 In the Add Material window, click to

expand the Built-In folder. Scroll down
to find Structural steel, right-click, and
select Add to Component |.

3 Examine the Material Contents section
in the Settings window for Material to
see the properties that are available.

Properties with check marks are used G

by the physics in the simulation.

4 Close the Add Material window.

~ Material Contents

L]

&
©:
&
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Property

Density

Young's modulus

Poissen's ratio

Isotropic structural loss factor
Relative permeability

Heat capacity at constant pressure
Thermal conductivity

Electrical conductivity

Relative permittivity

Coefficient of thermal expansion

Murnaghan third-order elastic moduli

Variable

tho

E

nu

eta_s
MUr_iso ; M.,
Cp

k_izo ; kii =...
sigma_iso ;.
epsilonr_iso..,
alpha_iso ;..

!

Value
7850[kg/m*3]
EM

nu(T)

0.02

1

A75[)/ (kg*K)]
A4.5[W (m*K)]
4.032e6(5/m]
1

12.3e-6[1/K]

H“ d Materia c )

Add to Global Materials * -~ Add to Component

Search

== Nimonic alloy 90

=i Nylon

Perfect vacuurm

25 Polysilicon

2= Lead Zirconate Titanate (PZT-5H)
25 Silica glass

=5 Silicon

2= Solder, 605n-40Pb

oi Steel AISI 4340

i Structural steel

s

2= | @ Add to Global Materials
@ Addto Component 1 (comp1)
== Water, liquid

b % AC/DC
Unit Property group
kg/m* Basic
Pa Young's modulus and Poissen's ratio
1 Young's modulus and Poissen's ratio
1 Basic
1 Basic
kg K) Basic
W/ (m-K) Basic
5/m Basic
1 Basic
17K Basic
N/m* Murnaghan

-3.0e11[Pa]



Also see the busbar tutorial sections “Materials” on page 84 and
“Customizing Materials” on page 133 to learn more about working with
materials.

Global Definitions

You will now define a global parameter specifying the load applied to the wrench.

Parameters

I In the Model Builder window, under Global Definitions ¢, choose Parameters
| Pi .

4 4@ Untitled.mph (root)
4 () Global Definitions

Fi Parameters 1 G

== Materials
T Component 1 {compT)

2 Go to the Settings window for Parameters |. In the Parameters table, enter these
settings:
- In the Name column or field, enter F.
- In the Expression column or field, enter 150[N]. The square-bracket notation
is used to associate a physical unit to a numerical value; in this case, the unit

of force in Newtons. The Value column is automatically updated based on the
expression entered once you leave the field or press Return.

- In the Description column or field,
enter Applied force.

¥ Parameters

" Name Expression Value Description
F 150[N] 150 N Applied force

If you have a Parameters table with more than one entry, you can sort the
table with respect to a particular column by clicking on the corresponding
header.

The sections “Global Definitions” on page 77 and “Parameters, Functions,
Variables, and Couplings” on page 128 show you more about working with
parameters.
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So far, you have added the physics and study,
imported a geometry, added the material, and
defined one parameter. The Model Builder node

~
Builder =4

Mode

- s Stv Elv Sie

4 @ Untitled.mph {root)

sequence should now match the figure to the 4 (@) Global Definitions
right. The default feature nodes under Solid Pi Parameters 1
. oy . - 4 Default Model Input
Mechanics are indicated by a D in the upper-left - S
A aterials
corner of the node icon &=. 4 [ Component 1 (comp )
. . [+ = Definitions
The default nodes for Solid Mechanics are: 4 7] Geometry 1
Linear Elastic Material, Free, and Initial Values. = Import 1 (imp1)
. . L. Form Union (fin)
The node Linear Elastic Material is the default 4 sz Materials
material model for the Solid Mechanics b s Structura steel (mat’)
. . 4 0= Solid Mechanics (solid)
1nterfaFe. The node Free is a bougdary 25 Linear Elastic Material 1
condition that allows all boundaries to move e Freel
. . . Do |
freely without a constraint or load. The node R 'M= :.:.awmueu
. e, . e e £ Mesl
Initial Values is used for specifying initial 4~ Study 1
displacement and velocity values for a 5 [= step 1: Stationary
[ Results

nonlinear or transient analysis (not applicable
in this case).

The default physics nodes cannot be removed. Instead, you specify physics settings
that deviate from that of the default nodes by adding additional nodes. These
additional nodes can override or contribute to the settings of the default nodes as
well as other nodes. For more information, see “Override and Contribution:
Exclusive and Contributing Nodes” on page 144.

At any time, you can save your model and then open it later in exactly the state in
which it was saved.

3 From the File menu, select Save As. Browse to a folder where you have write
permissions and save the file as wrench.mph.
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Physics and Boundary Conditions

With the geometry and materials defined, you are now ready to set the boundary
conditions.

| In the Model Builder window, P 1 comp )
B Component 1 (comp

right-click Solid Mechanics b = Definitions
(solid) = and select Fixed 4 Geometry 1 Material Models
H S Import 1 (imp1) Volume Forces
Constraint = . Form Union (fin) e
. .. - ass, Spring, and Damper
This boundary condition 4 &k Materials Pring F
. h . 1 f [» Eg= Structural steel (mat1) Domain Constraints
constrains the displacement o G =1 Solid Mechanics (solid) Variables
each point on a boundary = Linear Elastic Material M
. D F 1 ore
surface to be zero in all o eE
. X e Initial Values 1 = Boundary Load
directions. /5 Mesh 1 . :
4~ Study 1 s Fixed Constraint
You can also use the ribbon [% step 1: Stationary SR EsscribedDeplacement
and, from the Physics tab, b & Resuts _ L&l

select Boundaries > Fixed
Constraint.

2 In the Graphics window, rotate the
geometry by clicking anywhere in the
window and then dragging the wrench
into the position shown. Click on the
exposed front surface of the partially
modeled bolt. The boundary turns blue,
indicating that it has been selected. The
Boundary number in the Selection list
should be 35.

3 Click the Go to Default View button ... on the Graphics toolbar to restore the
geometry to the default view.

Graphics ©

Qa®- @@ B X

Go to Default View
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4 In the Model Builder window, right-click Solid Mechanics (solid) = and select
Boundary Load. A Boundary Load node = is added to the Model Builder sequence.

4 5= Solid Mechanics (solid)
T Linear Elastic Material 1
S Freel
= Initial Values 1
= Fixed Constraint 1

6 s Boundary Load 1
A Mesh 1

The “warning” attribute displayed on the Boundary Load node indicates that its
boundary selection is empty. The next step will be to select a boundary.

5 In the Graphics window, click the Zoom 5
Box button :@ on the toolbar and drag
the mouse to select the square region
shown in the figure to the right.
Release the mouse button to zoom in
on the selected region.

6 Select the top socket face (boundary
111) by clicking the boundary to
highlight it in blue and add it to the
Selection list.

7 In the Settings window for Boundary

Load, under Force, sclect Total force as T o

the Load type and enter -F in the text lLoidt:iE: -
field for the z component. The negative - Uorce 5
sign indicates the negative z direction Feor 0 v | N
(downward). With these settings, the e - z

load of 150 N will be distributed
uniformly across the selected surface.
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Note that to simplify the modeling process, the mechanical contact between the
bolt and the wrench is approximated with a material interface boundary condition.
Such an internal boundary condition is automatically defined and guarantees
continuity in normal stress and displacement across a material interface. A more
detailed analysis including mechanical contact can be done with the Structural
Mechanics Module.

ADDING A PARAMETER DIRECTLY FROM A TEXT FIELD

As an alternative to the method shown above, you can add or edit a parameter
directly from a text field. For example, in the case of the wrench model, first type
the value of the Total force in the text field for the z component. Then, right-click
the text field and select Create Parameter from the drop-down menu to open a
Create Parameter dialog box, as shown in the second figure below.

~ Force
Load type:
Total force =
0 X
Ftor 0 y | N
|-150[N] 1=
Fi Create Parameter
Copy Ctrl+C
Paste Ctrl+V
Select All Ctrl+ A

In this dialog box, you can enter a parameter Name and Description.

3 Create Parameter *
MName: F2

Expression:  -130[N]

Value: -150N

Description: Applied force]

0K Cancel
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The parameter is now added to the list of Parameters, as shown below.
Settings M
Parameters
Label: Parameters 1 ,@

¥ Parameters

L

MName Expression | Value Description
F 150[N] 150N Applied force
F2 -130[N] -150N Applied force

To edit a parameter, select the parameter in an edit field, right-click, and choose
Edit Parameter.

~ Force
Load type:
Total force =
0 X
Ftor 0 y | N
-H z

Fi  Create Parameter

#  Edit Parameter

Paste Ctrl+V

Note that when you hover over edit fields and table cells, a tooltip shows the value
of the parameter or expression. This only works when the value is a constant.

~ Force
Load type:
Total force =
0 X
Ftor 0 y | N
-F z

SELECTING BOUNDARIES AND OTHER GEOMETRIC ENTITIES

When a boundary is unselected, its color is typically gray. The exception is when
you use the material Appearance setting available in Materials; sece page 88. To
select a boundary, first hover over it. This highlights the boundary in red,
assuming the boundary was previously unselected. Now, click to select the
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boundary by using the left mouse button. The boundary now turns blue. Its
boundary number will appear in the Selection list in the Settings window of the
corresponding boundary condition. Once a boundary is selected and you hover
over it again, the boundary turns green. If you click a boundary highlighted in
green, the boundary is deselected and now turns gray again. The same technique
for selecting and deselecting is applicable to geometry objects, domains,
boundaries, edges, and points.

The figure below shows the different selection states for a boundary.

Highlighted for selection Selected Highlighted for deselection

To select internal surfaces that are hidden behind the one closest to you, use one
of the following methods to cycle through the boundaries at the mouse pointer:
roll the mouse scroll wheel, use the keyboard + and - buttons, use the keyboard
arrow-up and arrow-down buttons, or use two-finger drag on a touchpad.

When hovering over a boundary, information about the boundary number and
surface normal direction is displayed in the upper-left corner of the Graphics
window, as shown in the figure below.

Graphics
aQA- @ L-mEEr dr @ @

—111|Up

Similarly, when selecting domains, edges, and vertices the corresponding
geometric entity number is displayed.
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For each boundary surface, the normal vector has a “positive” and “negative”
direction, referred to as the up and down direction, respectively. When hovering
over a surface, the information display shows which normal direction is currently
pointing toward you. This information can be useful, for example, when defining
more advanced boundary conditions, especially on material interfaces.

SELECTING USING THE GRAPHICS WINDOW CONTEXT MENUS

As an alternative selection method, you can right-click in the Graphics window and
choose one of the options for domain, boundary, edge, or point selection.

For example, to assign a Boundary Load boundary condition, first right-click and
sclect New Boundary Selection, as shown in the figure below.

Zoom te Selection

Measure

B I &

IeeE»E

Select Box

Zoom Box

Zoom Extents

New Domain Selection
New Boundary Selection
New Edge Selection

New Point Selection

Clipping
Go To
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Click to select the boundaries to which you would like to apply the boundary
condition. (In this case, the top socket face; boundary 111.) Then, right-click
again and select Boundary Load, as shown in the figure below.

Boundary Load
Fixed Constraint
Prescribed Displacement

Roller

oo

Thin Layer

Connections

Mass, Spring, and Damper
More Constraints

More

* v v ¥

"+ Zoom to Selection

Measure

v B

Hide

Geometric Entity Level

Show Selection for Solid Mechanics (solid)

Clipping

Go T

You can also use this method to add additional boundaries to the selections of an
already created boundary condition. In the example above, you could, for
example, while having the Fixed Constraint node selected, select the menu option
Add to Boundary Selection for Fixed Constraint | (although it wouldn’t be applicable
in this example).

SELECTING USING CLIP PLANES

For selecting geometric entities inside complicated CAD models, you can use clip
planes, clip boxes, clip spheres, or clip cylinders. You select these from the graphics
toolbar by clicking the Clipping toolbar button.

@ - B-a
[E  Add Clip Plane
f51 Add Clip Box
B0 Add Clip Sphere
(5] Add Clip Cylinder
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By selecting a Clip Plane, for example, you can quickly hide all parts of a model that
is on one side of the plane. The figure blow shows a clip plane used to select one
of the interior boundaries of the wrench model.

Mesh

The mesh settings determine the resolution of the finite element mesh used to
discretize the model. The finite element method divides the model into small
elements of geometrically simple shapes, in this case tetrahedra. In each
tetrahedron, a set of polynomial functions is used to approximate the structural
displacement field — how much the object deforms in each of the three
coordinate directions. The stress is then computed by differentiating the
displacement field.

In this example, because the geometry contains small edges and faces, you will
define a slightly finer mesh than the default setting suggests. This will better
resolve the variations of the stress field and give a more accurate result. Refining
the mesh size to improve computational accuracy always involves some sacrifice in
speed and typically requires increased memory usage.
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I In the Model Builder, under Component |, click Mesh 1 4 . In the Settings window
for Mesh, under Mesh Settings, sclect Finer from the Element size list.

o

Settings

" LA

[E Build All

m

Label: Mesh 1
¥ Sequence Type
Physics-controlled mesh

¥ Physics-Controlled Mesh

Element size:

| Finer

Extremely fine
Extra fine

Finer

Fine

MNormal

Coarse

Coarser

Extra coarse
Extremely coarse

2 Click the Build All button =
The resulting mesh will require about 5GB to solve. If you have a computer
with less than 5GB of RAM you can select Fine from the Element size list (instead
of Finer.)

in the Settings window or on the Mesh toolbar.
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3 After a few seconds, the mesh is displayed in the Graphics window. Rotate the
wrench to take a look at the element size distribution (this may vary a bit
depending on the version you are running).
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Study

In the beginning of setting up the model, you selected a Stationary study, which
implies that a stationary solver will be used. For this to be applicable, the
assumption is that the load, deformation, and stress do not vary in time. To start
the solver:

I Right-click Study I -« and select b b Study 1
Compute = (or press F8). G b B Results | = Compute Fa

Update Solution F5

After a few seconds of
computation time, the default plot
is displayed in the Graphics
window. During computation, a
Progress window shows progress information from the solvers. After the
computation you can find other useful information about the computation in the
Messages and Log windows; Click the Messages and Log tabs under the Graphics

Parametric Sweep

Function Sweep
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window to see the kind of information available to you. The Messages window can
also be opened from the Windows drop-down list in the Home tab of the ribbon.

Messages Progress  Log
aLv:=
<---— Stationary Solver 1 in Study 1/Sclution 1 ({scll)

Started at Sep 8, 2022, 5:30:18 FM.

Linear sclver

Humber of degrees of freedom solwved for: 412278.

Symmetric matrices found.

Scales for dependent warisbles:

Displacement field (compl.u): 1

Orthonormal null-space function used.

Iter SolEst Damping Stepsize #Res #Jac #5cl LinErr LinRes
1 0.88 1.0000000 0.88 1 1 1 4.%e-10 4.3e-09

Solution time: 9 a.

Physical memory: 4.86 GB

Virtual memory: 6.11 GB

Ended st Sep 8, 2022, 5:30:27 PFM.

————— Stationary Solver 1 in Study 1/Sclution 1 ({scll) >

Results

The von Mises stress is displayed in the Graphics window in a default Volume plot
with the dlsg)lacement visualized using a Deformation subnode. Change the default
unit (N/m?) to the more suitable MPa as shown in the following steps.

I In the Model Builder, expand the Results > Stress

(solid) @ node, then click Volume | @. ‘ @ Results

Datasets

% Derived Values
EH Tables

4 N Stress (solid)

2 In the Settings window under

Expression, from the Unit list, select v Expression = b @
MPa (or type MPa in the field). Expression:

solid.mises

Unit:

MPa -

[] Description:

von Mises stress
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3 Click the Plot button = on the toolbar of the Settings window for the Volume
plot and then click the Go to Default 3D View button ... on the Graphics window
toolbar.

The von Mises stress distribution is shown in the bolt and wrench under an
applied vertical load.

Volume: von Mises stress (MPa)

-
x10°m M 350

10

You can add additional predefined plots by selecting from the list defined by Add
Predefined Plot under Results or by clicking the corresponding button from the
ribbon Home tab.

4 @ﬁ‘éﬁulh
3 Dat| N 3D Plot Group
ez Dern [
2D Plot Grou
B Tab e
4 i stre 1D Plot Group
[ . ’% Polar Plot Group
&= < .
Bxp 99 Srith Plot Group
[# Rep _—
Add Predefined Plot
{E Evaluation Group
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4 You can, for example, visualize the applied load distribution. Right-click Results
and seclect Add Predefined Plot > Study I/Solution | > Solid Mechanics > Boundary

Loads.

Add FI Solid Mechanics 3 ii Stress (solid)
{E  Evaluation Group Wl Displacement (solid)
Pi  Parameters ii Boundary Loads (solid) 6
@ Total Reaction Forces and Moments (Solid Mechanics)

Plot All I

The resulting plot shows the boundary load using arrows.

Graphics
Qa@-@ Lk ¢y B FEEEEE@S - @8

Boundary Loads (solid)

For our purposes we are not interested in the stress in the bolt. We can selectively
visualize the stress in just the wrench by adding a Selection node.
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I Right-click the Stress > Yolume node and select Selection

4 [ Results
3

Datasets

2% Derived Values

EH Tables

4 i'i Stress (solid)

I Nl Boundary Loz

4 7 volume 1
== Defon

Export
[# Reports

& NE &

u | i

Plot

Plot In

Filter

Image

Marker

Material Appearance
Selection

Translation

Transparency

2 In the Graphics window, click the wrench, domain 1.

Model Builder

—

Yt =

t -

4 @ Untitled.mph {root)
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I () Global Definitions
I @ Component1 {comp1)

[~ Study 1

4 [ Results
3 Datasets

2% Derived Values

EH Tables

4 i“ Stress (solid)
- Volume 1
== Deformation
:—.‘ Selection 1
I> 4@ Boundary Loads (solid)

i= Export
[# Reports

-1

Label: Selection 1

¥ Selection

Selection: Manual

'@'@@ o

&

4
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3 Click Plot to see the visualization.

Volume: von Mises stress (MPa)

For a typical steel used for tools like a wrench, the yield stress is about 600 MPa,
which means that we are getting somewhat close to plastic deformation for our
150 N load (which corresponds to about 34 pounds force). You may also be
interested in a safety margin of; say, a factor of three. To quickly assess which parts
of the wrench are at risk of plastic deformation, you can plot an inequality
expression such as solid.mises>200[MPa].

I Right-click the Results node @& and add a 3D Plot Group W .

4 [ Results
3D Plot Group 0

2D Plot Group
1D Plot Group

Polar Plot Group
Smith Plot Group

Add Predefined Plot 3

Evaluation Group

Parameters

Plot All

= Show More Options...

Mode Group

Copy as Code to Clipboard 3

Help F1
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2 Right-click the 3D Plot Group 3 node @ and select Volume & .

4 [ Results
[ # Datasets
2% Derived Values
EH Tables
[ I'.’ Stress (solid)
VB Boundary Loads (solid)
| 3D Plot Group 3

Export Plot
[# Reports Plot In
a Volume G
@ Arrow Volume
—

Surface

3 In the Settings window for Volume,
click the Replace Expression button %
and select Model > Component | > Solid e —or
Mechanics > Stress > solid.mises-von solid mises>200(Pa)
Mises stress - N/m? by double-clicking.
When you know the variable name
beforehand, you can also directly enter
solid.mises in the Expression ficld.
Now edit this expression to:
solid.mises>200[MPa].

This is a Boolean expression that evaluates to either 1 for true or 0 for false. In
areas where the expression evaluates to 1, the safety margin is exceeded.

w Expression =iy S

Unit:

[] Description:

solid.mises=> 200[MPa]

4 Click the Plot button @ .

5 In the Model Builder window, click 3D Plot Group 3. Press F2 and, in the Rename
3D Plot Group dialog box, enter Safety Margin. Click OK. Alternatively, edit the
label at the top of the Settings window.

The resulting plot shows that the stress in the bolt is high, but the focus of this
exercise is on the wrench. If you wish to comfortably certify the wrench for a
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150 N load with a factor-of-three safety margin, you would need to change the
handle design somewhat, such as by making it wider.

Volume: solid. mises>200[MPa]

x10°

v_\I/'x

You may have noticed that the manufacturer, for various reasons, has chosen an
asymmetric design for the wrench. Because of that, the stress field may be different
if the wrench is flipped around. Try now, on your own, to apply the same force in
the other direction and visualize the maximum von Mises stress to see if there is
any difference.

Convergence Analysis

The results from a simulation software such as COMSOL Multiphysics can
shorten design times dramatically by, for example, reducing the number of
experiments or product tests. However, simulation software is not a substitute for
real-world testing. This is especially important if there are risks for physical or
environmental damage. One way to reduce (but not eliminate) the risk of drawing
the wrong conclusions from simulation results is to perform a convergence
analysis.

To check the accuracy of the computed maximum von Mises stress in the wrench,
you can now continue with a mesh convergence analysis. Do that by using a finer
mesh and therefore a higher number of degrees of freedom (DOFs).
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This section illustrates some more in-depth functionality and the steps
below could be skipped at a first reading. In order to run the convergence
analysis below, a computer with at least 4GB of memory (RAM) is
recommended.

EVALUATING THE MAXIMUM VON MISES STRESS

I To study the maximum von Mises stress in the wrench, in the Results section of
the model tree, right-click the Derived Values :: node and select Maximum >
Volume Maximum wax.

2 In the Settings window for Volume Maximum, under Selection, choose Manual and
select the wrench, domain 1, by clicking on the wrench in the Graphics window.
We will only consider values in the wrench domain and neglect those in the bolt.

3 In the first row of the Expressions table, in the Expression column, type
solid.mises. To find the expression for the von Mises stress, you can also click
the Replace Expression button % and browse to this variable.

4 In the Expressions table, type MPa as the Unit.
Settings

Volume Maximum
= Evaluate =

Label: Velume Maximum 1 =

¥ Data

Dataset: | Study 1/Solution 1 (sol1) | |E
Selection

Selection: | Manual -

Active -g:']

B T &

v Expressions +- S~

"
Expression Unit Description

solid.mises MPa von Mises stress G

5 In the Settings window for Volume Maximum,
click Evaluate to evaluate the maximum stress. - =
The result will be displayed in a Table window 5 =705 & e & L D E
and will be approximately 375 MPa. The von Mises stress (MPa)
value may vary slightly depending on the 3495 G
software version and hardware platform.

Messages Progress Log Table 1
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6 To see where the maximum value is attained, you can, for example, use a
Max/Min Volume plot. Right-click the Results node & and add a 3D Plot Group
. Next, right-click the 3D Plot Group 4 node @ and select More Plots > Max/Min
Volume .

7 To plot values in the wrench and not in the bolt, right-click the Max/Min Volume
= node, select Selection, and then select the wrench, domain number 1.

8 In the Settings window for Max/Min Volume, in the Expression text field, type
solid.mises.

9 In the Settings window under Expression, from the Unit list, select MPa (or enter
MPa in the field).

10 Click the Plot button & . This type of plot simultaneously shows the location of
the maximum and minimum values and also their coordinate location in the
table below (the exact values may differ depending on the version you are
running).

Graphics =
@ am- LrxEkh cr @y (EEe-EEOS - @8
Max/Min Volume: von Mises stress (MPa) e
%107 m
10
0.05 | 0
G e
5
|
00370568
| Bean
-10
ax: 374,931
z
(NP
Messages Progress Log Maximum and Minimum values 82T
B HEESD @8 \ IR CEE -
X ¥ z wvon Mises stress (MPa)

0.062743 |0.0070844 |-2.4465E-4 0.037057
-0.036471 -4.9213E-4|-0.0064445 374.93
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An alternative way of plotting the maximum and minimum stress is to
right-click the Stress > Volume plot and select Marker.

4 [ Results
I # Datasets
2% Derived Values
I E Tables
4 @ Stress (solid)
4 B volume 1

=3 Deformation

& Selection 1
= Marker 1
I §@ Boundary Loads (solid)
VB Safety Margin

PARAMETERIZING THE MESH

We will now define a parametric sweep for successively refining the mesh size while
solving and then finally plot the maximum von Mises stress versus mesh size. First,
we define the parameters that will be used for controlling the mesh density.

I In the Model Builder window, click Parameters | » under Global Definitions .

2 Go to the Settings window for Parameters. In the Parameters table (or under the
table in the fields), enter these settings:

- In the Name column or field, enter hd. This parameter will be used in the
parametric sweep to control the element size.

- In the Expression column or field, enter 2.

- In the Description column or field, enter Element size divider.

3 Now, enter another parameter

with Name h0, Expression 0.01, Settings e vy
and Description Starting POEIGEIE
element size.This parameter  Label Parameters1 =

will be used to define the
clement size at the start of the

¥ Parameters

parametric sweep. " MName Expression Value Description
X F 150[N] 150N Applied force
4 In the Model Builder WlHdOW, hd 2 2 Element size divider
under Component | , click h 0.01 0.01 Starting element size

Mesh | 4 . In the Settings
window for Mesh, sclect User-controlled mesh from the Sequence type list.

5 Under Mesh 1, click the Size node |
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6 In the Settings window for Size, under

. . ¥ Element Size Parameters
Element Size, click the Custom button.

Maximum element size:

Under Element Size Parameters, enter:

h0/hd m
- h0/hd in the Maximum element size ficld. G Minimum element size:
. . . . h0/(4*hd
- h0/(4*hd) in the Minimum element size /(@ hd) m
ﬁeld Maximum element growth rate:
’ 13
- 1.3 in the Maximum element growth rate Curvature factor:
field. 0.1
- 0.1 in the Curvature factor ficld. =l T ol TR G e
02

- 0.2in the Resolution of narrow regions ficld.

See page 98 for more information on the
clement size parameters.

PARAMETRIC SWEEP AND SOLVER SETTINGS
As a next step, add a parametric sweep for the parameter hd.

I In the Model Builder window, right-click Study | -« 4 St
and select Parametric Sweep ::. A Parametric arametric Sweep

Sweep node is added to the Model Builder [= Step L: Stationary
4 [Tr. Solver Configurations
sequence.

2 In the Settings window for Parametric Sweep, under the table in the Study
Settings scction, click the Add button + . From the Parameter name list in the
table, select hd.

3 Enter a range of Parameter values to
sweep for. Click the Range | button
and enter the values in the Range = Compute (2 Update Solution
dialog box. In the Start field, enter 2. | Porametric Sweep
In the Step ficld, enter 1, and in the
Stop field, enter 6. Click Replace. The

~ Study Settings

. . . Sweep type: Specified combinations
Parameter value list will now display
2 1 6 Parameter name Parameter value list Parameter unit
Pange ( LR ) ° hd (Element size divider) ~ |range(2.1,6)
The settings above make sure that as e

the sweep progresses, the value of the
parameter hd increases and the
maximum and minimum element sizes decrease.

See page 159 for more information on defining parametric sweeps.

For the highest value of hd, the number of DOFs will exceed one million.
Therefore, we will switch to a more memory-efficient iterative solver.
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4 Under Study | > Solver
Configurations > Solution I,
expand the Stationary Solver |
node [z, and right-click Suggested

4 o Study 1
Parametric Sweep

— Step 1: Stationary
4 e So.l\.rer Configurations
4 [ Solution 1 (sol1)

Iterative SOIVel"N and select 54 Compile Equations: Stationary
Enable. Selecting an iterative b v Dependent Variables 1
. . 4 [75 stationary Solver 1

solver option typically reduces Direct
memory usage but may require 2, Advanced

. . P =* Fully Coupled 1
phySICS SP_CCIﬁC tallorln.g of the Suggested Direct Solver (solid)
solver settings for efficient b [N Suggested Iterative Solver (solid) G
computations. 4 B Results

5 Under General in the Settings
window for Suggested Iterative Solver, change the Preconditioning to Right. (This
is a low-level solver option, which in this case will suppress a warning message
that would otherwise appear. However, this setting does not affect the resulting
solution. Preconditioning is a mathematical transformation used to prepare the
finite element equation system for using the iterative solver.)

6 Click the Study | node and select Compute =, cither in the Settings window or
by right-clicking the node. You can also click Compute on the ribbon Home or
Study tab. The computation time will be a few minutes (depending on the
computer hardware) and memory usage will be about 4GB.

RESULTS ANALYSIS

Note that after running the parametric sweep, a new set of default plot nodes are
created corresponding to the new Dataset Study |/Parametric Solutions I.

Model Builder ~ # | Settings _—
= t § ®Ey By =~ 3D Plot Group
4 & wrench.mph (root) Plot M= 4= = =]
I () Global Definitions
I [l Component1 {comp1) Label:  Stress (solid) 1 =
[~ Study 1
4 [E Results - [BEE
: Dat.asets Dataset: Study 1/Parametric Solutions 1 (sal2) ~ %
[ Derived Values
[ Tables Parameter value (hd): 6 -
[ Stress (solid)
I §i§ Boundary Loads (solid) I Selection
I §i§ Safety Margin L Title
I §i§ 3D Plot Group 4
I i Stress (solid) 1 ¥ Plot Settings
I §i§ Boundary Loads (solid) 1 ) =
Wiew: Automatic > | |E

[] Show hidden entities
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As a final step, analyze the results from the parametric sweep by displaying the
maximum von Mises stress in a table.

I In the Model Builder window, under Results > Derived Values, sclect the Volume
Maximum | node w«.

The solutions from the parametric sweep are stored in the Dataset named Study
I/Parametric Solutions 1. Now, change the Yolume Maximum settings
accordingly:

2 In the Settings window for Volume Maximum, change the Dataset to Study
I/Parametric Solutions I.

3 Click the arrow next to the Evaluate button at the top of the Settings window
for Yolume Maximum and select to evaluate in a New Table. This evaluation may
take 10 seconds or so, depending on the computer.

4 To plot the results in the Table, click the Table Graph = button at the top of the
Table window (the first few values will vary due to slight mesh variations

between versions for coarser meshes before a converged value has been
reached).

BIMBEE s B T e as -
hd wvon Mises stress (MPa)
2,0000391.88 .
3.0000/384.92

4,0000/382.76 A
5.0000376.45
£.0000(375.79 serk :

392

von Mises stress (MPa)
&
2
T
/
/
/
/
/
/
/
/
/
/
/

It is more interesting to plot the maximum value vs. the number of DOFs. This
is possible by using the built-in variable numberofdofs.

5 Right-click the Derived Values node :: and select Global Evaluation .

6 In the Settings window for Global Evaluation, change the Dataset to Study
I/Parametric Solutions I.
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7 In the Expressions ficld, enter numberofdofs.

You can type the first few characters of the variable name and then use
the keyboard shortcut Ctrl+Space to get a variable suggestion from the

list of available variables.

8 In the Settings window for Global Evaluation, click the arrow next to the Evaluate
button and select the option to evaluate in Table 2, or Table I, depending on
which previous steps you chose to follow. This displays the DOF values for each
parameter next to the previously evaluated data.

This convergence analysis shows that the computed value of the maximum von
Mises stress in the wrench handle will decrease from the high original value, for a
mesh with about 115,000 DOFs, to 375 MPa for a mesh with about 1,000,000

DOPFs. It also shows that above 700,000 DOFs the results have essentially the
same accuracy as for 1,000,000 DOFs.

The figure below shows the associated Table Graph and Table Graph Settings

window.

Graphics

ea-EUENDNS @8

von Mises stress (MPa)

5 6
Number of degrees of freedom (1)

Label: Table Graph 1
¥ Data

Source: Table

Table: Table 2 -
[] Row-based
x-axis data: Number of degrees of freedom (1)
Plot columns: Manual

Colurmns:

hd
wvon Mises stress (MPa)
Mumber of degrees of freedom (1)

Note that depending on the version of COMSOL Multiphysics that you are

running, the above values may vary slightly due to variations in the number of

clements generated by the meshing algorithm.

As an alternative to Derived Values, you can use Evaluation Groups. An Evaluation
Group shares some of the properties of Plot Groups as well as Derived Values. An

Evaluation Group comes with an integrated table whereas Derived Values outputs to
a table of your choice. In addition, Evaluation Groups allows you to automatically
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reevaluate after solving. To enable this, select the corresponding check box in the

Settings window of the Results node as shown in the figure below.

Model Builder -1 Sett-pgg -1
. = =t i< Results
4 & wrench.mph (root)

I {E} Global Definitions e

I [l Compoenent1 (compl) [ Only plot when requested

:> E ;:Is‘:l:lft: Recompute all plot data after solving

Reevaluate all evaluation groups after solving
¥ Save Data in the Model

Save plot data:  Automatic

In this Settings window you can also request to regenerate all plots after solving.

You add an Evaluation Group in the same way as a Plot Group: by right-clicking the
Results node. The figure below shows an Evaluation Group that performs the same

task as the Derived Values described earlier.

4 G Evaluation Group 1
ma Yolurme Maxirmum 1
.@ Global Evaluation 1

The figure below shows the corresponding Evaluation Group table.

Messages Progress Log  Evaluation Group 1
B ESMESs B VI 219G 2H -
hd von Mises stress (MPa) | Mumber of degrees of freedom (1)

2.0000(391.88 1.1564E5

3.0000|334.92 2.5011E5

4,0000(382.76 4,4698E5

5.0000|376.45 6.9909E5

6.0000|375.79 9.5113E5

This concludes the wrench tutorial.

|71



Example 2: The Busbar — A Multiphysics Model

Electrical Heating in a Busbar

This tutorial demonstrates the concept of multiphysics modeling in COMSOL
Multiphysics using the Model Builder. You will learn how to use one of the many
preconfigured multiphysics combinations as well as subsequently add the effects
of physics phenomena not initially included in the analysis. At the end, you will
have built a truly multiphysics model.

The model that you are about to create analyzes a busbar designed to conduct a
high amount of direct current in an industrial setting (see picture below). The
current conducted in the busbar, from bolt 1 to bolts 2a and 2b, produces heat
due to the resistive losses, a phenomenon referred to as Joule heating. The busbar
is made of copper, while the bolts are made of a titanium alloy. Busbar bolts are
usually made of steel, but in this example, we will assume a highly corrosive
environment. Therefore, a titanium alloy was chosen.

Under normal operational conditions, the currents are predominantly conducted
through the copper. This example, however, illustrates the effects of an unwanted
clectrical loading of the busbar through the bolts. The fact that there are different
materials is important because titanium has a lower electrical conductivity than
copper and will be subjected to a higher current density.

Titanium Bolt 2a

Titanium Bolt 2b  Titanium Bolt |

The goal of your simulation is to precisely calculate how much the busbar heats
up. Once you have captured the basic multiphysics phenomena, you will have the
chance to investigate thermal expansion that generates structural stresses and
strains in the busbar and the effects of cooling by an air stream.
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The Joule heating effect is described by conservation laws for electric current and
energy. Once solved for, the two conservation laws give the temperature and
electric field, respectively. All surfaces, except the bolt contact surfaces, are cooled
by natural convection in the air surrounding the busbar. You can assume that the
exposed parts of the bolt do not contribute to the cooling or heating of the device.
The electric potential at the upper-right vertical bolt surface is 20 mV and the
potential at the two horizontal surfaces of the lower bolts is 0 V. This corresponds
to a relatively high and potentially unsafe loading of this type of busbar. More
advanced boundary conditions for electromagnetics analysis are available with the
AC/DC Module, such as the capability to give the total current on a boundary. A
more advanced model that includes multiple busbars in an assembly, as shown in
the figure below, can be found in some of the add-on products, including the
AC/DC Module and a few of the LiveLink™ products for CAD.

assclastc

Busbar Model Overview

More in-depth and advanced topics included in this tutorial are used to show you

some of the many options available in COMSOL Multiphysics. The following

topics are covered:

+ “Parameters, Functions, Variables, and Couplings” on page 128, where you
learn how to define functions and nonlocal couplings.

e “Material Properties and Material Libraries” on page 133 shows you how to
customize a material and add it to your own material library.
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» “Adding Meshes” on page 134 gives you the opportunity to add and define
two different meshes and compare them in the Graphics window.

* “Adding Physics” on page 137 explores the multiphysics capabilities by
adding solid mechanics and laminar flow to the busbar model.

o “Parametric Sweeps” on page 159 shows you how to vary the width of the
busbar using a parameter and then solve for a range of parameter values. The
result is a plot of the average temperature as a function of the width.

+ “Parallel Computing” on page 171 gives you an overview of how to solve
on clusters.

e “COMSOL Multiphysics Client-Server” on page 175 gives you an
introduction to using the COMSOL Multiphysics client—server mode of
operation.

Model Wizard

I To open the software, double-click the COMSOL
Multiphysics icon on the desktop.

When the software opens, click the Model Wizard button.
You can also start the Model Wizard at any time by selecting G

New from the File menu. Then, choose Model Wizard. ——

Wizard

2 In the Select Space Dimension window, click 3D.

Blank Model

0 1D
Axisymmetric Axisymmetric

o & &+ 9 - —
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3 In the Select Physics window, expand
Heat Transfer > Electromagnetic
Heating. Then, right-click Joule
Heating |~ and choosc Add Physics.
Click the Study © button.

You can also double-click the selected
physics interface or click the Add
button to add physics.

(Another way to add physics is to
open the Add Physics window by
right-clicking the Component node in
the Model Builder window and
selecting Add Physics ;)

Note that you may have fewer items
in your physics list depending on the
add-on modules installed. The figure
on the right is shown for the case
where all add-on modules are
installed.

In the Select Study window, click to
select the Stationary = study type.

Click the Done button.

Choosing a stationary study means
that we are solving for the
steady-state temperature of the
busbar when it has reached thermal
equilibrium with its surroundings.

Select Physics

Search

D Recently Used
¥} ACDC
1) Acoustics
"2 Chemical Species Transport
Tl Electrochemistry
<= Fluid Flow
Heat Transfer
1B Heat Transfer in Selids (ht)
Heat Transfer in Fluids (ht)
& Heat Transfer in Solids and Fluids (ht)
b |= Conjugate Heat Transfer
b Radiation
4 %) Electromagnetic Heating
X Joule Heating

[ ——

# Induction Heating
[ Microwave Heating
=81 Laser Heatina

Added physics interfaces:
% Electric Currents (ec) e
51 Heat Transfer in Solids (ht)
4 Multiphysics
= Electromagnetic Heating (emh1)

Remove

e e Study

@ Space Dimension
Help 0 Cancel  [3] Done

Select Study

4 oo General Studies
[= Stationary G
[ Time Dependent

4~ Preset Studies for Selected Physics Interfaces
b~ Heat Transfer in Solids
b~ Electric Currents
4~ Preset Studies for Selected Multiphysics
[ Frequency-Stationary
[ Frequency-Stationary, One-Way Electromagnetic Heating
[+ Frequency-Transient
|+% Frequency-Transient, One-Way Electromagnetic Heating
b o More Studies
b~ Preset Studies for Some Physics Interfaces
Added study:
[= Stationary
Added physics interfaces:
X Electric Currents (ec)
1B Heat Transfer in Solids (ht)
4 Multiphysics
2 Electromagnetic Heating (emh1)

ephy;m;
Help € Concel [ Done G
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A preconfigured Study has solver and equation settings adapted to the selected
combination of physics interfaces; in this example, Joule Heating.

Note that you may have fewer study types in your study list depending on the
installed add-on modules.

A physics interface is a user interface for a specific physics area that
defines the equations together with settings for mesh generation,
solvers, visualization, and results. A multiphysics interface is a
combination of physics interfaces together with multiphysics couplings.
The Joule Heating multiphysics interface consists of two physics
interfaces, Electric Currents and Heat Transfer in Solids, together with the
multiphysics coupling Electromagnetic Heating that appear in the
Multiphysics branch. This method of mixing physics is very flexible and
makes it possible to use all the capabilities of the participating
single-physics interfaces for multiphysics purposes.

]

ar - 1

=t .

Mode

—

4 & Untitled.mph (root)
4 () Global Definitions
Fi Parameters 1
= Materials
4 |§ Component1 (comp1)
[ = Definitions
[ Geormnetry 1
2 Materials
4 +\_ Electric Currents {ec)
&= Current Conservation 1
%= Electric Insulation 1
= Initial Values 1
4 [F Heat Transfer in Solids (ht)
= Solid 1
= Initial Values 1
%= Thermal Insulation 1
- .{;3. Multiphysics
* Electromagnetic Heating 1 (emh1)
A Mesh 1
4 o Study 1
[= step 1: Stationary

b {8 Results
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Global Definitions

To save time, it is recommended that you
load the geometry from a file. In that case,
you can skip to “Geometry” on page 80.

On the other hand, if you want to draw the
geometry yourself, the Global Definitions
node is where you define the parameters.
First, complete steps 1 through 3 below to
define the parameter list for the model.
Then, follow step 4 and skip to the section
“Appendix A — Building a Geometry” on
page 201.

The Global Definitions node @ in the Model
Builder window stores Parameters, Variables,
and Functions with a global scope. The
model tree can hold several model
components simultaneously, and the
definitions with a global scope are made
available for all components. In this
particular example, there is only one Component node in which the parameters are
used. If you wish to limit the scope to this single component, you could define,
for example, Variables and Functions in the Definitions subnode, available directly
under the corresponding Component node. However, no Parameters can be
defined here because Parameters that are defined under Global Definitions arc
always global.

Since you will run a parametric study of the geometry later in this example, define
the geometry using parameters from the start. In this step, enter parameters for
the length of the lower part of the busbar, L; the radius of the titanium bolts,
rad_1; the thickness of the busbar, tbb; and the width of the device, wbb.

You will also add the parameters that control the mesh, mh; a heat transfer
coefticient for cooling by natural convection, htc; and a value for the voltage
across the busbar, Vtot.

I Under Global Definitions ), choose Parameters » . In the Parameters table, click
the first row under Name and enter L.

2 Click the first row under Expression and enter the value of L, 9[cm]. You can
enter the unit inside the square brackets.

3 Continue adding the other parameters: rad_1, tbb, wbb, mh, htc, and Vtot
according to the Parameters list below. It is a good idea to enter descriptions for
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variables in case you want to share the model with others and for your own
future reference.

¥ Parameters

" MName Expression Value Description
G L G[cm] G 0,09 m Length

rad_1 6[mm] 0.006 m Bolt radius

thb 5[mm] 0.005 m Thickness

whb 5lem] 0.05m Width

mh 3[mm] 0.003 m Maximum element size

htc 5[W/m*"2/K] 5 W/ (m*K) Heat transfer coefficient
6 Vot 20[mV] 0.02V Applied voltage

Click the Save button o on the Quick Access Toolbar and name the model
busbar.mph or use the corresponding File menu option. Then, go to “Appendix
A — Building a Geometry” on page 201.

The Auto Completion and Find Tools

The model tree contains a large number of parameters and variables. To make it
casier to find them, you can use the auto completion and find tools as described
below.

AUTO COMPLETION

You can use Ctrl+Space for auto completion of parameter and variable names. For
example, in the Parameters table, if you click an empty Expression ficld and then
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press Ctrl+Space, you will get a list of parameters and variables, as shown in the

figure below.

mh almm] U005 m

htc 5[W/m*2/K] 5 W/(m*K)
Vtot 20[mV] 0.02V
my_par

4 Parameters
L - Length - m
Vtot - Applied voltage - V

laximuim elerment siZe
Heat transfer coefficient
Applied voltage

htc - Heat transfer coefficient - W/(m®K)

mh - Maximum element size - m
rad_1 - Bolt radius - m
thb - Thickness - m

whb - Width - m
4 Builtin
4 Mathematical constants
1 T Inf - Infinity
MNaM - Mot a number
Mames R R
eps - Machine epsilon
my_par i - Imaginary unit
Expression: Jj - Imaginary unit

pi-Pi,m

4

This functionality is also available for other edit fields in the Model Builder window.

FIND

To find parameters, variables, as well as other strings in the model tree, you can
click the Find button in the Quick Access Toolbar or use the keyboard shortcut
Ctrl+F. This opens the Find and Replace window.

Graphics
aA Qv @~ -

Find and Replace X

Contains: current
Replace with:
MNode Type
+\_ Electric Currents (ec) MNode label
*_ Electric Currents (ec) MNode type
4 +\_ Electric Currents (ec)
= Current Conservation 1 MNode label
&= Current Conservation 1 MNode type
* Electromagnetic Heating 1 (emh1} Setting
4 ~db Study 1
[= stationary Table cell

Text
Electric Currents

Electric Currents
Current Conservation 1
Current Conservation

Electric Currents (ec)

Electric Currents (ec)

), Search

% Replace *

Replace Preview
O Electric s

Electric Currents
O Conservation 1
Current Conservation

Electric Currents (ec)

Electric Currents (ec)
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The results of the search are displayed below the Contains and Replace with fields.
The results in this example are coming from the completed busbar model by
searching for the string current.

You can double-click any of the rows in this window to open the corresponding
Settings window.

Geometry

This section describes how the geometry can be opened from the Application
Libraries. The physics, study, parameters, and geometry are included with the
model file you are about to open.

I Select Application Libraries [ from the _
Windows drop-down menu in the Home tab. [~
You can also access the Application Libraries Windows Diﬁfp .
from the File menu. %5 Add Physics
i Add Multiphysics

"% Add Study

o1 Add Material from Library

Material Browser

G [l Application Libraries

[fifi Part Libraries
2= Add-in Libraries

= Selection List
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2 In the Application Libraries tree

under COMSOL Multiphysics >
Multiphysics, sclect busbar_geom.

To open the file, you can:
- Double-click the name

- Right-click and select an option
from the menu

- Click one of the buttons under
the tree

You can select No if prompted to
save Untitled.mph.

The geometry in this file is
parameterized. In the next few
steps, we will experiment with
different values for the width

Application Libraries

( Refresh [ Update COMSOL Application Libraries

Search

[l Applications

[l Acoustics

[ffl Chemical Engineering
[l Cluster and Batch Tuterials
[l Diffusion

[l Electromagnetics

[l Equation Based

[l Fluid Dynamics

[l Geophysics

[l Heat Transfer

[l Meshing Tutorials

4 [3 COMSOL Multiphysics
b
b
b
b
b
b
b
b
b
b
b
4 [ Multiphysics

O bushar_box
G BT
@ busbar

L+ free_convection
O pid_control
@ thermal_actuator_jh
@ thermal_actuator_simplified
Z+ thermal_controller_rom
b [l Structural Mechanics
b R ACC Madule

%) Application Gallery

g =8
parameter, wbb. Run Application Open
15 Open PDF Document
(2 B8 e(lnsa
Under Global Definitions ¢, click
¥ Parameters
the Parameters node »: .
In the Settings window for Parameters, Name | Brpression s
L . L 9[cm] 0.09 m
click in the Expression column for the rad 1 §{mm] 0.006 m
wbb parameter and enter 10[cm] to tbb 3[mm] 0.005 m
change the value of the busbar width. 6 whb [l Joam
X mh B[mm] 0,006 m
4 In the Model Builder window, under htc SIW/mA2/K] |5 Wi (mEK)
Vtot 20[mv] 002V

Component | > Geometry |, click the
Form Union node i and then the Build
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All button in the Settings window @ to rerun the geometry sequence. You can
also use the ribbon and click Build All from the Geometry group in the Home tab.

Model Builder ~ & Settings -
-— = EtEl = - Form Union/Assembly
4 & bushar_geom.mph (root) [ Build Selected = | |58 Build All G
4 () Global Definitions
Fi Parameters 1 Label: Form Union E
i Materials .
4 @ Component 1 {comp1) ¥ Form Union/Assembly
[ = Definitions Action:
4 YA Geometry 1 -
) Form a union -

b+ & WorkPlane 1 fwp1)
lf,.!, Extrude 1 {ext?)

b 8 Work Plane 2 (wp2) Automatic
lf,.!, Extrude 2 {ext3)

b {8 Work Plane 3 (wp3)
lf,.!, Extrude 3 {ext3)
Form Union (fin)

2 Materials

Repair tolerance:

5 In the Graphics toolbar, click the Zoom Extents button [ to see the wider busbar

in the Graphics window.

Graphics @
Q @

@a@- @@ - lixis

Zoom Extents

wbb = 10cm
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Experiment with the geometry in the Graphics window:

- To rotate the busbar, click and drag the pointer anywhere in the Graphics
window.

- To move it, right-click and drag.
- To zoom in and out, click the scroll wheel, continue holding it, and drag.

- To get back to the original position, click the Go to Default 3D View button .[.
on the toolbar.

[
08

raphics
A Q @~ & F B e s

Go to Default View

Return to the Parameters table and
change the value of wbb back to 5[cm].

¥ Parameters

In the Model Builder window, click the WETw ISy Value
. . L 9em] 0,09 m
Form Union node & and then click the a1l 6imml 0,006 m
Build All button ® to rerun the geometry thh Simmi 0005 m
mh B[mm] 0,006 m
On the Graphics toolbar, click the Zoom htc SIW/mA2/K] |5 Wi (mEK)
Extents button 7. Vtot 20[mV] 002V

10 If you built the geometry yourself, you are

already using the file busbar .mph, but if you opened the file from the Application
Libraries window, sclect Save As from the File menu and rename the model
busbar.mph.

After creating or importing the geometry, it is time to define the materials.

| 83



Materials

The Materials node = stores the material properties for all physics and geometrical
domains in a Component node. The busbar is made of copper and the bolts are
made of a titanium alloy. Both of these materials are available from the Built-In
material database.

| In the Model Builder window, right-click Component | > Materials = and select
Add Material from Library :. By default, the window will open on the
right-hand side of the desktop. You can move the window by clicking on the
window title and then dragging it to a new location. While dragging the
window, you will be presented with several options for docking.
4 |§ Component1 (comp1)

[ = Definitions
b Geometry 1

G i Materials - =
I +\_ Electric Cu =+ Add Material from Library
I {8 Heat Trans| [i] Browse Materials

b iy Multiphysi

A Mesh 1 2= Blank Material

The Materials node will show a red x in the lower-left corner if you try to
solve without first defining a material, which we will go over in the next
few steps.

2 In the Add Material window,
expand the Built-In materials
folder and locate Copper.
Right-click Copper :: and select
Add to Component I.

Add Materia v RX
() Add to Global Materials ¥ - Add to Component ~
Search

22 Aluminum
24 Arnerican red oak

Alternatively, you can i# Beryllium copper UNS C17200
double-click. o
A Copper node is added to the is Concrete
Model Builder window. Er?fre;r’ Add to Global Materials
3 In the Add Material window, G g';; {8 Addto Companent 1 (comp)

scroll to Titanium beta-21S in the
Built-In material folder list.
Right-click and select Add to
Component |.

2 High-strength alloy steel
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4 In the Model Builder window, collapse the Geometry | node ' to get an overview
of the model.

4 4% busbar.mph (roct)
4 (i) Global Definitions
P Parameters 1
= Materials
4 @ Component1 {compl)
[ = Definitions
GI YA Geometry 1
4 oo Materials
[ 222 Copper (matl)
[+ 2z8 Titanium beta-215 [mat2)
[ }_ Electric Currents {ecg)
[* | I8 Heat Transfer in Solids (hi)
b e Multiphysics
£ Mesh 1
[+t Study 1

b {E Results
At this stage, the Materials node may display one or more red x symbols
depending on the active selection. These will disappear in the next few steps.

5 Under the Materials node, click Copper :: .

4 [ Component1 fcomp1)
= Definitions
Y Geornetry 1
4 o= Materials

e I tzs Copper (matl)

I %28 Titanium beta-215 (mat2)

6 In the Settings window for Material, examine the Material Contents section.

Property Variable Value Unit Property group
[ Electrical conductivity sigma_iso ; si... | 5.998e7[5/m] S‘m Basic
[ | Heat capacity at constant pressure | Cp 3850/ (kg™ K)] 1/ (kg-K) Basic
[ | Relative permittivity epsilonr_so.. |1 1 Basic
[ Density rho 8960[kg/m"3] kg/m* Basic
[  Thermal conductivity k_iso ; kii = k_.. 400[W/(m*K]] W/ (m-K) Basic
Relative permeability mur_iso; mur... 1 1 Basic
Coefficient of thermal expansion alpha_iso; al.. | 17e-6[1/K] 1K Basic
Young's medulus E 110e9[Pa] Pa Young's medulus and Poissen's ratic
Poiszon's ratio nu 0.35 1 Young's medulus and Poissen's ratic
Reference resistivity rhol 1.72e-8[chm*m] (:m Linearized resistivity
Resistivity temperature coefficient | alpha 0.0038[1/K] /K Linearized resistivity
Reference temperature Tref 298[K] K Linearized resistivity

The Material Contents section has useful information about the material
property usage of a model. Properties that are both required by the physics and
available from the material are marked with a check mark . Properties
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required by the physics but missing in the material are marked with a warning
sign 4 . A property that is available but not used in the model is unmarked.

The Coefficient of thermal expansion, Young’s modulus, and Poisson’s ratio
properties in the table above are not used but will be needed later when
heat-induced stresses and strains are added to the model.

Because the copper material is added first, by default, all parts have copper

material assigned. In the next step, you will assign titanium properties to the
bolts, which override the copper material assignment for those parts.

7In the Model Builder window, click
4 T\ Component 1 (comp1) Titanium beta-21$
I = Definitions
b Geometry 1
4 EE Materials
I 228 Copper (matl)
e I* ig= Titanium beta-215 (mat2)

[ +\_ Electric Currents {ec)



8 Select All Domains from the Selection list and then click domain 1 in the list. Now
remove domain 1 from the selection list.

~ *| Graphics
Q Q@ @

Label:  Titanium beta-215

Mame: mat2
Geometric Entity Selection

Geometric entity level: Domain

Selection: @ All domains

@

[

IT “ ilT[I

E

Remove from Selection

[ R

To remove a domain from the selection list (or any geometric entity, such as
boundaries, edges, or points), you can use either of these two methods:

- Click domain 1 in the selection list found in the Settings window for Material.
Then, click the Remove from Selection button — or press Delete on your
keyboard.

- Alternatively, in the Graphics window, click domain 1 to remove it from the
selection list.

@ The domains 2, 3, 4, 5, 6, and 7 are highlighted in blue.
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You can enable and disable material color and texture from the Color
toolbar button in the Graphics window. To render the copper components
using a realistic color, select Show Material Color and Texture. This will also
enable material-true rendering of other materials. Here, you can also
enable coloring of selections by selecting Show Selection Colors.

B WrE-r-EBE TS
v Show Selection Colors

Show Material Color and Texture

The figures below show the Settings and Graphics windows corresponding
to a selection where a color (pink) other than the default has been used.
There is also a second selection (not shown) with another color (green).

Settings TE QAR eE L hbEK Gy @ S8 B ~23 @ @@e-a@E

Label: Tibolts E
¥ Input Entities

Geometric entity level: Domain -

& 50 i
|

o B oW ong

[] All domains

* Output Entities

Selected domains  +
~ Calor

Color: | NG -

Note that to see the color while creating a selection, you need to click the
Suppress Selection Highlight button in the Graphics toolbar. For more
information on Selections, see page 140.

To further increase the level of realism in material rendering you can
enable Environment Reflections from the Scene Light menu button in the
Graphics toolbar. From this menu you can choose an Indoor Environment
or Outdoor Environment.



The corresponding image, known as a skybox image, will be reflected in
the material, thereby increasing the level of realism. This is particularly
visible when the material is a metal, as shown in the figure below.

By selecting the Show Skybox option you can display the corresponding
skybox image used for the environment reflection.

For best results you will need a graphics card that supports OpenGL. See
also “Graphics and Plot Windows” on page 14.
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9 In the Settings window

for Material, be sure to "
inspect the Material
Contents section for the Label:  Titanium beta-215 =
titanium material. All of Name:  mat2
the proRertlcs used by Geometric Entity Selection
the physics should have a
check mark . Geometric entity level: Domain =
Selection: Manual =
=3 :
3 E —
4 T W
5 ..
6
7
Override
Material Properties
¥ Material Contents
L . =
Property Variable | Value Unit
[ |Electrical conductivity sigma.. | 7.407e5[5/m] | 5/m |
e [ |Heat capacity at constant pressure | Cp TI00/ (kg*K)] | )/ (kgK) |1
[ |Relative permittivity epsilo., |1 1 |
[ |Density rho 4940[kg/m*3] | kg/m® ||
[ |Thermal conductivity k_iso . | TSW/ K] | W (me ||
Relative permeability mur_is... | 1 1 |
Coefficient of thermal expansion | alpha_... 7.08e-8[1/K] /K |
Young's modulus E 105e9[Pa] Pa ]
Poisson's ratio nu 0.33 1
10 Close the Add Material . ]
. . . . aters PR X
window cither by clicking the Add Meateria @
. . . Add to Global Materials Add to Component
icon in the upper-right corner or -
earc

by clicking the Add Material :

. . [+ 225 Recent Materials
toggle button i in the Materials b @ Material Library
group of the ribbon Home tab. b 3 Built-in

Physics and Boundary Conditions

Next, you will inspect the physics domain settings and set the boundary conditions
for the heat transfer problem and the conduction of the electric current.

In the Model Builder window, examine the default physics nodes of the
multiphysics interface for Joule Heating. First, collapse the Materials node. Then,
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click the arrows next to the Electric Currents x , Heat Transfer in Solids =, and
Multiphysics .z, nodes to expand them.

Model Bu ¥ 1| Settings v
e - Electromagnetic Heating
4 & busbar.mph (root)
4 () Global Definitions Label:  Electromagnetic Heating 1 =
Fi Parameters 1 Name:  emhl
= Materials
4 |§ Component1 (comp1) ¥ Domain Selection
[ Definitions
I Geometry 1 Selection:  All domains -
I 5z& Materials X
4 +\_ Electric Currents {ec) lil ;_ H t
i Current Conservation 1 3 El
S Electric Insulation 1 4 &
B Initial Values 1 3 i
4 | I8 Heat Transfer in Solids (ht) 7

&= Solid 1
& Initial Values 1 i
G Thermal Insulation 1 - By S

4 5 Multiphysics

Selection:  All boundaries -
% Electromagnetic Heating 1 (emh1)

A\ Mesh 1 0= s T
[~ Study 1 2 E —
b Results 3 El A

4 e
5
6

¥ Equation

Show equation assuming:

Study 1, Stationary -

Q.=]-E
The D in the upper-left corner of a node’s icon (&) means it is a default node.

The equations that are being solved are displayed in the Equation section of the
Settings windows of the respective physics nodes.

The default equation form, for example, whether it should be a stationary or
transient equation, is inherited from the study added in the Model Wizard. In this
case, the study is stationary and the equation form is the stationary version of the
equation system for Joule heating. For the Joule Heating multiphysics interface,
the equation system has the temperature and electric potential as dependent
variables.

To always display the equations in the Settings windows, click the Show

More Options button (=) on the Model Builder toolbar and select Equation
Sections so that a check mark appears next to it.
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The Heat Transfer in Solids and Electric
Currents nodes have the settings for heat
conduction and current conduction,
respectively.

Under the Electric Currents node, the
Current Conservation node represents the
conservation of electric current at the
domain level and the Electric Insulation
node contains the default boundary
condition for Electric Currents.

Under the Heat Transfer in Solids node,
the domain level Solid node represents the
conservation of heat and the Thermal
Insulation node contains the default
boundary condition for Heat Transfer in
Solids. The heat source for the Joule

4 & busbar.mph (root)
4 () Global Definitions
Fi Parameters 1
2 Materials
4 |§ Component1 (comp1)
[ = Definitions
[ Geormnetry 1
I 5z& Materials
rl +\_ Electric Currents (ec)
i Current Conservation 1
S Electric Insulation 1
B Initial Values 1
4 | I8 Heat Transfer in Solids (ht)
= Solid 1
B Initial Values 1
%= Thermal Insulation 1
- .{;3. Multiphysics
x| Electromagnetic Heating 1 (emh1)
A Mesh 1
[~ Study 1

b {8 Results

heating effect is set in the Electromagnetic Heating node under the Multiphysics
node. The Initial Values node, found in both the Electric Currents and Heat Transfer
in Solids interfaces, contains initial guesses for the nonlinear solver for stationary
problems and initial conditions for time-dependent problems.

Now, define the boundary conditions.

I Right-click the Heat Transfer in Solids node ia. In the second section of the
context menu — the boundary = section — select Heat Flux.

I 5z& Materials
4 +\_ Electric Currents {ec)
= Current Conservation 1

S Electric Insulation 1

i Initial Values 1
G 4 | I8 Heat Transfer in Solids (ht)
= Solid1 1= Solid
i Initial Values 1 = Fluid
%= Thermal Insulation 1
- = Heat Source

4 5 Multiphysics

x| Electromagnetic Heating 1 I= Initial Values

Domain section

~L—Section divider

Boundary section

£ Mesh 1 Specific Media
[~ Study 1
b [B Results m  Temperature
= Thermal Insulation
m»  Heat Flux
= Symmetry
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2 In the Settings window for Heat Flux,
select All boundaries from the Selection
list.

Assume that the circular bolt
boundaries are neither heated nor
cooled by the surroundings.

In the next step, you will remove the
selection of these boundaries from the
heat flux selection list, which leaves

¥ Boundary Selection

Selection:

o=

Manual

Manual

All boundaries

them with the default Thermal Insulation boundary condition for the Heat

Transfer in Solids interface.

i

3 Rotate the busbar to view the back. Move the mouse pointer over one of the
circular titanium bolt surfaces to highlight it in green. Click the bolt surface to
remove this boundary selection from the Selection list. Repeat this step to
remove the other two circular bolt surfaces from the selection list. Boundaries

8, 15, and 43 are removed.

Cross-check: Boundaries 8, |15, and 43 are removed from the

Selection list.

01
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4 In the Settings window for Heat

Flux, in the Heat Flux section, select T Heat Flux
Convective heat flux as the Flux Flux type:
type. Enter htc in the Heat transfer G Convective heat flux =
coefficient ficld, 4. Hest transfer coefficient:

User defined g
This parameter was either entered P ———
in the Parameter table in “Global h e Wi(maK)
Definitions” on page 77 or External temperature:
imported with the geometry. T [Bikerdenined -

293.15[K] K

More advanced boundary conditions for heat transfer analysis are
available with the Heat Transfer Module. Examples include the
capability to give the total deposited power or to set boundary
conditions for common natural convection scenarios such as for a
horizontal or vertical wall.

Continue by setting the boundary conditions for the electric current according
to the following steps:

5 In the Model Builder window, right-click the Electric Currents node x . In the
second section of the context menu — the boundary section — select Electric
Potential. An Electric Potential = node is added to the model tree.

4

4 & busbar.mph (root)
4 () Global Definitions

g

F'L Parameters 1 = Current Conservation
{: Eﬂe::;:i;ltﬂodel Inputs I&= External Current Density
4 i Component1 {camp1) I= Force Calculation
b = Definitions =  Piezoresistive Material
: :ﬂeaDt::ieatI?1 1= Current Source
4 *_ Electric Currents (ec) I= Terminal
i Current Conservation 1 = Initial Values
S Electric Insulation 1
B= Initial Values 1 a Ground
4 |[E Heat Transfer in Solids (ht) | s Electric Potential G

= Solid 1

s . m  Electric Insulation
i Initial Values 1
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6 Move the mouse pointer over the circular face of the single titanium bolt to
highlight it and then click to add it (boundary 43) to the Selection list.

7 In the Settings window for Electric
Potential, cnter Vtot in the Electric ¥ Electric Potential
potential field. Electric potential:

. Vg Wi
The last step is to set the surfaces of the o (ot Y

two remaining bolts to ground.

8 In the Model Builder window, right-click the Electric Currents node x . In the
boundary section of the context menu, select Ground. A Ground node = is
added to the model tree. The model tree node sequence should now match this

figure.

4 *_ Flectric Currents {ec)

s
f= Current Conservation 1

G Electric Insulation 1

= Initial Values 1

o Electric Potential 1

¥y Ground 1 @
4 |[E Heat Transfer in Solids (ht)

= Solid 1

= Initial Values 1

G Thermal Insulation 1

o Heat Flux 1
4 .{;], Multiphysics

x| Electromagnetic Heating 1 (emh1)

The “warning” attribute displayed on the Ground node indicates that its
boundary selection is empty. The next step will be to select boundaries.
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9 In the Graphics window, click one of the remaining bolts to add it to the
Selection list.
6 Cross-check: Boundaries 8 and |5.

Repeat this step to add the last bolt. Boundaries 8 and 15 are added to the
selection list for the Ground boundary condition.

10 On the Graphics toolbar, click the Go to Default View button ...

Graphics
Qa@- @@ [Bxksls

Go to Default View

More advanced boundary conditions for electromagnetics analysis are
available with the AC/DC Module, such as the capability to give the total

current on a boundary.

COMBINING PHYSICS INTERFACES MANUALLY

As an alternative to using the preconfigured Joule Heating multiphysics interface,
you can manually combine the Electric Currents and Heat Transfer in Solids
interfaces. For example, you can start by setting up and solving the model for
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Electric Currents and then subsequently add Heat Transfer in Solids. In that case,
you right-click the Multiphysics node to add the required multiphysics couplings.

4 +\_ Electric Currents {ec)
&= Current Conservation 1
%= Electric Insulation 1
= Initial Values 1
mw Electric Potential 1
= Ground 1
4 [F Heat Transfer in Solids (ht)
= Solid 1
= Initial Values 1
%= Thermal Insulation 1
mw Heat Flux 1
.{',’3. Multiphysics
A Mesh | s

[~ Study 1 mTh R
b I Results ermoelectric Effec

Electromagnetic Heating

Equilibrium Discharge Heat Source

6‘3 Equilibrium Discharge Boundary Heat Source

ﬂ Help

As an alternative, you can click the Add Multiphysics button in the Physics tab on
the ribbon and select a suggested multiphysics coupling in the Add Multiphysics
window.

@ : Add Multiphysics v A X
. i - i )
Heat Transferin  Add Add + Add to Component
Solids (ht) = Physics Multiphysics
Physics

4 (0 Recently Used
X Joule Heating
4 ¥} AC/DC
4 %)\ Electrornagnetic Heating
% Joule Heating
el Heat Transfer
4 %)\ Electrornagnetic Heating
_ X Joule Heating
Thermoelectric Effect
I &) Plasma

Select the physics interfaces you want to couple

Physics Couple
x_|Electric Currents (ec) =4
) Heat Transfer in Solids (ht) =4

Multiphysics couplings in study

Studies Solve
Study 1 =4
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Mesh

The simplest way to mesh is to create an unstructured tetrahedral mesh, which is
perfect for the busbar model. Alternatively, you can create several meshing
sequences, as shown in “Adding Meshes” on page 134.

A physics-controlled mesh is created by default. In most cases, it is possible
to skip to the Study node and just solve to get a solution. For this exercise,
the settings are investigated in order to parameterize the mesh settings.

I In the Model Builder window, click the

- . - !
Mesh | node 4 . In the Settings window
for Mesh, select User-cont'rolled mesh & Build Al
from the Sequence Type list. G
. Label: Mesh 1 =
2 Under Mesh 1, click the Size node 4} ——
¥ Sequence Type
[ Physics-controlled mesh - |

| User-controlled mesh |

Physics-controlled mesh

4 /5 Meshl

©

Free Tetrahedral 1
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3 In the Settings window for Size, in
the Element Size scction, click the
Custom button.

Under Element Size Parameters,
enter:

- mh in the Maximum element size
field. Note that mh is 3 mm — the
value entered earlier as a global
parameter. By using the parameter
mh, element sizes are limited by
this value.

- mh-mh/3 in the Minimum element
size ficld. The Minimum element
size is slightly smaller than the
maximum size.

- 0.2 in the Curvature factor ficld.
The Curvature factor determines
the number of elements on curved
boundaries; a lower value gives a
finer mesh.

The other two parameters are left
unchanged.

©

Settings

Size

& Build Selected [§§ Build All

Label: Size E
Element Size

Calibrate for:
General physics -
O Predefined Maormal

® Custom
¥ Element Size Parameters

Maximum element size:

mh m
Minimum element size:

mh-mhy/3 m
Maximum element growth rate:

1.5

Curvature factor:

0.2

Resolution of narrow regions:

0.5

The Maximum element growth rate determines how fast the elements should
grow from small to large over a domain. The larger this value is, the larger the
growth rate. A value of 1 does not give any growth.

For Resolution of narrow regions, a higher value will generally result in a finer

mesh.

The asterisk (*) that displays in the upper-right corner of the Size node 2}
indicates that the node is being edited.
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4 Click the Build All button & in the Settings window for Size to create the mesh,

as in this figure:

0.1

T

SRR

IQSSTS

T
SRR RIS

SIS

SSEE
ERRICKRY

T
N L

0.1

You can also click Build Mesh in the Home tab of the ribbon.

Study
I To run a simulation, in the Model 4 A Mesh
Builder window, right-click Study ize

ree Tetrahedral 1

I ~» and choose Compute =.You

. G [~ Study 1
can also press F8 or click b [ Results | = Compute F8
Compute on the ribbon Home tab. Parametric Sweep

The Study node ~» automatically

defines a solution sequence for the
simulation based on the selected 2
physics and study type. In this case, S5

the simulation only takes a few
seconds to solve. During the solution process, two Convergence plots are generated

and are available from tabs next to the Graphics window. These plots show the
convergence progress of the different solver algorithms engaged by the Study.

Function Sweep
Material Sweep
Study Reference

Combine Solutions
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Results

By default, in the Results node, four plot groups
are generated: a Volume plot of the Electric
Potential, a Multislice and Streamline Multislice plot
of the Electric Field Norm (the magnitude of the
clectric field) and Electric Field, a Surface plot of the
Temperature, and a plot named Isothermal Contours
containing an Isesurface plot of the temperature.

Click Results > Temperature @ to view the
Temperature plot in the Graphics window. The
temperature difference in the device is less than 10
K due to the high thermal conductivity of copper
and titanium. The temperature variations are
largest in the top bolt, which conducts double the
amount of current compared to the two lower
bolts. The temperature is substantially higher than
the ambient temperature of 293 K.

4 [E Results

b £

[

252 Derived Values

=

Datasets

Tables

W Electric Potential (ec)

) volume 1

W Electric Field Norm (ec)

P

il Termperature (ht)

5 Multislice 1

] Streamline Multislice 1

™ Surface

l'ﬁ Isothermal Contours (ht)

#

o
& lsosurface

Export
Reports

I Click and drag the image in the Graphics window to rotate and view the back of

the busbar.

Surface: Temperature (K)

2 In the Graphics toolbar, click the Go to Default 3D View button .[..

You can now manually set the color table range to visualize the temperature

difference in the copper part.
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3 In the model tree, expand the Results > Temperature node w and click the
Surface node ™.

4 In the Settings window for Surface, click Range to expand the section. Select the
Manual color range check box and enter 324 in the Maximum field (keep the
default for Minimum and replace the default for Maximum). Click the Plot button
in the Settings window for Surface.

: “ 4]
G [ Plot
Label: Surface =
Data
Expression = % ov
I Title
~ Range

Manual color range
Minimum:  322.39376

Maximum: 324

5 On the Graphics toolbar, click the Zoom Extents button [ to view the updated
plot.
6 Click and drag in the Graphics window to rotate the busbar and view the back.

o

Surface: Temperature (K) Surface: Temperature (K)

-0.02 324 324

The temperature distribution is laterally symmetric with a vertical mirror plane
running between the two lower titanium bolts and cutting through the center of
the upper bolt. In this case, the model does not require much computing power
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and you can model the entire geometry. For more complex models, you can
consider using symmetries to reduce the computational requirements.

Select Go to Default View on the toolbar in the Graphics window -l
Then, generate a Surface plot that shows the current density in the device.

I In the Model Builder window, )
5 Derived Values

o

Wl Temperature (ht)
i Isothermal Contours (ht) El Arow Volume
i@ 3D Plot Group 5 ™ Surface

] Export

right-click Results & and add a 3D Plot B Tables Plot

Group @& . In the Label ficld, enter b i Electric Potential (ec) Plot In

Current Density to give the plot | o Electne Peld o (20 Volume
[

group a descriptive name. Right-click
3D Plot Group 5@ and add a Surface

- =—
node m. 7 Reports M slice
¥ lsosurface
2 In the Settings window for Surface under _
. ] . 4 Electric Currents
Expression, click the Replace Expression 4 Currents and charge
button % . Go to Model > Component | > ec.n) - Normal current density - A/m®
. G .norm)J - Current densi - Afm?
Electric Currents > Currents and charge > e —rE———
ec.rhog - Space charge density - C/m

ec.norm]) - Current density norm - A/m? and ec.rhogs - Surface charge density - C/m?
double-click or press Enter to select.

ec.normd is the variable for the

magnitude, or absolute value, of the v Expression = %~
current density vector. You can also Expression:

type ec.normd in the Expression field ec.norm

when you know the variable name or, Unit

alternatively, use the auto completion Afm*2 -
functionality by typing norm and then [ Description:

pressing Ctrl+Space to get a variable Surentdensiynon,

name suggestion.

3 Click the Plot button @ .

The plot that displays in the Graphics window is almost uniform in color due to
the high current density at the contact edges with the bolts. The next step is to
manually change the color table range to visualize the current density
distribution.
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4 In the Settings window for Surface under Range, sclect the Manual color range
check box. Enter 1e6 in the Maximum field and replace the default.

~ Range

G Manual color range

Minimum: 019079

Maximum:  Te6

5 Click the Plot button @ .

The resulting plot shows that the current takes the shortest path in the
90-degree bend in the busbar. Notice that the edges of the busbar outside of
the bolts are hardly carrying any current.

Surface: Current density norm (A/m?)
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6 Click and drag the busbar in the Graphics window to view the back. Continue
rotating the image to see the high current density around the contact surfaces
of each of the bolts.

Surface: Current density norm (A/m?)

01 0.04

=
When you are done, click the Go to Default View button ... on the Graphics toolbar.
GETTING THE MAXIMUM AND MINIMUM TEMPERATURE

You can easily obtain the maximum and minimum temperature values in the
busbar, including their locations.
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I Right-click Results > Temperature @ and select More Plots > Max/Min Volume.

[~ Study 1
4 ([ Results
I #: Datasets
£ Derived Values
B Tables
I\l Electric Potential (ec)
I Ni@ Electric Field Norm (ec)
4 @ Temperature (ht)
™) Surface Plot F8
I Ni@ lsothermal Contou

: Plot In '
I §@ Current Density
= Export B volume
[# Reports =] Arrow Volume
™ surface
W slice
¥ lsosurface

+

Arrow Surface

‘4 Image

0 Line

@ Contour

3F  Streamline

:j Arrow Line

[E  Mesh

] Annotation G
More Plots 3 Scatter Volume

% Add Image to Export %) Coordinate System Volume
Copy as Code to Clipboard » | %5 Max/Min Volume

1+ MoveUp Ctrl+Up & Coordinate System Surface

2 In the Settings window for Max/Min Volume under Expression, click the Replace
Expression button % . Go to Model > Component | > Heat Transfer in Solids >
Temperature > T - Temperature - K and double-click or press Enter to select. You
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can also search for Temperature in the search field above the tree of
postprocessing variables or manually enter T. Click Plot.

Label: Max/Min Volume 1
~ Data
Dataset: | From parent

~ Expression

Expression:

v

Unit:

v

[ Description:

Electric potential
Title

I» Advanced

~ Coloring and Style

Color: Black

Background color: | None

[] Show frame

4 Model
Global definitions
Materials

v -

4 Component 1 (compT)
Definitions
Frames

-

Geometry

Mesh

Electric Currents
Heat Transfer in Solids
Dormain fluxes

AT T T T

-

Heat and energy balance
Heat sources
Material properties

AT T T

Temperature
b Weighted average temperature

T- Temperature - K

ht.gradTmag - Temperature gradient magnitude - K/m
b Temperature gradient - K/m

Double-click or press Enter to add selected expression.

2

The maximum and minimum values are plotted in the Graphics window and
their locations and values are displayed in the Maximum and minimum values
table. The values may vary a bit depending on the version you are running. For

a finer mesh the results will be the same regardless of version.

aa@-@L-rn ¢y @

Ly' 002
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Messages ~ Progress Log  Maximum and Minimum Values

x Temperature (K
006327200000 00000 [322.39
010500 |-0.024899)0.053425/330.40
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Surface: Temperature (K) Max/Min Volume: Temperature (K) L
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320

max: 330.400

min: 322.303
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As an alternative to the method of plotting the maximum and minimum values
described above, you can use the Derived Values node or an Evaluation Group for a
pure numerical output. The following steps show how to use Derived Values.

3 In the Results section of the model tree, right-click the Derived Values :: node
and select Maximum > Volume Maximum .

4 In the Settings window for Volume Maximum, under Selection, choose All
domains.

5 In the first row of the Expression table, enter T (unless it is automatically filled
out) for the temperature and click Evaluate at the top of the Settings window.

Model Builder L
+~— ‘= Et -
4 & busbar.mph (root)
[ {E‘:-,I Global Definitions
4 [ Component 1 (comp1) Label: |Volume Maximurm 1 =
[ = Definitions

4

~ Data

-

4| Geometry 1
I 5z& Materials
[ +\_ Electric Currents (ec)
[» IIE) Heat Transfer in Solids (ht)
I .y Multiphysics
[ A Mesh1
[~ Study 1

4 [ Results ‘
I # Datasets

4 &32 Derived Values

Dataset:  Study 1/5olution 1 (sol1) x| |z
¥ Selection

Selection: All domains =

E=limir
|

max Volume Maximum 1
I E Tables
I* §@ Electric Potential (ec)
I §@ Electric Field Norm (ec)
4 V@ Temperature (ht) ~ Expressions G
™) Surface
25 Max/Min Velume 1
I §@ lsothermal Contours (ht) M=
4 @ Current Density
™) Surface 1
& Export
[# Reports

L T
i

AV
4

L
Expression Unit Description
T K Temperature

The resulting maximum temperature is shown in Table 1.

Messages Progress Log | Table 1 X
ML 2. @O V1D =
Temperature (K)

33041 e

As a next step, you can create a model thumbnail image.
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CREATING MODEL IMAGES FROM PLOTS

With any solution, you can create an image to display when browsing for model
files. After generating a plot, click the corresponding plot node in the Model
Builder window under Results. Then, click the root node (the first node in the
model tree). In the Settings window for the root node, under Thumbnail, click Set
from Graphics Window.

There are two other ways to create images from a plot. One is to click the

Image Snapshot button @ in the Graphics window toolbar to directly create an
image. You can also add an Image node & to the Export node to create an image
file. Right-click the plot group of interest and then select Add Image to Export.

You can use the Image Snapshot button to export Results visualizations to
glTE™ (file extension .glb). These files can then be opened in 3D
visualization software such as Paint 3D from Microsoft®, as shown in the
figure below. (If you are running Windows® 10 or 11, then this may be
available in your system.) You can also find gl TEF™ viewers online that run
in web browsers.

Make sure to save the model at this stage. This version of the model,
busbar.mph, is reused and renamed during the next set of tutorials.
Alternatively, for the subsequent tutorials, you can use the busbar file in
the Application Libraries under COMSOL Multiphysics > Multiphysics.

Building an Application with the Application Builder

This section gives a brief introduction to using the Application Builder to create
applications, using the busbar model to demonstrate. Each application will have a
specialized user interface dedicated to interacting with the busbar model that
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includes input fields for the length, width, and applied voltage. The outputs will
be the maximum temperature and a temperature plot.

In this introduction, you will learn how to use the New Form wizard to quickly
create an application in two different ways, using two different layout templates.
The wizard is used to create one or more forms with user interface components
called form objects. The wizard gives quick access to a subset of all of the form
objects available for creating applications with the Application Builder. In the
following examples, you will learn how to add input fields, numerical outputs,
graphics, and buttons. For detailed information on building applications, see the
Introduction to Application Builder manual.

The first example shows how to create an application based on a single form, using
the Single form template. The Single form template makes it easy to interactively
move buttons and edit fields by dragging. However, it does not allow you to resize
the graphics when changing the size of the application window. The second
example demonstrates how to use the Basic template to create an application with
several forms, subwindows, and a ribbon. Using this template automatically
creates an application with a resizable graphics window.

CREATING AN APPLICATION USING A NEW SINGLE FORM

I This example uses the busbar model. You can open the busbar file from the
Application Libraries under COMSOL Multiphysics > Multiphysics or, if you saved
your model upon completing Example 2 on page 109, you can open your saved
busbar.mph file.

To switch from the Model Builder to the Application Builder, click the

Application Builder button in the leftmost Workspace section of the Home tab on
the ribbon.

e hEdR
File Home  Defin

A

Application Model
Builder ~ Manager

Workspace

o
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2 To create a new form, click the New Form button on the ribbon. This will create
a new global form.

Home
® E [

Model  Model MNew
Builder Manager  Form -

2

In the Select Template page of the wizard, select Single form.

e DEER > EDED

Home
Select Template

|

[E7] Blank form
| [f) Basic
[ subwindows

Single form G

[EMll Ribbon, tabs, and graphics

[EMl Toolbar, sections, and graphics

[Em Buttons, sections, and graphics

(Ml Compact layout for tablets

[Emll Advanced compact layout for tablets
[EMll Compact layout for smartphones

[EMll Advanced compact layout for smartphones

@ content G

[2 B3 @@me\ [/ pone

Click Content to continue.



The Select Content page appears.

S e R > is h busbar.mph - (
Fie [

Select Content

Formtitle  Form 1| [] Labels on top

Form name:  form1

Inputs  Qutputs  Graphics  Buttons
Available: Selected:

4 % Model (root)
4 () Global Definiticns
4 F; Parameters 1

== Length (L)

&= Bolt radius (rad_1)

o= Thickness (tbb)

o= Width (whb)

o5 Maximum element size {mh)

== Heat transfer coefficient (htc)
&= Applied voltage (Viot)

eTempme
(2B e(an(e\ [+ pone

It consists of four tabs for Inputs, Outputs, Graphics, and Buttons. On the Inputs
tab, you can double-click the parameters in the tree to make them available in
the user interface of the application. For this application, we will select a few of
the parameters as input fields and the maximum temperature as the output.
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3 On the Inputs page, double-click each of the parameters: Length (L), Width
(wbb), and Applied voltage (Vtot). Also, on the Outputs tab double-click Volume
Maximum under Derived Values.

B TR > i § busbar.mph - COMSOL Multiphysics - O X
a

Select Content Preview

Form title: Form 1 [] Labels on top Length: 9 m

Form name:  form1 Width: 5 m

Inputs  Qutputs  Graphics  Buttons Applied voltage: 20 my

Available: Selected: Temperature 0.001235K

4 % Model (root) 4 % Model (root)
4 ) Global Definitions 4 [l Results
4P| Parameters 1 4 1 Derived Values
a Length (L) v Volume Maximum 1

o5 Bolt radius (rad_1)
o5 Thickness (tbb)
== Width (whb)
=5 Maximum element size (mh)
=5 Heat transfer coefficient (htc)
o5 Applied voltage (Vtot)

4 [ Results

4 Tables

B2 Maximum and Minimum Values
FH Table 1

eT&mp\a(e
(2 23 etanze\ [ oone

23GB|3.68GB

The Preview section to the right displays the user interface layout.

4 Click the Graphics tab in the wizard and double-click the Temperature plot. A
graphics object placeholder appears in the Preview area.

o e OR > s ¥ busbar.mph - COMSOL Multiphysics - o X
a
Select Content Preview
Formtitle: | Form 1 [7] Labels on top Length: 9 m
Form name:  form1 Width: 5 em
Inputs | Outputs  Graphics _Buttons Applied voltage: 20 mv
Available: Selected: Temperature:  0.001235K
4 @ Model (root) —+ 4 @ Model (root) VAR R
4 T Component 1 (comp1) 4 [ Results
A Geometry 1 Wl Temperature (ht) 4
A Mesh 1
4 [E Results

Wl Electric Potential (ec)
Wl Electric Field Norm (ec)
Wi Isothermal Contours (ht)
Wil 30 Plot Group 5

eTEmp\a(E
[ 2 B ecan:e\ [M pone

2.8GB|364GB
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5 Click the Buttons tab in the wizard and double-click Compute Study. A Compute
button now appears in the Preview area beneath the graphics object.

e hEPR >

Home
Select Content

Formtitle: | Form 1

Form name: ~ form1
Inputs  Outputs Graphics Buttons
Available:

» B GUI Commands
4 % Model (root)
4 [ Component T (compT)
YA\ Plot Geometry 1
A Plot Mesh 1
4 [E Results
N Plot Electric Potential (Ec)
N Plot Electric Field Norm (E<)
Wil Plot Temperature (Ht)

Nl Plot Isothermal Contours (Ht)

Nl Plot 3D Plot Group 5

eTEmp\ate
B Hee e(ame\ [ pone

h busbar.mph - COMSOL Multiphysics - [m] X
Preview
[] Labels on top Length: 9 cm
Width: 5 om
Applied voltage: |20 mV
Selected: Temperature: 0.001235K
4 49 Model (root) Q- LrEEzn[cre-
i Compute Study 1 ‘r ; B o=
Compute

28GB|[3.64GB

6 Finally, click Done to accept the settings and close the wizard.

After closing the Form wizard, the Form Editor is opened. The Form Editor
allows you to drag and drop form objects and add new form objects. The default

view is a preview of the form. Double-click forml to enable editing.

SINEORroCcXEHBDRER-
Home  form
JInput Field [7)Text Label FHGrid o on|
= = =) [#[a]
(58 Button Data Display -ttSk:t:h
Mo == Show Grid Arrange
[ Check Box [Graphics  Objects - Lines 5
Form Objects Layout Sketch Grid
Application Builder v n [@Preview [Jform1 X
=t 5| v
4[] busbar.mph (root] i Length: 9 ==
Inputs
%  — Width: & cm
b 7] Main Window Applied voltage: 20 ml
4 B Forms Temperature: 0001235 K
[ form1
] Events
= Declarations
2 Methods aQ@-@L-krzn C-
b [l Libraries +- B ow@g J
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7 You can rearrange the user interface by dragging the graphics object to the right
of the input fields and dragging the button to a position directly under the input
fields, as shown in the figure below. Blue guidelines will aid you in aligning the

objects.

[@] Preview [ form1 X

v

M Length: o m Tae@-@ i HEER G- - BERD @B
Width: 5 m

Applied voltage: 20 mv

Temperature: 0.001235K

Compute

You can make the graphics object larger or smaller by dragging the blue handles.
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8 You can test the application by clicking Test Application on the ribbon.

N
> OO,
Test Preview Testin Web @
Application Form  Browser -

Test

Alternatively, you can click the corresponding button in the Quick Access
Toolbar. This creates a run-time copy of the application and lets you quickly try
different designs during the process of developing an application.

> Untitled.mph - Parameterized Busbar Geometry - o X

Length: 0 m aa@-@ Lk o MEOeEENas

Width: 5 m

surface: Temperature (K) Max/Min Volume: Temperature (K}
Applied voltage: 20 my

Temperature: 3304 K 392

Compute

About

9 Now, try a different Length value, for example, and click Compute.

ADDING A BUTTON

You may wish to preview the geometry before starting the computation. This can
easily be done by adding a button. There are two ways to add a button. Either click
Button button in the Form Objects scction of the Form tab on the ribbon, as shown
in the figure below, or use the Editor Tools window. In this example, you will use
the latter method.

o INBOR > o X @
Home  Form
input Field [T]Text Label E’
[2K] Button Data Display e
[+ Check Box [ Graphics Objects +
Form Objects
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| First, make sure the Editor Tools window is visible by selecting the
corresponding button on the Home tab of the ribbon.

e hEER»5 b |

Home  Form
’. D " Data Access
M

\ EﬁRecord Method Edi‘torTooIs G
Model  Model Mew ew X
Builder Manager  Form - Method - (&3 Compiler

Workspace Main

2 In the Editor Tools tree, right-click the Geometry node and select Button.

Settings Editor Tools X At
S EditNode =t v El ~

% Themes

D Main Window
b B Forms
I @ GUI Commands
b [ Libraries
4 & Model (root)
I () Global Definitions
4 |§ Component 1 (comp1)
= Definitions
'}f-\ Geomnetry 1
i= Mate [/ Graphics

*_ Elect G
iy Button
) Heat =

<y Multi S¢ Edit Node
A5 Mesh 1

v v v v v W v

3 Drag the Geometry button to the left of the Compute button.

[@ Preview [ form1 X
v
L
Length: 9 m Qa@~@ - arEn(¢r o BEMO B8
Width: 5 om
Applied voltage: 20 my

Temperature:  0.001235K

Geometry Compute

For each button, there is a command sequence that controls the action taken
when it is pressed. The command sequence is defined in the Settings window of
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the button. You can open the Settings window (if not already opened) by
double-clicking a button.

4 Double-click the Geometry button to see its Settings window. Command
sequences appear below the tree in the Choose Commands to Run section.

Settings X Editor Toals L ]
Button

Name: button2 5]
Text: Geometry

lcon: geometry 32png v + [=
Size: Large -
Style: Outlined -

Tooltip:
Keybeard shortcut:

¥ Choose Commands to Run B8

B Forms
» [ GUI Commands
b [ Libraries
4 % Model (root)
) Global Definitions
ompenent 1 (comp1)
b = Definitions
4 YA Geometry 1
b & Work Plane 1 (wp1)
[EL Extrude 1 (extl)
b B Work Plane 2 (wp2)

Edit Nede Run [& Plot Set Value Show

Show as Dialeg Import File Enable Disable

L3
Command Icon | Arguments

Plot Geometry 1 graphics1 G

-

In this case, the command sequence for the Geometry has one command for
plotting the geometry. The input argument contains information concerning
which graphics window to send the geometry plot to. In this case, the graphics
object is graphics1.

To automatically adjust the axis settings, you can add a Zoom Extents command.

5 In the Choose Commands to Run scction, locate the Zoom Extents command
under GUI Commands > Graphics Commands. Double-click to add it to the
command sequence.

6 Now, create the input argument to the Zoom Extents command. Click the white
field next to Zoom extents and click the Edit Argument button.

L
Command lcon | Arguments
Plot Geornetry 1 graphics1
Zoom extents G
t f==3 . ~ 4
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7 This opens a dialog box with possible input arguments. Select graphics| under
forml.

3 Edit Argument X
4 & Forms
el D form1
graphics1 e

@_‘ Use as Argument
Selected argument:
[ graphicsl
OK Cancel

8 The command sequence is now complete.

L
Command lcon | Arguments
Plot Geornetry 1 graphics1
Zoom extents form1/graphics1 e
t == . - i

9 To make sure the new Geometry button works, you can test the application again
by clicking Test Application on the ribbon.

USING FORMS IN THE MODEL BUILDER

Forms without graphics form objects can be used in the Model Builder. You can
use this functionality to create customized Settings windows for common or
repetitive tasks, for example. If you would like to reuse your customized Settings
window between sessions or even with other users, you can create an add-in, as
explained in the Introduction to Application Builder.
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To use a form in the Model Builder that was created with the Application Builder,
right-click Global Definitions and select the form under Settings Forms.

9] ~y
sullder

Mode

+— ‘® Et -

4 & busbar.mph (root)
4 (7 Global Definitions
P; Parameters 1 Fi  Parameters
4 Default Model | 5=

Variables
i Materials :
b {@ Component 1 (con Functions
b o Stucy 1 Geometry Parts
4 [ Results Mesh Parts

[ Datasets

Tables Materials
i Electric Potenti

§i§ Electric Field Ny Load and Constraint Groups

[

[

[

[

I Nl Temperature (h Thermodynamics
b Ni§ Isothermal Con

b @ 30 Plnt Groun§

D form1 Settings Forms

[# Reports =

METHODS

Derived Values | ¥ Default Model Inputs

Cosimulation for Simulink

Show More Options...

When you need to perform a more advanced operation than what is possible with
a command sequence, you can use the Method Editor to write code that defines
the actions to be taken when the user clicks a button, selects a menu item, etc. In
addition to calling methods from applications or Settings Forms, you can call
methods from the Developer tab on the ribbon or from Method Calls in the model
tree. For more information, see Introduction to Application Builder.

An easy way to get started with the Method Editor is to convert an existing

command sequence into a method.

I In the Application Builder, locate or open the Settings window for the Geometry
button again. Click the Convert to Method button below the command
sequence. (The other two options in the drop-down list are for creating two

types of local methods.)

T % .v i
5E Convert to Method

¥ Dialog Actior ™
5E  Convert to Form Method

Close dialo -
g 2 o . 5E  Convert to Local Method
ore changes|
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2 To open the method in the Method Editor, click the Go to Method button below
the command sequence.

L
Command lcon | Arguments
method1 B

b BE -

~ Dialog Act Go to Method

The Method Editor now opens with the code for methodl, corresponding to
the Plot Geometry and the Zoom Extents commands in the previous command

sequence.

App ication Builder -a [a) Preview [ form1 method] X

= =t e = @ LseGrUpMc;Cdeel.cumpunent('-::n;;').gEDm( geoml™), “"graphicsl");
- — zoomExtents ("forml/graphics1");

4 [2] busbar.mph (root)

E Inputs
B Themes
b D Main Window

4 3 Forms
D form1

Events

= Declarations

4 [ Methods
method1 G

I [l Libraries

The Application Builder has several tools for automatically generating code. In
addition to converting a command sequence to a method, you can, for example,
click Record Code on the ribbon.

@] o

Goto Record Use
Node Code Shortcut

Code
This will generate code for each operation performed in the COMSOL Desktop
windows. Click Stop Recording on the ribbon to stop recording and go back to the
Method Editor.

CREATING AN APPLICATION USING THE BASIC TEMPLATE

This second example shows how to use the Basic template to create an application
with several forms, subwindows, and a ribbon. Using this template creates an
application with a resizable graphics window. Note that the type of applications
that you create using templates can also be built using manual steps by starting
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from a Blank form or Single form template; however, using templates accelerates
this process. For more information, see Introduction to Application Builder.
This example uses the busbar model. You can open the busbar file from the
Application Libraries under COMSOL Multiphysics > Multiphysics or, if you saved
your model upon completing Example 2 on page 109, you can open your saved
busbar.mph file.

I To switch from the Model Builder to the Application Builder, click the

Application Builder button in the leftmost Workspace section of the Home tab on
the ribbon.

e @R

File Hoeme  Defin

A

Application Model
Builder ~ Manager

Workspace

o
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2 To create a new form, click the New Form button on the ribbon. This will create

a new global form.

Home
® E [

Model  Model MNew
Builder Manager  Form -

2

In the Select Template page of the wizard, select Basic.

I DBEERr o XEREBD I

I o
Select Template

) Biank form

[ Basic G

[ subwindows
Single form

[Em Ribbon, tabs, and graphics

[ Toolbar, sections, and graphics

[Emll Buttons, sections, and graphics

[Emll Compact layout for tablets

[EMl Advanced compact layout for tablets
[Em Compact layout for smartphones

[Eml Advanced compact layout for smartphones

@ content G

Click Content to continue.
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The Select Content page appears.

Select Content Preview
[7] Labels on top (= Home
Inputs  Outputs  Graphics  Ribbon buttons
Available: Selected:
4 % Model (root) 15 Inputs.
4 @) Global Definitions 4 % Model (root) Main
4 Py Parameters 1 4 () Global Definitions
o= Bolt radius (rad_1) 4 Pi Parameters 1 |¥ Inputs |
o Thickness (thb) 2= Length (L) —— ]
55 Maximum element size (mh) =5 Width (wbb) i . i
55 Heat transfer coefficient (htc) == Applied voltage (Vtot) | Width: 5 cm,
| Applied voltage: |20 myi

+ Add Form i Edit Form — Remove Form

eTEmp\ate
B @ [Fome

Just like when using the Single form template, this page consists of four tabs for
Inputs, Outputs, Graphics, and Ribbon buttons. On the Inputs tab, you can
double-click the parameters in the tree to make these available in the user
interface of the application. In the same way as in the earlier example, using the
Single form template, on the Inputs tab, double-click each of the parameters:
Length (L), Width (wbb), and Applied voltage (Vtot). Also, in the Outputs page
double-click Volume Maximum under Derived Values.

3 Continue by clicking the Graphics tab in the wizard and double-click the
Temperature plot. A graphics object placeholder appears in the Preview area.

e DeER > b busbar.mph - COMSOL Multiphysics - o X
T Fore a
Select Content Preview
[] Labels on top File Home

nputs | Outputs| Graphics | Ribbon buttons
Avalable: Selected
4 % Model (root) —+ 4 % Model (root)
4 @ Component 1 (comp) 4 @ Results Main
Wl Temperature (ht)
~ Inputs aa@- Ll
ool
%A\ Geometry 1 Length: 0 o
A vt it s @
4 (B Results Applied voltage: 20 mv
Wl Electric Potential (ec)
lectric Field Norm (ec) ~ Outputs
il Isothermal Contours (ht)
o Temperature: 0001235 K
@ rerpite

vep Q) Concel [ Done

139 GB| 1.63 GB
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When using the Basic layout template, this selection determines the default plot
shown when the application is started.

4 The Ribbon buttons tab displays the model and application tree nodes that can
be run by clicking a button on the ribbon in the application user interface.

In the figure below, buttons have been added corresponding to the actions: Plot
Geometry, Plot Mesh, Compute Study, Plot Electric Potential, Plot Temperature,
Plot Current Density, and Reset Window Layout.

Select Content Preview

[] Labels ontop

Inputs | Outputs | Graphics  Ribbon buttons =

el
Electric  Temperature Current Reset Window |
Potential(ec) ()  Density Layout

Available: Selected:
4 3 GUI Commands
b [ File Commands
b Ciy Graphics Commands. set Window Layout
» 4 Mode| Commands 4 % Model (root) ~ Inputs aa@- @i~
4 % Model (root) ne
4 T Component 1 (comp)

metry Mesh Compute

onent ! {co Length: 9 em

b = Definitio A PlotMesh 1 Width 5 em
4 B Results % Compute Stucly 1 Appliedvotage: 20 _—
Wl Plot Electric Field Norm (Ec) 4 @ Results
il Plotisothermal Contours (HY) Tl Plot Electric Potential (Ec) ~ outputs
Wl Plot Temperature (HY)
@ Plot Current Density Temperature: 0001235K
&) Termplate

|2 B3 g[an:e\ [ Bone

The option Reset Window Layout is available under GUI Commands > Main
Window Commands > Reset Window Layout. The application consists of two
subwindows, one for the inputs and outputs and one for the graphics. The Reset
Window Layout button will reset the two subwindows in the application to their
original size. The Subwindows template is similar to the Basic template but
additionally allows you to detach, move around, and dock the subwindows. In
this case, the Reset Window Layout operation will rearrange all subwindows to
their original position and size.

Using the Main Window Editor in the Application Builder, you can add ribbon
buttons that run your own custom command sequences or methods.

Click Done to exit the wizard. This automatically takes you to the Form Editor.
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5 You can test the application by clicking Test Application on the ribbon.

g Untitled.mph - Electrical Heating in a Busbar - o X
A = @ @ @
Geometry Mesh Compute i Temperature Curtent Reset Window
Potentil (ec) () Densty  Layoot
~ Inputs Qa@-@Lrkn ¢ FReEED 8
Length: 9 m Surface: Temperature (K) Max/Min Volume: Temperature (K) o
width s
Applied voltage: 20 v 01 o0
~ outputs
Temperature: 3304 K m
0.05
| min: 322.400
3 e
0.04
323
m 0.02
0
x
z‘_f m
y

To learn more about using the Form Editor and the Method Editor, see the book
Introduction to Application Builder, which provides more information on
writing methods. For more in-depth information on methods, see the
Application Programming Guide and the Application Builder Reference
Manual.

This completes the busbar example. To switch back to the Model Builder, click
the Model Builder button on the ribbon.

B Ihw L

Home
g

Model  Model
Builder Manager

Workspace

Overview of Advanced Topics

The next sections are designed to deepen your understanding of the steps
implemented so far and to extend your simulation to include additional effects like
thermal expansion and fluid flow. These additional topics begin on the following

pages:
o “Parameters, Functions, Variables, and Couplings” on page 128
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“Material Properties and Material Libraries” on page 133
“Adding Meshes” on page 134

“Adding Physics” on page 137

“Parametric Sweeps” on page 159

“Parallel Computing” on page 171

“COMSOL Multiphysics Client—Server” on page 175
“Appendix A — Building a Geometry” on page 201
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Advanced Topics

Parameters, Functions, Variables, and Couplings

This section explores working with parameters, functions, variables, and nonlocal
couplings.

The Global Definitions and Component > Definitions nodes contain functionality
that helps you to prepare model inputs and nonlocal couplings and to organize
simulations. You have already used the functionality for adding parameters to
organize model inputs in “Global Definitions” on page 77.

Functions, available as both Global Definitions and Component > Definitions,
contain a set of predefined function templates that can be useful when setting up
multiphysics simulations. For example, the Step function template can create a
smooth step function for defining different types of spatial or temporal transitions.

To illustrate using functions, assume that you want to add a time-dependent study
to the busbar model, where an electric potential is applied across the busbar that
goes from 0 V to 20 mV in 0.5 seconds. For this purpose, you could use a step
function to be multiplied with the parameter Vtot. In this section, you will add a
step function to the model that goes smoothly from 0 to 1 in 0.5 seconds to find
out how functions can be defined and verified.

DEFINING FUNCTIONS

For this section, you can continue working with the same model file created in the
previous section. Locate and open the file busbar.mph from page 109 if it is not
already open on the desktop.
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I Right-click the Global Definitions node @ and select Functions > Step I .

4 & busbar.mph (root)
4 (7 Global Definitions
Fi Parameters 1
4 Default Model
i Materials
I @ Component 1 (o
[~ Study 1
4 [ Results
3 Datasets
[» &2 Derived Values
I E Tables
I §i§ Electric Potent
I+ §i§ Electric Field
I N Ternperature |
I §i§ lsothermal Co
I §i& 3D Plot Group
Export
[# Reports

W

oi

Parameters
Variables

Functions

Geometry Parts
Mesh Parts

Default Model Inputs

Materials

Load and Constraint Groups
Thermodynamics

Cosimulation for Simulink

Method Calls

Settings Forms

Show More Options...

Mode Group
Group by Type

Help

Fi

Analytic
Interpolation
Piecewise
Gaussian Pulse
Ramp

Rectangle

Step

Triangle
Waveform
MNormal Distribution
Random

External

MATLAB
Elevation (DEM)
Image
Least-Squares Fit
Gaussian Process

Function Switch

2 In the Settings window for Step, enter 0.25 in the Location field to set the
location of the middle of the step function, where it has the value of 0.5.

Settings

Step
Plot Create Plot

Plot (F8) Step 1
Function name:  stepl

~ Parameters

G Location:  0.25
From: 0
To: 1

¥ Smoothing

Size of transition zone:

MNumber of continuous derivatives:

-1
=
05
2 -
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3 Click Smoothing to expand the section and enter 0.5 in the Size of transition zone
field to set the width of the smoothing interval. Keep the default Number of
continuous derivatives at 2.

4 Click the Plot button = in the Settings window for Step.

If your plot matches the one below, this confirms that you have defined the
function correctly.

G stepl o
4
F T T T T T T T T T T T T T T )

0.9+

0.8

0.7F

0.6

0.5F

0.4

0.3F

0.2

0.1}

h 1 1 1 1 n L L L L L L L L L L
-0.5 0.4 0.3 -0.2 -0.1 0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1

You can also add comments to the function to make it more descriptive.
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5 Right-click the Step | node I in the Model Builder window and select

Properties [=.

4 & busbar.mph (root)
4 () Global Definitions
Fi Parameters 1
_I” Step 1 (step?)

45 Default Model
i Materials
I @ Compenent 1 (con
[~ Study 1
4 [ Results
4 Datasets
b 25 Derived Values
I E Tables
I §i§ Electric Potenti
I N Electric Field N
I §i§ Terperature (h
I §i§ lsothermal Cor
I §i§ Current Density

Export

Copy as Code to Clipboard

Copy
Duplicate
Group
Delete
Disable

Rename

Ctrl+Shift+D
Ctrl+G

Del

F3

F2

Settings

Properties

Help

Fi

[# Reports

6 In the Properties window, enter any information you want. Right-click the
Properties tab and select Close when you are finished. Special characters and
markup tags that you use here will be displayed in reports generated from the

Reports node.

Settings

Label: Step 1
MName: stepl

Tag: stepl

¥ MNode Properties

Properties X

Created: Sep 15, 2022, 1:19:43 PM

Author: COMSOL

Version: Version 1.0 of this model

Comments L § E C €C C X X X o X, X2

Created for the Introduction to COMSOL Multiphysics.

a P v 58l MO LK L1V
CCTULVLOdLVOTL AOA
(I;\}IQ——__‘,

W @

[

v

=
-1

[1] o
[=]
=
=]

For the purpose of this exercise, assume that you want to introduce a second
component to represent an electric device connected to the busbar through the
titanium bolts.
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First, rename Component | to specify that it represents the busbar.
I Right-click the Component | node @ and select Rename =t (or press F2).
2 In the Rename Component window, enter Busbar. Click OK and save the model.

4 G busbar.mph (root)
I () Global Definitions

G [ [@ Busbar {compi)
[~ Study 1

[ @ Results

DEFINING NONLOCAL COUPLINGS AND PROBES

Right-click the Definitions node = under Busbar 4 % busbar.mph (root)
(compl) to introduce a nonlocal coupling that 4 (@) Global Definitions
t th . t 1 f Busb I Fi Parameters 1
computes the integral of any Busbar (compl) . - Varinbles |
variable at the bolt boundaries facing the electric I Step 1 (step1)
. . S
device. You can use such a coupling to define a & E:f:“!tl'““e' Inputs
B . . aterials
variable in a Variables node under the Global 4 T Busbar fcomp)
Definitions node that calculates the total current. 4 = Definitions
This variable is then globally accessible and [ou Integration | (intop)
) . [1»] Boundary Systern 1 (sys1)
could, for example, form a boundary condition b [ View 1
for the current that is fed to an electric device ::”"”_e"lm
2= Materials

+\_ Electric Currents {ec)

[
[

modeled as a second component. L,
[» IIE) Heat Transfer in Solids (ht)
[

The Nonlocal Couplings in Definitions have a wide ; rans
iy Multiphysics

range of uses. The Average - , Maximum = and b A Mesh
Minimum «~ couplings have applications in l E Study 1
[ Results

generating results as well as in boundary
conditions, sources, sinks, properties, or any
other contribution to the model equations. The Probes # are for monitoring the
solution progress. For instance, you can follow the solution at a critical point
during a time-dependent simulation or for each parameter value in a parametric
study.

You can find an example of using the average operator in “Parametric Sweeps” on
page 159. Also see “Functions” on page 231 for a list of available functions.

To learn more about working with definitions, in the Model Builder window,
click the Definitions = or Global Definitions @ node and press F1 to open the
Help window @ . This window displays helpful information about the selected
item in the desktop and provides links to the documentation. It could take

up to a minute for the window to load the first time it is activated, but will

load quickly the next time it is opened.
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Material Properties and Material Libraries

You have already used the functionality in the Materials node to access the
properties of copper and titanium in the busbar model. In the Materials node, you
are also able to define your own materials and save them in your material library.
In addition, you can add material properties to existing materials. In cases where
you define properties that are functions of other variables, typically temperature,
the plot functionality helps you to verify the property functions in the range of
interest. You can also load Excel® spreadsheets and define interpolation functions
for material properties using LiveLink™ for Excel®.

The Material Library add-on contains over 3800 materials with tens of thousands
of temperature-dependent property functions. In addition, many of the add-on
products include material libraries relevant to their application areas.

First, investigate how to add properties to an existing material. Assume that you
want to add bulk modulus and shear modulus to the copper properties.

CUSTOMIZING MATERIALS
Let us keep working on the busbar.

I In. the Model Builder window, under Materials, b A Geometry 1
click Copper :: . G 4 55 Materials

I» 2z Copper (matl)
b %22 Titanium beta-215 (mat2)
2 In the Settings window for
Material, click to expand the
Material Properties scction, b [l Geomechanics Material
which contains a list of all of b [l Hyperelastic Material
. 4 [fffi Linear Elastic Material
the definable properties. !
[
I
[
[
[
[
[

¥ Material Properties

24 Anisotropic

24 Anisotropic, Voigt Motation

2= Bulk Modulus and Shear Madulus

22 Compliance -+ Add to Material

22 Compliance, Voigt Notation

24 Cubic G
2= Cubic (3 Constants)

i Effective Flexibility Matrices

Expand the Solid Mechanics >
Linear Elastic Material scction.
Right-click Bulk Modulus and
Shear Modulus and select +
Add to Material.

This lets you define the bulk
modulus and shear modulus
for the copper in your model.

+

3 In the Copper node, locate the Material Contents section. Bulk modulus and Shear
modulus rows are now available in the table. The warning sign 4, indicates that
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the values are not yet defined. To define the values, click the Value column. In
the Bulk modulus row, enter 140e9 and in the Shear modulus row, enter 46e9.

¥ Material Contents

L

Property Variable
Bulk modulus K
e A Shear modulus G

[ |Electrical conductivity sigma_i..

[ |Heat capacity at constant pressure | Cp

[ |Relative permittivity epsilonr...

[ |Density rho

[ |Thermal conductivity k_iso; k..
Relative permeability mur_isa...
Coefficient of thermal expansion alpha_is...
Young's modulus E
Poisson's ratio nu
Reference resistivity rhol

# -

Value
1408

46e9

5.998€7[S/ ...
3850/ (kg™

:
2060[kg/...

A00[W/ (...

1
17e-6[1/K]
110e8[Pa]
0.35

1.72e-8[o...

Unit
N/m®
N/m*
5/m

1/ (kg K]
1
kg/m?*
Wi m:K)
1

/K

Pa

]

Om

Property group

Bulk modulus and shear m...
Bulk modulus and shear m...
Basic

Basic

Basic

Basic

Basic

Basic

Basic

Young's modulus and Poiss...
Young's modulus and Poiss...
Linearized resistivity

By adding these material properties, you have changed the contents of the Copper
material. You can save this information in your own material library, but not in the
read-only Solid Mechanics materials library.

4 In the Model Builder window, right-click Copper and sclect Add to User-Defined

Library [f.

b Geometry 1
4 EE Materials
I» 2zi Copper (matl)

I %22 Titanium beta-2| "= User-Defined Property Group

+\_ Electric Currents (e Merge With

[

[» {[E Heat Transfer in Solif

b iy Multiphysics [l Addto User-Defined Library G
[

A Mesh 1
~do Study 1

Copy as Code to Clipboard

To see this library, click the Browse Materials in the Materials tab on the ribbon.

Adding Meshes

A model component can contain different mesh sequences for generating meshes
with different settings. A mesh sequence is an ordered set of instructions for
generating a mesh. Mesh sequences can be accessed by the study steps. In a study,
you can select which mesh you would like to use in a particular simulation.

In the busbar model, a second mesh node is now added to create a mesh that is a

bit coarser (has larger elements).
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ADDING A MESH

I Open the model busbar.mph that
was saved earlier on page 109.

2 In order to keep this model in a
separate file for later use, select File
> Save As and rename the model
busbar_I.mph.

3 To add a second mesh node,
right-click the Component | node
@ and select Add Mesh 4 . (If you

busbar_l.mph (root)
(1) Global Definitions
Fi Parameters 1
45 Default Model Inputs
2 Materials
Il Component 1 {comp 1)
[ = Definitions
[ | Geometry 1
I
I
I
I
I

21 Add Physics
21 Add Multiphysics

2 Materials
+\_ Electric Currents (e iz}
[ Heat Transfer in Sol| 2
iy Multiphysics

Insert Physics

Insert Physics From

A Mesh 1 Moving Mesh
followed the instructions in b~ Study 1 Deformed Geometry
“Parameters, Functions, Variables, b B Results Topology Optimization
and Couplings” on page 128, the Shape Optimization
name of Component | is Busbar Parameter Estimation
instead.) Control Variables
By adding another Mesh node, a 6 £ Add Mesh
Meshes parent node is created that Capy as Code to Clipboard
contains both Mesh | and Mesh 2.

4 Click the Mesh 2 node. In the Settings i
window for Mesh under Mesh Settings, sclect >ettings o
User-controlled mesh as the Sequence type. ‘B:”d al
A Size and Free Tetrahedral node arc now
Label: Mesh2 =

available under Mesh 2.

¥ Sequence Type

| Physics-controlled mesh - |

G | User-controlled mesh |

Physics-controlled mesh
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5 In the Model Builder window, under Mesh 2, click Size

Model Builder ¥ & | Settings -
— = Et - o Size
4 % busbar_l.mph (root) " Build Selected [E Build All G
4 () Global Definitions
P; Parameters 1 Label: Size E
45 Default Model Inputs .
) Materials Element Size
4 W Component 1 (comp1) Calibrate for:
[ = Definitions -
I Geometry 1 General physics =
I 5z& Materials ) Predefined Normal
[ +\_ Electric Currents {ec) G @ Custom
[» IIE) Heat Transfer in Solids (ht)
I .y Multiphysics ¥ Element Size Parameters
4 A Meshes

b A Mesh 1 Maximum element size:
4 S Mesh2 G 2'mh m
Size Minimum element size:
Free Tetrahedral 1

2*(mh-mh/3) m

[~ Study 1
4 [ Results Maximurn element growth rate:

[ Datasets 15

! Derived Values Curvature factor:

I E Tables 0z

[ I'.’ Electric Potential (ec) :

I N Electric Field Norm (ec) Resolution of narrow regions:

I §i§ Ternperature (ht) 0.5

|

I'.’ |sothermal Contours (ht)
The asterisk in the upper-right corner of a node icon indicates that the node is
being edited.
6 In the Settings window for Size, under Element Size, click the Custom button.
7 Under Element Size Parameters, cnter:

- 2*mh in the Maximum element size ficld, where mh is 3 mm — the mesh control
parameter defined previously.

- 2*(mh-mh/3) in the Minimum element size ficld.
- 0.2 1in the Curvature factor ficld.
8 Click Build All = . Save the file as busbar_I.mph.

Compare Mesh | and Mesh 2 by clicking the Mesh nodes. The mesh is updated in
the Graphics window. An alternative to creating multiple meshes in this way is to
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run a parametric sweep of the parameter for the maximum mesh size, mh, that was
defined in the section “Global Definitions” on page 77.
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Adding Physics

The distinguishing characteristics of COMSOL Multiphysics, particularly
adaptability and compatibility, are prominently displayed when you add physics to
an existing model.

In this section, you will experience the ease with which this seemingly difficult task
is performed. By following these directions, you can add structural mechanics and
fluid flow to the busbar model.

STRUCTURAL MECHANICS
After completing the busbar Joule heating simulation, we know that there is a
temperature rise in the busbar. What kind of mechanical stress is induced by
thermal expansion? To answer this question, let us expand the model to include
the physics associated with structural mechanics.
To complete these steps, either the Structural Mechanics Module or the
MEMS Module (which enhances the core Solid Mechanics interface) is
required.
If you want to add cooling by fluid flow, or do not have the Structural
Mechanics Module or MEMS Module, read this section and then go to
“Cooling by Adding Fluid Flow” on page 146.
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I Open the model busbar.mph that was saved earlier on page 109. From the main
menu, select File > Save As and rename the model busbar_II.mph. Alternatively,
you could load the busbar.mph model from the Application Libraries as shown

carlier.

2 In the Model Builder window,
right-click the Component | node &
and select Add Physics «;

Sy

3 In the Add Physics window, under
Structural Mechanics, sclect Solid
Mechanics =.

To add this interface, you can
right-click and select Add to
Component | or click the + Add to
Component | button at the top of
the window. You can also

double-click.

4 Close the Add Physics window and
save the file.

©

busbar_ll.mph (root)
I () Global Definitions

I @ Component 1 {comp1)
[

[

"5 Study 1 1 Add Physics

& Results

2

1 Add Multiphysics
& Insert Physics
=

Insert Physics From

Add Physics

+ Addte Component 1 + Add to Selection

X

Search

b)) Acoustics

P =% Chemical Species Transport

b 1[ Electrochemistry

[» == Fluid Flow

[ Heat Transfer

b i Optics

I &) Plasma

I £ Radio Frequency

[ ‘1'&3 Semiconductor

4 E27 Structural Mechanics
=1 Solid Mechanics (solid)
[j Shell (sh 4 Add to Component 1

@ Layered ~+  Add to Selection
L] Membra___ .
&L Beam (beamn)

When adding additional physics, you need to make sure that materials
included in the Materials node have all of the required properties for the
selected physics. In this example, all properties are already available for

copper and titanium.

You can start by adding the effect of thermal expansion to the structural

analysis.
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5 In the Model Builder window,
right-click the Multiphysics node
and select Thermal Expansion = .

4 @ Solid Mechanics [solid)
#a Linear Elastic Material 1
T Freel
f= Initial Values 1

. . 4 'ﬁk Multiphysics

A Thermal Expansion node is added

to the model tree.

X Electrom x

I A Mesh 1 m

b ~de Study 1

b B Results

Electromagnetic Heating
Thermoelectric Effect

€ Equilibrium Discharge Heat Source

You can also use the ribbon and,
from the Physics tab, sclect

\'a Piezoresistive Effect, Domain Currents

Thermal Expansion

6=

Multiphysics Couplings > Thel’mal & Equilibrium Discharge Boundary Heat Source
Expansion. B rep

In the Settings window for Thermal _

Expansion, sclect All domains from the >ettings

Selection list. This will enable thermal

Thermal Expansion

expansion in the copper as well as in the Label:  Thermal Expansion 1 =
titanium bolts. Name: el
The Thermal Expansion Properties > Gomsh sdmEien
section of this window shows G selection: [ Alldormains =
information about the coefficient of )
thermal expansion and the strain ;_ pé -
reference temperature (there are also Active 3 R
some more advanced settings). The 4 &
Coefficient of thermal expansion takes its :
value from the Materials node. In the
Model Input section, the Volume [Eusiien
reference temperature (strain reference ~ Coupled Interfaces
temperature) has a default value of Heat transfer:
293.15 K (room temperature) taken Heat Transfer in Solids (ht) ] [
from Common model input, which in this Structure:
case corresponds to the Default Model Solid Mechanics (solid) =E
Inputs node that is available in Global

~ Model Input +

Definitions, and defines the temperature
for which there is no thermal expansion.
The Coupled Interfaces section shows
which two physics interfaces define the
physics for heat transfer and solid
mechanics. This is useful in the case
where there is more than one physics
interface for heat transfer or solid
mechanics in the model component.

Keep all default settings in this window.

Next, constrain the busbar at the
position of the titanium bolts.

Volume reference temperature:

T ref Common model input

¥ Thermal Expansion Properties

Input type:

Secant coefficient of thermal expansion

Coefficient of thermal expansion:

a From material

¥ Heat Sources

Thermoelastic damping
[] Mechanical losses
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7 In the model tree, right-click Solid Mechanics = and from the boundary level,
select Fixed Constraint = . A node with the same name is added to the tree.

8 Click the Fixed Constraint node . In the Graphics
window, rotate the busbar to view the back. Click the
circular surface of one of the bolts to add it to the -

Selection list.

D
"
b

D
")

n

9 Repeat this procedure for the remaining bolts to add
boundaries 8, 15, and 43.

¥ Boundary Selection

Selection: | Manual

a
on ]
)

Active 43

4 @ Solid Mechanics (solid)
Linear Elastic Material 1

Initial Values 1
Fixed Constraint 1

For easier management of multiple boundary selections, you can group
boundaries into a user-defined selection. Once you have selected
boundaries 8, 15, and 43, click the Create Selection button = and give it

a name, such as Bolt top surfaces.

This selection is then added as a node under Component | > Definitions and
is accessible from the Selection list in the Settings window for all types of
boundary conditions. You can use this technique to group domains,

boundaries, edges, and points. In the figure below, an additional selection
for the titanium bolt domains has been created.

Maodel Builder

+—

+ N

-

4 4 busbar_ll.mph (root)
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I () Global Definitions
4 [ Compenent1 (comp1)
4 = Definitions
4 i Selections
& Tibolts
i Bolttop surfaces
[Z‘] Boundary System 1 (sys7)
b (L] view 1
[ Geometry 1
b 255 Materials
b X Electric Currents (ec)
[ IIE) Heat Transfer in Solids (ht)
4 @ Solid Mechanics {solid)
& Linear Elastic Material 1
S Freel
&= Initial Values 1
w» Fixed Constraint 1

Label: Bolttop surfaces
* Input Entities
Geometric entity level:

=a| ®,

43

Boundary

[] All boundaries
[] Group by continuous tangent

w  Qutput Entities

Selected boundaries  ~

B0 (i
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Next, we update the Study node to take the added physics into account.

SOLVING FOR JOULE HEATING AND THERMAL EXPANSION

The Joule heating effect is independent of the stresses and strains in the busbar,
assuming temperature invariant materials and small deformations, and ignoring
the effects of electric contact pressure. This means that you can run the simulation
using the temperature as merely an input to the structural analysis. In other words,
the extended multiphysics problem is weakly coupled. As such, you can solve it in
two separate study steps to save computation time — one for Joule heating and a
second one for structural analysis. In a more advanced analysis, you can include all
of the aforementioned effects.

For this example, you can skip these steps and just click Compute.
However, the following technique can be useful for saving computational
time and memory resources, especially for larger simulations.

I In the Model Builder window, right-click 4~ Study1
Study | - and sclect Study Steps > Stationary > [ Step1: Stationary

Stationary = to add a second stationary study G [ Step 2: Stationary 2
Sth [*r. Solver Configurations

When adding study steps, you need to manually connect the respective
physics with the correct study step. We start by disabling the structural
analysis from the first step.

2 Under Study I, click the Step I: Stationary node 4~ Study1
=. G .~ Step 1: Stationary
— Step 2: Stationary 2
3 In the Settings window for Stationary, locate the s Solver Configurations

Physics and Variables Selection.

K
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4 In the Solid Mechanics (solid) row under Solve for, click to change the check mark
= to an ] to remove Solid Mechanics from Study Step 1.

In the Multiphysics couplings section, keep all of the default settings.

¥ Physics and Variables Selection ]

[] Modify model configuration for study step
L

Physics interface Solve for | Equation form
(®) |Electric Currents (ec) =4 Automatic (Stationary)
(®) |Heat Transfer in Solids (ht) =4 Automatic (Stationary)
Solid Mechanics (zolid) El Automatic (Stationary) G
" Multiphysics couplings Solve for | Equation form
(® |Electromagnetic Heating 1 (emh1) =4 Automatic (Stationary)
® |Thermal Expansion 1 (tel) =4 Automatic (Stationary)

Now, repeat these steps to remove Electric Currents (ec) and Heat Transfer in
Solids (ht) from the second study step.

5 Under Study 1, click Step 2: Stationary 2 . 4~ Study1
6 Under Physics and Variables Selection, in the c II::: 2::2 ; 2:::2:3 5

Electric Currents (ec) and Heat Transfer in Solids
(ht) rows, click to change the check mark [ to
an [J to remove Joule heating from Step 2: Stationary 2.

[*r. Solver Configurations

¥ Physics and Variables Selection ]

[] Modify model configuration for study step
L

Physics interface Solve for | Equation form
Electric Currents (ec) O Automatic (Stationary)
Heat Transfer in Solids (ht) El Automatic (Stationary) G
® | Solid Mechanics (solid) =4 Automatic (Stationary)
L] . . = .
Multiphysics couplings Solve for | Equation form
(® |Electromagnetic Heating 1 (emh1) =4 Automatic (Stationary)
® |Thermal Expansion 1 (tel) =4 Automatic (Stationary)

7 Right-click the Study I node ~» and select Compute = (or press F8 or click
Compute on the ribbon) to solve.

e 4 ~dn Study 1

[~ Step 1: Stationary | = Compute F&
[= step 2: Stationary |

b [fpe Solver Configurati B
123

b IE Results

Update Solution F5

Parametric Sweep

Save the file as busbar_II.mph, which now includes the Solid Mechanics interface
and the additional study step.
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RESULTING DEFORMATION

Now that a physics interface has been added, additional plots for Solid Mechanics
need to be added manually. First, a displacement plot.

I In the Model Builder window, right-click Results & and add a 3D Plot Group W .
In the Label field enter Displacement to give the plot group a descriptive name.
Right-click Displacement @ and add a Surface | node ™. Click the Surface |

node m.

4 [ Results
I # Datasets
2% Derived Values
EH Tables
Nl Electric Potential (ec)
Wi Electric Field Norm (ec)
I'.’ Temperature (ht)
N Isothermal Contours (ht)
W& Current Density
i Displacement
™ Surface 1
& Export
[# Reports

[

2 In the Settings window for Surface in
the Expression section, click the Replace
Expression button % .

From the context menu, select Model >
Component | > Solid Mechanics >
Displacement > solid.disp - Displacement
magnitude - m.

You can also enter solid.disp in the
Expression ficld.

Now, change to a more suitable unit.
In the Settings window under
Expression, from the Unit list, select mm
(or type mm in the field).

The local displacement due to thermal

 Expression

Expression:

solid.disp

©

Unit:
mm v
[] Description:

Displacement magnitude

4 Model
I Global definitions
I Materials
4 Component 1 (compl)
I Definitions
I Frames
> Geometry
I Mesh
b Electric Currents
b Heat Transfer in Solids
4 Solid Mechanics
I Acceleration and velocity
I Activation
4 Displacement
G solid.disp - Displacement magnitude - m
[ Curl of displacement {material and geometry frames)
[ Displacement field - m

expansion is displayed as a surface plot. Next, we will add information about the

busbar deformation.

3 In the Model Builder window, under Results > Displacement, right-click the
Surface | node ™ and add a Deformation node =s. The plot automatically
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updates in the Graphics window. Click the Go to Default View button ... so your
view appears similar to the plot shown below.

The deformations shown in the figure are highly amplified to make the
very small distortions that actually take place more visible.

Surface: Displacement magnitude (mm)

T 0.05 ¢

4 Save the busbar_II.mph file, which now includes a Surface plot with a
Deformation.

You can also plot the von Mises and principal stresses to assess the
structural integrity of the busbar and the bolts.

OVERRIDE AND CONTRIBUTION: EXCLUSIVE AND CONTRIBUTING NODES

The model tree nodes for a physics interface are traversed in a downward sequence
starting from the top. Depending on the selection, a node can totally or partially
override, or shadow, a node that comes earlier in the sequence. There are two
types of physics interface nodes: exclusive and contributing. How the nodes are
treated depends on the type.

A constraint boundary condition is a typical example of an exclusive node.
Examples of constraint boundary conditions include Electric Potential or Fixed
Constraint. In the case of Electric Currents, for example, if there are two or more
Electric Potential nodes for the same boundary, then the last Electric Potential node
in the sequence will override the settings of the other nodes. The Ground node is
also an exclusive node and will similarly override the boundary conditions specified
by any previous node.
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The figure below shows the Override and Contribution section in the Settings
window for Electric Potential. The Overrides list indicates that this boundary
condition takes precedence over the default Electric Insulation boundary condition.

Model Bu - & | Settings v
& b ELRE Electric Potential
4 & busbar_ll.mph {root)

4 (@) Global Definitions Label:  Electric Potential 1 =

&
Pi Parameters 1
4 Default Model Inputs
= Materials

4 [@ Component 1 {comp )

= Definitions ‘ 43 ]
Geometry 1
25 Materials

*
:\_ Electric Currents (ec)

#i= Current Conservation 1

¥ Boundary Selection

Selection: Manual b

[N

%= Electric Insulation 1
= Initial Values 1

— | [sarzbainic | + override and Contribution
m Ground 1
1Y Heat Transfer in Solids (ht) Overridden by:

:
: lé.‘-l Solid Mechanics (solid)
: .{ﬁ, Multiphysics

b A Mesh 1
b odo Study 1 Overrides:
b (B Results Electric Insulation 1

A flux boundary condition, such as one specifying a heat flux, is a typical example
of a contributing node. You can stack several heat flux boundary conditions and
they will all contribute to the total heat flux. The figure below shows an example
where a Heat Flux 2 boundary condition overrides the default Thermal Insulation
boundary condition and contributes to the heat flux together with Heat Flux 1.

b Wy Selections ¥ Override and Contribution
(%] Boundary System 1 (sys1)

Overridden by:

b iz Materials

b ¥ Electric Currents (2c)

4 1Y Heat Transfer in Solids (ht)
= Solid 1

= Initial Values 1

Overrides:

2% Thermal Insulation 1 Thermal Insulation 1
Sw HeatFlux 1
mw Heat Flux 2

I =5 Solid Mechanics (solid) Contributes with:

b iy Multiphysics Heat Flux 1
P A Meshi
I~ Study 1

b @ Results

In the model tree, the override and contribution relationships are indicated by a
red arrow and an orange circle, respectively.
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COOLING BY ADDING FLUID FLOW

After analyzing the heat generated in the busbar and possibly the induced thermal
expansion, you might want to investigate ways of cooling the busbar by letting air
flow over its surfaces. These steps do not require any additional modules, as the
model only includes Joule heating without the previous thermal expansion
analysis.

If you use either the Nonisothermal Flow or Conjugate Heat Transfer
multiphysics interface, the coupling between heat transfer in solids and fluids
is automatic, whereas in this example, this is done manually and with limited
functionality. This is to illustrate adding a multiphysics coupling to an already
existing analysis.
Adding fluid flow to the Joule heating model creates a new multiphysics coupling.
To simulate the flow domain, you need to create an air box around the busbar for
the external flow. You can do this manually by altering the geometry from your
first model or by opening an Application Library file. To save time, open a file with
the box already created.

After loading the geometry, as described later, you will learn how to simulate air
flow according to this figure:

Air outlet

Air inlet

DEFINING INLET VELOCITY

Start by loading the geometry and adding a new parameter for the inlet flow
velocity.
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I If you have just reopened the software, close the New window that opens
automatically by clicking the Cancel button .

2 Click the Home tab, and, from the Windows menu, select Application Libraries [ .
Navigate to COMSOL Multiphysics > Multiphysics > busbar box. (You can also
open the Application Libraries directly from the File menu.)

Double-click to open the file,
which contains the geometry Application Libraries
in addition to the physics
modeling steps completed
through the Cnd. of the 4 [ COMSOL Multiphysics

b

[

b

b

b

[

[

b

[

b

b

(* Refresh Update COMSOL Application Libraries ) Application Gallery

Search

section “Customizing Ml Applications
. [flfi Acoustics
Materials” on page 133.

[flfi Chemical Engineering

[ilfi Cluster and Batch Tuterials
[ilfi Diffusion

[lfl Electremagnetics

[illi Equation Based

[ilif Fluid Dynamics

[l Geophysics
[flfi Heat Transfer
[ilfi Meshing Tuterials

[lfi Multiphysics
G : busbar_assembly
O bushar_box

O busbar_geom
@ bushar

Run Application Open

EI Open PDF Document

Help e Close

3 Under Global Definitions, click the Parameters node = .

4 In the Settings window for Parameters, click the empty row just below the Vtot
row. In the Name column, enter Vin. Enter 0.1[m/s] in the Expression column
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and a description of your choice in the Description column, such as Inlet
velocity.

Model Builder ML

= F =tv 2l

4

4 & busbar_box.mph (root)
4 () Global Definitions Label:  Parameters 1 =
G Py Parameters 1

4 Default Model Inputs - [ETEGEEs

iz Materials W
4 [ Component 1 (comp1) Marme Expression Value Description
b & Definitions L 9[em] 0.08m Length
4 [A] Geometry 1 rad_1 6[mm] 0.006 m Bolt radius
b {2 Work Plane 1 (wp1) thb S[mm] 0.005 m Thickness
[5) Extrude 1 fext?) whb 5[em] 0.05m Width
b & Work Plane 2 fup2) mh 3[mm] 0.003 m Maximum element size
l_;é Extrude 2 fext2) hte S[W/m*2/K] 5 W/ (m*K) Heat transfer coefficient
[3 El Work Plane 3 fwp3) Vot 20[mV] 0.02V Applied voltage
[5) Extrude3 (ext3) G Vin 0.1[mys] 0.1 m/s Inlet velocity

[T Block 1 (bik7)

5 Seclect File > Save As and save the model with a new name, busbar_box_I.mph.

ADDING AIR
The next step is to add the material properties of air.

I From the Home tab, sclect Add Material = (or right-click the Materials node and
select Add Material from Library).

2 In the Add Material window, expand

the Built-In node. Right-click Air and Add Materia L33
select Add to Component 1. Close the () Add to Global Materials + Add to Component ~
Add Material window. Search

I 425 Recent Materials
I [ Material Library
4 [3 Built-In
oa Air
) Add to Global Materials

F @ Addto Component 1 (comp1)
Aluminum 6063-T23

3 In the Model Builder window, under Materials, click the Air node .

4 g2 Materials
[ Eg8 Copper (mati)
[ 225 Titanium beta-215 (mat2)

G b i Air (mat3)

4 On the Graphics window toolbar, click Zoom Extents .
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5 In the Graphics window, click the air box (domain 1) to add it to the Selection
list, which changes the color to blue. This step assigns the air material properties
to the air box.

Settings -
hateria

Label:  Air =

Geometric Entity Selection

Geometric entity level: Domain =

Selection: Manual =

| 1 ] -
E

m &

ADDING FLUID FLOW
Now, add the physics of fluid flow.

I In the model tree, right-click Component | @ and select Add Physics ;.
2 In the Add Physics window under Fluid
Flow > Single-Phase Flow, right-click
Laminar Flow = and sclect + Add to
Component. Laminar Flow will appear

under Component | in the model tree.
Close the Add Physics window.

Add Physics

+ Addte Component 1 + Add to Selection

(O Recently Used

¥ AC/DC

1)) Acoustics

<»* Chemical Species Transport

el Electrachemistry

Fluid Flow

= Single-Phase Flow

= Creeping Flow (spf)

Laminar Flow (spf)

Tl 4+  Addto Component 1

Li
D ~+  Add to Selection

3 In the Graphics toolbar, click the
Transparency button =. In addition,
click the Wireframe Rendering button
@ . These two settings make it easier to G
see inside the box. Toggle these on
and off as needed during the modeling
process to control the type of &
rendering used. g Pipe Flow (pf)

[

Rotating Machinery, Fluid Flow

Now that you have added fluid flow to

the model, you need to remove the air domain (domain 1) from the Electric
Currents (ec) interface (assuming that the air has no electric conductivity and
hence no currents) and then couple the heat transfer part of the Joule Heating
multiphysics interface to the fluid flow.
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4 In the model tree, select the
Electric Currents (ec) node
x . In the Graphics window,
move the mouse pointer
over the air domain and
click to remove it from the
selection list. At this point,
only the busbar should be
selected and highlighted in
blue.

5 In the Model Builder window, right-click Heat Transfer in Solids = . In the first
section of the context menu, the domain level &, select Fluid.
I e Materials

[ +\_ Electric Currents {ec)
4 [F) Heat Transfer in Solids (ht)

= Solid 1 1= Solid
= Initial Values 1 . e
5% Thermal Insulation 1 LB
(9 Heat Flux 1 = Heat Source

4 == Laminar Flow (spf] I= Initial Values
= Fluid Properties 1 Specific Media
= Initial Values 1
S Wall1 = Ternperature

4 -& Multiphysics (= Thermal Insulation
* Electromagnetic Heatin & Heat Flux

b A Mesh 1

6 In the Graphics window, click the
air domain (domain 1) to add it to
the Selection list.

Now, couple the fluid flow and
heat transfer phenomena.
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7 In the Settings window for Fluid, under
Heat Transfer in Solids, in the section
Model Input, sclect Absolute pressure
(spf) from the Absolute pressure list. In
the section Heat Convection, select
Velocity field (spf) from the Velocity field
list.

Temperature:

Pa

+ Model Input

Absolute pressure (spf)

Temperature (ht)

Absolute pressure:

Coordinate System Selection

This identifies the pressure and flow
field from the Laminar Flow interface

. Velocity field:
and couples it to heat transfer.

Now, define the boundary conditions
by specifying the inlet and outlet for the
heat transfer in the fluid domain.

In the Model Builder window, right-click Heat
Transfer in Solids /= . In the second section of
the context menu, the boundary section =,
select Temperature.

[

.

4 @

A Temperature node is added to the model
tree.

In the Graphics window, click the
inlet boundary, boundary number
2, to add it to the Selection list.

This sets the inlet temperature to
293.15 K, the default setting.

The graphics should look like the
image to the right. (It may look
slightly different depending on
whether you have Transparency and
Wireframe Rendering on or off.)
Continue by defining the outlet.

o

G u | Velocity field (spf)

¥ Heat Convection

Electric Currents {eg)

Heat Transfer in Solids [ht)
s Solid 1

Initial Values 1
Thermal Insulation 1
Heat Flux 1

Fluid 1

Temperature 1

D

L]

p:]
-

-
=

o
Larninar Flow (spf)
im Fluid Properties 1
i Initial Values 1
3= Wall1
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10In the Model Builder window, right-click Heat Transfer in Solids =. At the
boundary level, select Flow Conditions > Outflow. An Outflow node = is added

to the model tree.

4 [F) Heat Transfer in Solids (ht)

= Solid 1

= Initial Values 1
%= Thermal Insulation 1

= Heat Flux 1

= Fluid 1

w Temperature 1
Laminar Flow (spf)

= Fluid Properties 1
= Initial Values 1
= Wall1
3 .&. Multiphysics
b Mesh 1
[~ Study 1
b IE Results

Solid
Fluid
Heat Source
Initial Values

Specific Media

Temperature

Thermal Insulation

Heat Flux

Symmetry

Periodic Condition

Lumped System Connector
Phase Change Interface

Phase Change Interface, Exterior
Flow Conditions

Heat Sources

Thin Structures

Il In the Graphics window, click the
outlet boundary, boundary
number 5, to add it to the

Selection list. Use the mouse scroll

wheel to scroll in and highlight
the boundary before selecting it,
or use the up and down arrow
keyboard buttons.

152 |

Inflow

Outflow @

Open Boundary




The settings for the busbar, the bolts, and the Electric Potential | and

Ground | boundaries have retained the correct selection, even though you
added the box geometry for the air domain. To confirm this, in the model
tree under Electric Currents, click the Electric Potential |1 and the Ground |

nodes to verify that they have the correct boundary selection.

Settings

Electric Potential

Label: Electric Potential 1
¥ Boundary Selection
Selection: Manual

Active

Cverride and Contribution
Equation
¥ Electric Potential

Electric potential:
Vg Viot

Label: Ground1
¥ Boundary Selection
Selection: | Manual

13
on ]
- 20

Active

Cverride and Contribution

Equation

Next, continue with the flow settings. You need to indicate that fluid flow only
takes place in the fluid domain and then set the inlet, outlet, and symmetry
conditions. Do this by first removing all domains from the selection and then

adding the air domain.

I In the model tree, click the Laminar Flow node
Laminar Flow, click the Clear Selection button |

Settings

Laminar Flow

Label:  Laminar Flow
Mame:  spf

¥ Domain Selection
Selection: | All domains

Active

oo s W o —

.

. In the Settings window for
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2 In the Graphics window, click the air box (domain 1) to add it to the Selection.

It is good practice to verify that the Air 4 3E2 Materials

material under the Materials node has all of b i Copper (matl)

the properties that this multiphysics b if Titanium beta-215 (mat2)
. . . [ gra Air (mat3)

combination requires. In the model tree i

under Materials, click Air. In the Settings

window for Material under Material Contents, verify that there are no

missing properties, which are marked with a warning sign 4. The section

“Materials” on page 84 has more information.

Now, we continue with the boundaries.
3 Inthe Model Builder window, right-click Laminar Flow = L
4 == Laminar Flow {spf]
and at the boundary level, select Inlet. An Inlet node = = Fluid Properties 1
is added to the model tree. G Initial Values 1
S Wall 1
e wp Inlet 1
4 In the Graphics window, click the

inlet (boundary 2) to add it to the
Selection list.

5 In the Settings window for Inlet
under Velocity in the U, field, : _ _
enter Vin to set the Normal inflow ) e

() Velocity field

velocity. G Uy 'Vin .

* Velocity
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6 Right-click Laminar Flow =. and at
the boundary level, select Outlet w .
In the Graphics window, click the
outlet (boundary 5) to add it to the
Selection list. Use the mouse scroll
wheel or keyboard arrows to scroll
in and highlight the boundary
before selecting it.

The last step is to add symmetry
boundaries. For simplicity, assume
that the flow just outside of the
faces of the channel is similar to the
flow just inside of these faces. This
assumption can be correctly
expressed by the symmetry
condition.

7 Right-click Laminar Flow =. and select Symmetry. A Symmetry node = is added

to the sequence.

8 In the Graphics window, click each of the blue faces in the figure below
(boundaries 1, 3, 4, and 48) to add all of them to the Selection list. You may need
to use the mouse scroll wheel or rotate the geometry to select all of them.

Save the busbar_box_I.mph file, which

now includes the Air material and
Laminar Flow interface settings.

When you know the boundary

numbers, you can click the
Paste Selection button [ and
enter the information. In this

example, enter 1,3,4,48 in the

Paste Selection window. Click

ij Paste Selection

Selection:  1,3,448

OK

| Cancel

OK and the boundaries are automatically added to the Selection list.
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COARSENING THE MESH

To get a quick solution, we will change the mesh slightly and make it coarser. The
current mesh settings would take a relatively long time to solve, and you can
always refine it later.

I In the Model Builder window, expand the Mesh | .
4 S Mesh 1

""" ",:E Size
Free Tetrahedral 1
2 In the Settings window for Size
under Element Size, click the
Predefined button and ensure that
Normal is sclected.

ettings

W LA

Build Selected [§ Build All

Label: Size E
Element Size
Calibrate for:
General physics -

G ® Ppredefined Normal ~

O Custom

3 Click the Build All button & . The
geometry displays with a mesh in
the Graphics window (you may
need to turn Transparency off to see
the picture below).

You can assume that the flow velocity
is large enough to neglect the 6
influence of the temperature increase

in the flow field.

It follows that you can solve for the
flow field first and then solve for the
temperature using the results from
the flow field as input. This is
implemented with a study sequence.

SOLVING FOR FLUID FLOW AND JOULE HEATING

When the flow field is solved before the temperature field, it yields a weakly
coupled multiphysics problem. The study sequence described in this section
automatically solves such a weak, or one-directional, coupling.
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I In the model tree, right-click Study | ~» and select Study Steps > Stationary >
Stationary = to add a second stationary study step to the Model Builder window.

4 ~cb Study 1
[= step
b JEl Results

= Compute

Parametric Sweep

764 Function Sweep

S Material Sweep
Study Reference
Combine Selutions
Optimization
Uncertainty Quantification
Study Steps

[f Show Default Solver
IE Show Default Plots
IS Reset Default Plots
Y, Getlnitial Value

Statistics

F&

Staticnary v | [= Stationary G
Time Dependent v | 14 Stationary Plug Flow

Eigenfrequency v | 2 Bidirectionally Coupled Particle Tracing
Frequency Domain v | 25 Bidirectionally Coupled Ray Tracing

Other v | |7y Time Periodic

" Stationary Source Sweep

Next, the correct physics needs to be connected with the correct study step.
Start by disabling the Electric Currents (ec) and Heat Transfer in Solids (ht)
interfaces associated with Joule heating from the first step.

2 Under Study I, click Step I: Stationary ~.

[ 2)

4 ~db Studyl
]/__—. Step 1: Stationary
]f' Step 2: Stationary 2

¥ Physics and Variables Selection ]

[] Modify model configuration for study step

L

@®
"

@®

Physics interface Solve for | Equation form

Electric Currents (ec) O Automatic (Stationary)
Heat Transfer in Solids (ht) El Automatic (Stationary)
Laminar Flow (spf) =4 Automatic (Stationary)

©

Multiphysics couplings Solve for | Equation form

Electromagnetic Heating... =4 Automatic (Stationary)

3 In the Settings window for Stationary, locate the Physics and Variables Selection
section. In both the Electric Currents (ec) and the Heat Transfer in Solids (ht)
rows, click to change the check mark & to an [ in the Solve for column,
removing the Joule heating effect from Step 1.
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4 Repeat the step. Under Study I, click Step 2: Stationary 2 = . Under Physics and
Variables Selection, in the Laminar Flow (spf) row, click in the Solve for column to

change the check mark = to an 7.

¥ Physics and Variables Selection ]
[] Modify model configuration for study step
L

Physics interface Solve for | Equation form

(®) |Electric Currents (ec) =4 Automatic (Stationary)

(®) |Heat Transfer in Solids (ht) =4 Automatic (Stationary)
Laminar Flow (spf) El Automatic (Stationary) 4
Multiphysics couplings Solve for | Equation form

(® |Electromagnetic Heating...| [~ |Automatic (Stationary)

5 Right-click the Study | node ~» and select Compute = (or press F8 or click
Compute on the ribbon). This will now automatically create a new solver
sequence that solves for laminar flow and then Joule heating.

4 ~dn Study 1
[= Step1:| = Compute F8 e
— Step 2
= step 1 Parametric Sweep

b IE Results

f Function Sweep

6 After the solution is complete, select the Temperature (ht) plot under the Results
node in the Model Builder window. If you do not already have transparency on,
click the Transparency button & on the Graphics toolbar to visualize the
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temperature field inside the box. To zoom, middle-click and hold down the
mouse button (or scroll wheel) while dragging the mouse.

Surface: Temperature (K)

Y_\T"x

The Temperature Surface plot that displays in the Graphics window shows the
temperature in the busbar and in the surrounding box. You can also see that the
temperature field is not smooth due to the relatively coarse mesh. A good
strategy to get a smoother solution would be to refine the mesh to estimate the
accuracy.

7 At this point, save the busbar_box_I.mph file so you can return to it at any time.
The next steps use the original busbar.mph file.

Parametric Sweeps

SWEEPING A GEOMETRIC PARAMETER

It is often useful to generate multiple instances of a design with the objective of
meeting specific constraints. In the previous busbar example, a design goal might
be to lower the operating temperature or decrease the current density. We will
demonstrate the former. Since the current density depends on the geometry of the
busbar, varying the width, wob, should change the current density and, in turn,
have some impact on the operating temperature. Let us run a parametric sweep on
wbb to study this change.
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ADDING A PARAMETRIC SWEEP

I From the File menu, open the
model file busbar.mph. If you
did not save the model, you can

(1) Global Definitions

et

4 & busbar.mph (root)
[ )
I @ Component1 {comp1)
[

. L Study 1
also open it from the Application | E Rt;ull'rts = Computz e
Libraries: File > Application G Update Solution s
Libraries > COMSOL Multiphysics > G SRR

Multiphysics > busbar.

f Function Sweep
In the Model Builder window,

right-click Study | ~» and select Parametric Sweep
is added to the Model Builder sequence.

. A Parametric Sweep node

2 In the Settings window for Parametric Sweep, under the empty parameter table,
click the Add button +. From the Parameter names list in the table, select wbb.

Model Builder - -
- w St Elw = v -
4 4% busbar.mph {root) Compute (¥ Update Solution
[ f‘\ Global Definitions
I [l Component 1 (comp 1) Label: Parametric Sweep =]
4 do Study 1
G Parametric Sweep ¥ Study Settings
- Stepl: Staananf Sweep type: Specified combinations -
: |'|'|-F Solver Configurations
L3
b @ Results Parameter name  Parameter value list Parameter unit
whb (Width] m
L {Length)

rad_1 (Bolt radius)

tbb (Thickness) el
G whb (Width)
mh (Maximum element size)

htc (Heat transfer coefficient)
. Vtot (Applied voltage)
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The Sweep type is used to control parametric sweeps with multiple
parameters. You can choose between sweeping for All combinations of
the given parameters, a subset of Specified combinations, or Parameter
switch. The option Parameter switch makes it possible to sweep over
Cases for Parameters, as defined in Global Definitions (shown below).

o
oullaer T

=t .

Mode

- L E

4 & busbar.mph (rooct)
4 (i} Global Definitions
4 Py Parameters 1
P; Casel
Pi Case2
P Case3
4 Default Model Inputs
=) Materials
I @ Compenent1 {comp1)
4~ Study 1
Parametric Sweep

Step 1: Stationary

b Fl'n- Solver Configurations

b Results

Compute * Update Solution

Label: Parametric Sweep

~ Study Settings
Parameter switch

Sweep type:

"
Switch Cases

Parameters - All

Settings
Case

o]

Lahel: Casel

~ Parameters

L
Mame

Expression
L 9lem]
rad_1 &[mm]
tbb 5[rmm]
whbb 5[em]
mh 3[mm]
htc S[Wim*2/K]
Vtot 20[mV]

-1

=

Case numbers

¥ range(1,1,3)

Description

Length

Bolt radius

Thickness

Width

Maximum element size
Heat transfer coefficient
Applied voltage

Note that you can replace the set of main Parameters used in the model
with that of a Case by selecting from the menu in the upper-left corner

of the Parameters window.

Model Builder

— > Ef v

4 <& busbarmph (root)
4 ([T Globsl Definitions
4 [P Parameters 1
P Casel
Fi Case2
Py Case3
% Default Model Inputs
& Materials
il Component 1 {comp1)
4 = Definitions
av Average 1 (aveopl)

[

[=] Boundary System 1 (sys1)
; View 1
b Geometry 1

[ 528 Materials

Settings
K

Ky Casel

) Casel2

) Casel

L]

Mame Expression

L [em]
rad_1 &[mm]
thb 5[mm]
whbb 5[cm]

mh 3[mm]

htc S[W/m*2/K]
Vtot 20[mV]

Value Description

0.09 m Length

0.006 m Bolt radius

0.005 m Thickness

0.05m Width

0.003 m Maximum element size
5 W/ (m*K) Heat transfer coefficient
0.02V Applied voltage
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3 Enter a range of parameter values to sweep the width of the busbar from 5 cm
to 10 cm in 1 cm increments. There are different ways to enter this information:

- Copy and paste or enter range (0.05,0.01,0.1) into the Parameter value list
field.

- Click the Parameter value list ficld and then
click the Range |..| button and enter the = Renge %
values in the Range dialog box. In the Start Entry method:
field, enter 0.05. In the Step ficld, enter Step =
0.01, and in the Stop field, enter 0.1. Click S[:;:
Replace. '
Step:
- In any of the methods, you can also use 0.01
length units to override the default SI unit Stop:
system using meters. Instead of 0.05, you 01
can enter 5[cm]; similarly, 1[cm] instead of Function to apply to all values:
0.01 and 10[cm] instead of 0.1. You can None S
also change the default unit system from the 6 e Add Cancel

Settings window of the root node in the
model tree.

¥ Study Settings

Sweep type: Specified combinations =
" Parameter name Parameter value list Parameter unit
whb (Width) - |range(0.05,0.01,0.1] m
+ =) beed

Next, define an Average nonlocal coupling that can be used later to calculate the
average temperature in the busbar.
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4 Under Component |, right-click Definitions = and select Nonlocal Couplings >
Average - .

4 & busbar.mph (root)

I () Global Definitions

4 |§ Component1 (comp1)
Definitions
Geometry 1| 3= Variables
I 5z& Materials

I 3% Electric Curr Runclions '
[» IIE) Heat Transfe Selections 3
I %y Multiphysics Probes N
[ A Mesh 1
4~ Study 1 Physics Utilities r
L2 Parametric § Meonlocal Couplings » | fiv Integration
Step 1: Stat Pairs v [ Average 4
b [fpe Solver Confi ) :
[ ,@ Results Coordinate Systems b | mMax Maximum

5 In the Settings window for Average, sclect All domains from the Selection list.

Model Builder v

— = =t -

4

4 & busbar.mph (root)
b @ Global Definitions fabst Average 1 S|

4 @ Component 1 {comp1) Operator name: | aveopl
4 = Definitions
G av Myverage 1 (aveop 1) Source Selection
[)_,] Boundary Systern 1 (sys1)
[ View 1 Geometric entity level: Domain -

Geometry 1 Selection: e All domains hd
= Materials

. Electric Currents {ec) ‘
Heat Transfer in Solids (ht)

Multiphysics

» Mesh 1

Study 1

Parametric Sweep

+

éVVVVVV
Pis @
E=lim
|

Fi

oo g W o —
]

This creates an operator called aveop1. This operator is now available to
calculate the average of any quantity defined on the selected domains. Later, we
use this tool to calculate the average temperature, but it can also be used to
calculate average electric potential, current density, and so forth.

6 Sclect File > Save As to save the model with the new name, busbar_III.mph.

7 To run the sweep, right-click Study 1 -« and select Compute = or click Compute
in the Home tab.

| 163



PARAMETRIC SWEEP RESULTS

Click the Temperature (ht) |1 node (the second
temperature plot node) located under Results in the
model tree.

The plot that displays in the Graphics window shows
the temperature in the wider busbar using the last
parameter value, wbb=0.1[m] (10[cm]). Select Zoom
Extents [3 from the Graphics window toolbar so that
you can see the entire plot. The resulting plot is rather
uniform in color, so we need to change the maximum
color range.

wbb(6)=0.1 m

Surface: Temperature (K}

vvvvvvvvvvvv@

Datasets

Derived Values

EH Tables

I“ Electric Potential (ec)
I“ Electric Field Morm {ec)
I“ Temperature (ht)

I“ |sothermal Contours (ht)
W& Current Density

I‘i Electric Potential (ec) 1
I“ Electric Field Morm {ec) 1
i@ Temperature (ht) 1

I“ |sothermal Contours (ht) 1
Export

[# Reports

mm

o

314

I Under the Temperature (ht) 1 node, click the Surface node ™.

I §i Electric Potential (c) 1
[ I‘i Electric Field Norm (ec) 1
4 §@ Temperature (ht) 1
h 9
1] Surface
b §i§ Isothermal Contours (ht) 1
W& Export
[# Reports
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2 In the Settings window for Surface, ~ Range
click Range to expand the section. G Manual color range
Select the Manual color range check Minimurm: | 309.03671
box. Enter 309.5 in the Maximum ficld Loooooooooaooooac
(replace the default). G N '30"}.5{' 2 0 0 0 0000
3 The Temperature (ht) | plotis
updated in the Graphics window for RN RN NN,
wbb=0.1[m] (10[cm]).

wbb(6)=0.1 m Surface: Temperature (K} a

309.27 9

The plot may look a bit different depending on which version you are running.
Compare the wider busbar plot to the temperature for wbb=0.05[m] (5[cm]).
For this purpose, you can reuse one of the previously defined plot groups.

I In the Model Builder window, click the first Temperature (ht) node @.

4 [ Results

I # Datasets

b 2% Derived Values

I E Tables

[ i“ Electric Potential (ec)

[ i“ Electric Field Morm {ec)
0 I N Ternperature (ht)

[ i“ |sothermal Contours (ht)

I §i§ Current Density

[ i'i Electric Potential (ec) 1

[ i“ Electric Field Morm {ec) 1

4 @ Temperature (ht) 1

™) Surface
[ i“ |sothermal Contours (ht) 1
Export
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2 In the Settings window for
3D Plot Group, sclect
Study I/Parametric Solutions
I from the Dataset list. This
dataset contains the results
from the parametric sweep.

3 In the Parameter value list,
select 0.05 (which
represents wbb=5 cm). Click
the Plot button @ . Click the

Settings .
3D Plot Group

Plot - =3

Label: Temperature (ht) =
~ Data

Dataset: G Study 1/Parametric Solutions 1 B

Parameter value (whb (m)): | 0.05

Zoom Extents button [F on the Graphics window toolbar.
The Temperature (ht) plot is updated for wob=0.05[m] (5[cm]). Note that if you
have updated the color range for this plot already, your plot should look similar to
the one below. If not, follow the subsequent steps.

wbb(1)=0.05 m

Surface: Temperature (K) Max/Min Volume: Temperature (K}

m

AR 323.25

0.1

: 330.400

0.05
m

m 322.39

(The plot may include the maximum and minimum points, depending on which

version of the model you started from.) Like the wider busbar, the plot may be

quite uniform in color, so change the maximum color range.

I Under the first Temperature (ht) node, click the Surface node ™.

2 In the Settings window for Surface, click Range to expand the section (if'it is not
already expanded). Select the Manual color range check box.
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3 Enter 323.25 in the Maximum field (replace the default).

The Temperature (ht) plot is updated in the Graphics window for wbob=0.05[m]
(5[cm]).

Click the first and second Temperature plot nodes to compare the plots in the
Graphics window. The maximum temperature decreases as the width of the
busbar increases from 5 cm to 10 cm.

ADDING MORE PLOTS

To further analyze these results, you can plot the average temperature for each
width.

I Right-click Results & and add a ID Plot Group -~ .

4 @I Results
3 Dataset| §ij 3D Plot Group

= -
Z Derived
B Tables . 2D Plot Group

W& Electric] 7~ 1D Plot Group G
Wi Electric| @) polar Plot Group
VB Temper
i Isother
& Current {E Evaluation Group
i Electric
i Electric

22 Smith Plot Group

Fi  Parameters

VB Temper Plot All
i Isother =

v T VT TV W W W W W

Show More Options...

Mode Group

Copy as Code to Clipboard 3

Help F1

2 In the Settings window for thelD Plot Group, sclect Study |/Parametric
Solutions | from the Dataset list.

Settings M
1D Plot Group
Plot
Label: 1D Plot Group 10 =
¥ Data

G Dataset: Study 1/Parametric Solutions 1 (s0l2) » =4
Parameter selection (whbb): All -

| 167



3 In the Model Builder window, right-click 1D Plot Group and add a Global & node.

Model Builder ~ * | Settings v
- =E-E- S~ Global
4 % busbar_lll.mph (root) Plot
I () Global Definitions
I @ Component1 {comp1) Label: Global 1 =
[~ Study 1
4 [E Results v Data
3 Datasets
b 295 Derived Values Dataset: From parent g
I E Tables .
[ I'.’ Electric Potential (ec) 7 JFEEB REE LI T
[ I'.’ Electric Field Morm {ec) "
b il Temperature (ht) Expression Unit Description
[ I'.’ Isothermal Contours (ht) aveopl(T) K Average 1 G
I §i§ Current Density
[ I'.’ Electric Potential (ec) 1
[ I'.’ Electric Field Morm {ec) 1
I @ Temperature (ht) 1
[ I'.’ |sothermal Contours (ht) 1
4 7. 1D Plot Group 10

b <

4 In the Settings window for Global under y-Axis Data, click the first row in the
Expressions column and enter aveop1(T). This is the operator that we defined
on page 163 for later use. You use a similar syntax to calculate the average of
other quantities.

You can also use auto-completion by using Ctrl+Space after clicking the
first row or after typing a few characters.

¥ y-Axis Data

" .
Expression

|ave
4 Compeonent 1 (compl)
4 Definitions
4 MNonlocal couplings
aveopl(expr) - Average 1

To use a nonlocal coupling operator without solving, you can select the
option Update Solution that is available by right-clicking a Study node.

~ct Study 1

B Results | = Compute F8
=+ Continue
' Update Solution F5
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5 Click the Plot button = and save the busbar_III.mph model with these
additional plots that use the parametric sweep results.

Global: Average 1 (K) e

:
\
AN 1

321+ LS 4

Average 1 (K)

L L L L L L L L L L
0.055 0.06 0.085 0.07 0.075 0.08 0.085 0.09 0.095
wbb (Width)

0.1

In the plot, the average temperature decreases as the width increases.

PARAMETERS IN RESULTS

For greater flexibility, it is possible to define parameters that are only used in the
Results node. Using these parameters does not require resolving the model. The
following example shows how you can animate over a Parameter defined under
Results.

I Right-click the Results node and select Parameters.

4 @ Rsu-lty
b E pat| W 3D Plot Group
b &% Der B 20D Plot Group
b E Tab
- T 1D Plet G
b Ele ot Group
I N Ele 2 Polar Plot Group
b W@ Ten @ Smith Plot Group
b N lsot
b i Cur [E Evaluation Group
b N Ele¢ Py Parameters G
bR Eleg
b i T Plot All
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2 Define a parameter, iso_level, with Expression 309.5[K].

Model Builder v

— = =t -

4

4 % busbar_lll.mph (root)
I () Global Definitions ¥ Parameters
I @ Component1 {comp1)

» -
[~ Study 1 MName Expression | Value Description
4 [ Results

iso_level 309.5[K] 3095K  |lsosurface level G
Fi Parameters

3 Datasets
[ &2 Derived Values

k! -
b B Tables =2 N

3 For the Isothermal Contours (ht) | plot group, in the Settings window for the
Isosurface plot, change the Entry method to Levels
field, type iso_level.

. For the Levels expression

I @ Temperature (ht) 1

4 [ Isothermal Contours (ht) 1 v Levels
& lsosurface
b ~% 1D Plot Group 10 Entry method: Levels A
Export Levels: iso_level K Ll G
[# Reports

[ Interactive
Shift: 0

4 In the same Settings window, click Plot.

wbb(6)=0.1m Isosurface: Temperature (K) L

1 0.05
| @ b= 3085 4




5 Generate an Animation by either selecting the Player option in the Animation
menu of the Isothermal Contours (ht) | tab on the ribbon, or right-click the
Export node and sclect Animation > Player.

Model Builder

— ‘s St El -

4 % busbar_lll.mph (root)
4 () Global Definitions

Fi Parameters 1

45 Default Model Inputs

= Materials

I @ Component1 {comp1)

[~ Study 1
4 [ Results

Fi Parameters
Datasets

2 Derived Values
EH Tables

I'.’ Electric Potential (ec)
I'.’ Electric Field Morm {ec)
VB Temperature (ht)

I'.’ |sothermal Contours (ht)

I'.’ Electric Potential (ec) 1
I'.’ Electric Field Morm {ec) 1
VB Temperature (ht) 1

I'.’ |sothermal Contours (ht) 1

/
/
/
/
/
/
/
I §i§ Current Density
/
/
/
4

¥ Isosurface

—

Export
[ Animation 1
[# Reports

~% 1D Plot Group 10

~ & Settings

gsh-o;\rFrame
Label: Animation 1
¥ Scene
Subject:
¥ Target
Target: Player

¥ Animation Editing

Sequence type:
Parameter:
Start:

Stop:

Unit:

¥ Frames

Number of frames: 50

Frame number: 50

iso_level:

Isothermal Contours (ht) 1

©

Result parameter
izo_level (lsosurface level)
309
310
K

310K

-

6 In the Settings window for Animation, change the Sequence type to Result
parameter and select the iso_level parameter. Type 309 for Start and 310 for
Stop. Click the Play button in the Graphics toolbar or the Show Frame button in
the Settings window for Animation. To get a smoother animation, change the
Number of frames to a higher number; for example, 50.

The subject of parametric sweeps raises the question of parallel computing; it
would be efficient if all parameters were solved simultaneously.

Parallel Computing

COMSOL Multiphysics and COMSOL Server support most forms of parallel
computing, including shared-memory parallelism for multicore processors and
high-performance computing (HPC) for clusters and clouds. All COMSOL
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licenses are multicore enabled. For cluster or cloud computing, including
parallelized sweeps, a Floating Network License (FNL) is needed.

You can use clusters or clouds with one of two options: Cluster Sweep or Cluster
Computing. If you have an FNL, these two options are available by right-clicking
the Study node. However, you first need to enable the Batch and Cluster study
options by clicking the Show More Options button = on the Model Builder toolbar
and selecting Batch and Cluster in the Show More Options dialog box.

Model B 1

3 Show More Options

Physics
[##] Au Equation Sections
[] 5+ Equation View
" Stabilization
[[] Ay Equation-Based Contributions
Elcj: Extra Dimensions
[[] &= Advanced Physics Options
4 o Study
é" Batch and Cluster
|:|I||II Sensitivity
B8 Multigrid Level
[1(5)) Reduced-Order Modeling
[[] % Solver and Job Configurations

4 ([ Results

CLUSTER SWEEP

The Cluster Sweep option is used for solving several models in parallel where each
model has a different set of parameters. This can be seen as a generalization of
Parametric Sweep. Right-click the Study node to add a Cluster Sweep node.

Model Builder ~ % Settings v
= = 5t~ i Cluster Swee
4 % busbar_lll.mph (root) = Compute ' Update Solution

4 () Global Definitions
Fi Parameters 1
45 Default Model Inputs

Label: Cluster Sweep =

¥ Study Settings

= Materials
P T Component 1 (comp1) Sweep type: Specified combinations =
4 o Study 1
LeFi L
"i Cluster Sweep Parameter name | Parameter value list | Parameter unit
[= Step 1: Stationary O TR
I [fre Solver Configurations D (e m
[ EJ Job Configurations
b IE Results
+ =) beed
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The Study Settings for Cluster Sweep arc similar to that of Parametric Sweep, but
additional settings are required for the cluster or cloud being used. The picture
above shows how the top of the Settings window for Cluster Sweep would look for
the same sweep as defined in “Parametric Sweeps” on page 159. To add and run
a Cluster Sweep in this case, you would first remove the Parametric Sweep node.

CLUSTER COMPUTING

You can also utilize a cluster or cloud to solve a single large model using
distributed memory. For maximum performance, the COMSOL software cluster
implementation can utilize shared-memory multicore processing on each node in
combination with the Message Passing Interface (MPI) shared-memory model.
This is also known as hybrid parallelism and brings a major performance boost by
making the most out of the computational power available.

Right-click the Study node to add a Cluster Computing node. A Cluster Computing
node cannot be used in combination with a Cluster Sweep. You will be asked if you
want to remove the Cluster Sweep before proceeding. Select Yes.
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The Settings window for Cluster Computing, shown below, helps to manage the
simulation with settings for the cluster or cloud.

Model Builder ~ */| Settings -
- @ =t R Cluster Computing
4 % busbar_lll.mph (root) = Compute ' Update Solution
4 () Global Definitions
P, Parameters 1 Label: Cluster Computing E
45 Default Model Inputs .
Materials ¥ Batch Settings
4 T\ Component 1 (comp1) Filename: batchmodel.mph
[ Definitions .
I Geometry 1 [] Generate solver sequence in external process
I 5z& Materials Mumber of nodes: 1
4 x_ Electric Currents (ec) [] Use batch license
Dmm 1
:3-' Curre!ﬂt Conser\ratlon‘l Before sweep
s Electric Insulation 1 T &
BS Initial Values 1 [ Clear meshes
= Electric Potential 1 [ Clear selutions
= Ground 1 During sweep
4 [ Heat Transfer in Solids (ht) [] Synchreonize solutions
= Solid 1 Clear sunchronizati
. Clear synchronization data

Initial Values 1

o ) Save model to file after synchronization is completed
s Thermal Insulation 1

= Heat Flu 1 Synchronize accumulated probe table

iy Multiphysics

b A Mesh 1 After sweep
4~ Study 1 Output model to file
%% Cluster Computing Cluster computing settings
7~ Step 1: Stationary Settings: Preferences controlled =
I [fre Solver Configurations
[ EJ Job Configurations I Cluster Settings

b IE Results

Remote and Cloud Access

Advanced Settings

The Settings menu under Cluster computing settings has two options: Preferences
controlled or User controlled. The figure above shows the Preferences controlled
option. For the Preferences controlled option, the settings are defined in the
Preferences dialog box in the File menu.
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For the User controlled option, you choose the type of cluster job you want to
perform from the Scheduler type list.

Cluster computing settings

Settings: User controlled =

Scheduler type: | General - |

Host file: |Genera| |
Microsoft® HPC Pack

Bootstrap server
0GS/GE

Directory: SLURM

[] Specify server direct PES

Directory: Mot distributed

[] Specify external COMSOL batch directory path
Directory:

[] Specify external COMSOL installation directory path
Directory:

Number of job restarts: 0
Alive time (seconds): 300

COMSOL Multiphysics and COMSOL Server support General, Windows® HPC
Pack, Open Grid Scheduler/ Grid Engine (OGS/GE), SLURM, PBS, or Not
distributed. The General option is a multipurpose option for Linux® clusters.
Additional cluster and scheduler settings, such as Prepend command and Postpend
command, arc available in the Preferences window in the File menu.

To learn more about running in parallel, see the Reference Manual.

The Cluster Sweep and Cluster Computing options are only visible if you
have an FNL and have enabled the Batch and Cluster study options.

COMSOL Multiphysics Client-Server

When using COMSOL Multiphysics with an FNL, it is possible to use a client—
server mode of operation to access remote computing resources for solving large
models, while still using the graphics card on a local machine to display graphics.
This mode of operation should not be confused with the use of Windows®
Remote Desktop, and similar technologies, to connect to a COMSOL
Multiphysics session, or the use of the COMSOL Server product for use with
COMSOL applications.

Using the COMSOL Multiphysics client—server mode can have some significant
advantages, since engineering and scientific computing problems involve working
with large amounts of data — anywhere from megabytes to gigabytes of data are
commonly generated during a simulation. To generate and store this data, you
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may want to use computers with fast processors, large amounts of Random Access
Memory (RAM), and a large hard drive. To visualize large datasets, it is important
to have a high-end graphics card on your local computer.

Under ideal conditions, you would always be working on a high-end computer
with more than enough memory and processing power for all of the simulation
steps. If this is not the case and you need to solve larger models, you may instead
access a shared computing resource across a network.

At any time while using COMSOL Multiphysics, it is possible to connect to a
remote computing resource via the client—server mode of operation. This is a
two-step process. First, log onto the remote system and invoke the COMSOL
Multiphysics server, which will start the COMSOL Multiphysics server process
and open a network connection. Second, on the local machine, simply enter the
network connection information into an open session of COMSOL Multiphysics.
The software then transparently streams the model data and results back and forth
over the network and uses the remote computing resource for all computations.

There are several ways to start a COMSOL Multiphysics server session. In
Windows® 10, you can start a server session from the COMSOL Launchers option
from the Windows start menu.

« v » ThisPC » Windows (C) » Program Files » COMSOL » COMSOL61 » Multiphysics » COMSOL Launchers

AT COMSOL Documentation &3 COMSOL Multiphysics 6.1 {Directi)

3 Quick access . . . .
43 COMSOL Multiphysics 6.1 (Software) L3 COMSOL Multiphysics 6.1

@ OneDrive - Personal # COMSOL Multiphysics Server 6.1 A= LMTOOLS
A= Uninstall i3 Update

[ This PC ‘ -

¥ Network

In Linux®, you can use the comsol mphserver command. The server and client
sessions can be run on different operating systems. For example, the server can run

in Linux® and the client session in Windows®.

The first time you start a COMSOL Multiphysics server on a computer, you are
asked for a username and password that are associated with the client—server mode
of operation and stored for future connections. The figure below shows the
command window for starting a server session in Windows®.

i3 COMSOL Multiphysics Server

llzername: paunl

Password:

[Conf irm password:

Port number 2836 was busy, using 2038 instead

ICOMS0L Multiphysics Server started listening on port 28038

llze the console command ‘close’ to exit the program
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The figure below shows how to connect to a server session from the COMSOL
Desktop user interface. From the File menu, select COMSOL Multiphysics Server >
Connect to Server to connect.

(5]

e R

Home  Definitions

b

MNew

[ Run Application

4
=

=

&

ek

I

Open

Open From

Recent

Application Libraries

Save

Save As

Save To

Revert to Saved

Compact History

COMSOL Multiphysics Server
Help

Licensed and Used Products
Preferences

Exit

Geometry  Materials  Physics Mesh  Study  Results  Developer
Ctrl+N
Ctrl+0
Ctrl+Shift+0
3
Ctrl+S
Ctrl+Shift+5

» =H Connectto Server
r Disconnect from Server
Import Application from Server

Remove Applications from Server

You are now prompted for the username and password that you gave the first time
you started a server session.

3 Connect to COMSOL Multiphysics Server X

Server

Server: | myserver.address.com

Port: Default

User

Username: | paul

Password: LYTTTYS

Remember username and password

oK Cancel

For more information on running the COMSOL Multiphysics client-server, see
the Reference Manual.
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Using the Model Manager

This section gives a brief introduction to using the Model Manager for simulation
data management. The Model Manager allows users to collaborate and centrally
organize models and apps and provides tools for version control, efficient storage,
searching for MPH-file contents, and more. A database can either be stored locally
on your computer for personal use, or, if you have an FNL, accessed remotely
from a server for collaborative use. You will learn how to create a local Model
Manager database, store simulation data, and control versions.

For detailed information on using the Model Manager, see the book Model
Manager Reference Manual.

Creating a Local Database

Assuming you have not already created a local database, this is how you create one
in order to get started using the Model Manager.

In the File menu, the Open and Save As menu items let you open and save files to
a local or shared file system. The Open From and Save To menu items also let you
open and save to a Model Manager database.
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I From the File menu, sclect %= Open From.

e e @R
Home  Definitions  Geometry  Materials
[ New Ctrl+N

[ Run Application

& Open Ctrl+0

%= Open From Ctrl+Shift+0 0
Recent r

[l Application Libraries

Save Ctrl+5

[ Save As

I saveTo Ctrl+Shift+S

Revert to Saved

B

=) Compact History
COMSOL Multiphysics Server 3
Help r
T Licensed and Used Products
Preferences
Exit

2 In the Open window, choose & Add Database in the list of options.

Home  Definitions  Geometry  Materials ~ Physics
Open
ﬁ—) Recent

" Add Database G

E Browse
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3 In the Add Database window, choose New Local Database

Home  Definitions  Geometry
Add Database

Mew Local
Database

Open Local
Database

=

Connect to
Server Database

4 In the New Local Database window, type Modeling Example as the name for the
new database in the Name field. You can choose a more suitable name if you
intend to keep using this database.

New Local Database

Database name
Mame  Modeling Example 4

Databases directory

Directory:  C:\Usershalice\AppData\Local\COMSOL\Databases W& Browse

@ seck
B e €)cance [ avd Dotabase G

5 Click [/ Add Database.
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A progress window is displayed, informing you that the database is being created
on the file system.

Progress

Creating local database

Once finished, the Open window is shown with the newly created database selected
in the list.

P hEER
Home Definitions Geometry Materials  Physics  Mesh  Study Results  Developer

Open

a Y ¥~ Noresultsfound
9 Recent

Search
= Modeling Example

L Add Database

P& Browse

|2 G eCance\ G Open Run

6 From the Open window, you can search the database for models to open. At the
moment, your database is empty. Click g Cancel.

Version Control

MODEL WIZARD SETUP

For the purpose of demonstrating using the Model Manager, we will revisit the
wrench model “Example 1: Structural Analysis of a Wrench” on page 38 and start
anew from the Model Wizard.

I From the File menu, select New. In the New window, choose Model Wizard.
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2 In the Select Space Dimension window, sclect 3D.

3 In Select Physics, sclect Structural Mechanics > Solid Mechanics (solid) = . Click
Add. Click Study o to continue.

4 Click Stationary = under Preset Studies. Click Done & once finished.

SAVING A FIRST VERSION
Place your new model under version control by saving it to your database.
I From the File menu, select 7 Save To.

2 In the Save window, choose your newly created database, Modeling Example,
from the list of options.

The Save window updates with the selected database set as the target for the
save. The header reads Save new as the model is not yet present in the database.

3 Type 3D stationary solid mechanics in the empty Title field.

4 You can type an optional comment describing what you are saving in the
Comments ficld. Type Setup for a 3D solid mechanics model using a
stationary study.

Title: 3D stationary solid mechanics
Comments:

Setup for a 3D solid mechanics model using a stationary study.

o

Save -

5 Click the Save button ( ] ).

A first version of the model is now saved in the Modeling Example database.

Click the root node in the Model Builder window. The Title field in the Presentation
section of the Settings window has been updated with the title you gave when
saving.
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SAVING ADDITIONAL VERSIONS

The model uses a geometry that was previously created and stored in the
COMSOL native CAD format mphbin.

I In the Model Builder window, right-click Geometry 1 14 and select Import = .

2 In the Settings window for Import, from the Source list, select the COMSOL
Multiphysics file.

3 Click Browse g and locate the file wrench.mphbin in the applications folder of
the COMSOL installation folder. Its default location in Windows® is

C:\Program Files\COMSOL\COMSOL61\Multiphysics\applications\
COMSOL_Multiphysics\Structural_Mechanics\wrench.mphbin

Double-click to add, or click Open.
4 Click Import = to display the geometry in the Graphics window.
5 Select Geometry | ‘% and click the Build All button ® in the Settings window.

With the geometry imported to the model, save a second version:
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I From the File menu, sclect [ Save as Version.

o0 w £ © BB O
Home  Definitions  Geometry  Mat
[ New Ctrl+N
[53 Run Application
& Open Ctrl+0
P Open From Ctrl+Shift+0
Recent r
[l Application Libraries
V] Save Draft Ctrl+5
Save as Version G
I saveTo Ctrl+Shift+S

Revert to Saved

The Save window opens with your database preselected in the list of options.

e Dhw g

Home Definitions Geometry Materials Physics Mesh  Study  Results  Developer

Save

S, ersion ~ Information

+~ Modeling Example - Latest Sep 16, 2022, 1:5820 P
Title: 3D stationary solid mechanics el 2 M

Saved by:

Comments:

Add Database Description

v Tags Ov B =

& Browse Notags assigned.

Save v

The header reads Save version, as the model already exists in the database. The
title is the same as when saving the first version.
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2 In the Title field, change the title to Structural analysis of a wrench and
type Added a geometry for a wrench in the Comments field.

Title: Structural analysis of a wrench

[ 2)

Comments:

Added a geometry for a wrench

Save -

3 Click the i Save button.
You now have two versions of the model saved in your database.

For the purpose of demonstrating multiple versions, we will make a small change
to the model and save another version by adding a description to the model. This
will be the third version.

I Click the root node in the Model Builder window.

2 In the Description ficld under the Presentation section, type Analysis of the
mechanical stress level in a wrench.

3 From the File menu, select [ Save as Version.
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4 Type Added a description. in the Comments field. Click Save.

Save version

Title: Structural analysis of a wrench

Comments:

Added a description. G

Save -

THE VERSIONS WINDOW
Up to this point, you have saved three versions of the model in the database.
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I From the Windows menu = in the Layout section of the Home tab, select
Versions to open the Versions window.

= =

Windows| Reset
- Desktop -

Add Physics
Add Multiphysics
Add Study

fracs

ﬂ n—§’ s

Material Browser

Part Libraries
Add-in Libraries

i E B E g

Selection List
Properties
Auxiliary Data
Messages
Debug Log
Table

External Process

Comparison Result

AedBEERKJ Ea

Find and Replace

Versions

2| Recovery Files

Add Predefined Plot
Add Material from Library

Application Libraries

o

2 You will see the three versions in a table in chronological order, with the most
recent version in the first row and the oldest version in the last row. The first
row in the table is highlighted in bold to indicate that it is the current version
in the COMSOL Desktop.

Messages Progress Log

e}

Title

Versions X

“Structural analysis of a wrench: Showing 3 versions

Saved

Saved By

[+ |Structural analysis of a wrench |Sep 16, 2022, 2:02:49 PM  Alice

[#] |structural analysis of a wrench
[#]|2D statienary selid mechanics

Sep 16, 2022, 2:01:58 PM
Sep 16, 2022, 1:58:20 PM

OPENING OLDER VERSIONS

You can easily open an older version from the Versions window.

Alice
Alice

Branch
Main
Main
Main

ML

Meodeling Example (Repositery 1/Main)

Comments
Added a description. G

Added geometry for a wrench

Setup for a 3D selid mechanics model using a stationary study.
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I Seclect the last row in the table and click the Open button in the toolbar. You
can also double-click the row. Select No if you are asked to save any unsaved
changes.

Messages Progress Log Versions X

(& sz 5 “Structural analysis of a wrench’

Title Saved
[#]|Structural analysis of awrench  |Sep 16, 2022, 2:02:49 PM

tructural analysis of a wrenc = 3 :01:
S | analysis of h Sep 16, 2022, 2:01:38 PM
|+| |3D stationary solid mechanics  |Sep 16, 2022, 1:58:20 PM

The first version is opened in the COMSOL Desktop. In this version, there is
no Import = node under the Geometry I 4 node, and the Description ficld is
empty.

2 Select the middle row in the table and click Open

The second version is opened in the COMSOL Desktop. In this version, the
Import node is now present under the Geometry node, but the Description ficld
is still empty.

3 Seclect the first row in the table and click Open
The third, and latest, version is opened in the COMSOL Desktop.

Working with a Draft of the Model

It may have crossed your mind that saving a new model version requires several
steps — especially compared to just pressing Ctrl+S for a model opened from the
file system. You need to open the Save window, think of a comment describing
your changes (although the comment is not required), and then click the Save
button ©J . You might even realize after saving multiple versions that your
modeling work has gone in the wrong direction. You would then have a version
history cluttered with unwanted versions.

A more lightweight option when working on a model is to save a draft of the
model. You can save multiple versions of this draft without affecting the original
model. Once you are happy with your draft, you can save it as a new version of the
original model. You may of course choose to discard your draft altogether and
instead go back to the original model and, perhaps, start a new draft.

STARTING A NEW DRAFT

Let’s continue working with the wrench model but now using drafts. Make sure
that you have opened the latest (first-row) version in the Versions window.
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Add a generic steel material for the wrench and save your work as a new draft.
I Right-click Component |>Materials ::: and sclect Add Material from Library ::; .

2 In the Add Material window, click to expand the Built-In folder. Scroll down to
find Structural steel, right-click, and select Add to Component 1.

3 Close the Add Material window.

4 From the File menu, select 7 Save Draft. You can also use the keyboard
shortcut Ctrl+S.

® 0w d Co@ELBEDE
File Home  Definitions  Geometry  Mater
[ New Ctrl+N

[ Run Application

& Open Ctrl+0
P Open From Ctrl+Shift+0
Recent 3

[l Application Libraries

:| Save Draft Ctrl+5 G

Save as Version
(! saveTo Ctrl+Shift+S
Revert to Saved
&)

Compact History

COMSOL Multiphysics Server 3
Help r
7 Licensed and Used Products

Preferences

Exit

You have now created a first version of a draft of the model. You can see this draft
version as a new row in the table in the Versions window above the three versions
of the original model. The draft version uses a separate pen icon ( 5] ) to
distinguish it from the regular versions ( [ ). Note that the regular versions
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belong to the original model, not the draft itself — they are included in the table
to make it easier for you to track where the draft originated from.

Messages Progress Log | Versions X A

& "Structural analysis of a wrench': Showing 4 versions Modeling Example (Repository 1/Main)
Title Saved Saved by Branch Cemments

I Structural analysis of a wrench  [Sep 16,2022, 2:14:11PM | Alice Main Draft of ‘Structural analysis of a wrench’ saved by user.

[#] [Structural analysis of awrench  |Sep 16, 2022, 20243 PM | Alice Main Added a description.

[] [Structural analysis of awrench  |Sep 16,2022, 201:58 PM | Alice Main Added geometry for a wrench

[#] 13D stationary solid mechanics  |Sep 16,2022, 1:58:20PM | Alice Main Setup for a 3D solid mechanics model using a stationary study.

SAVING ADDITIONAL DRAFT VERSIONS

Just like in “Example 1: Structural Analysis of a Wrench” on page 38, now specify
the load applied to the wrench and save your draft changes.

I Select Parameters 1 r; in the Model Builder window.

2 In the Settings window’s Parameters table, enter these settings:
- In the Name column, enter F.
- In the Expression column, enter 150[N].

- In the Description column, enter Applied force.
3 From the File menu, select [ Save Draft.
Selecting Save Draft a second time creates a second version of your draft — the

Versions window now contains two draft versions and three regular versions.

Just as for the regular versions of the original model, you can inspect an older draft
version by selecting the row in the table and clicking Open

A draft is a model in its own right in the database — existing side-by-side with the
original model. You can switch back and forth between them in the COMSOL
Desktop simply by opening one or the other.

I From the File menu, select Open From (&= ).
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2 In the Open window, choose your database, Modeling Example, in the list of

options.

The Open window shows a list containing the latest version of the draft ( i ) and

the latest version of the original model ( [ ).

(& T v 20of2results shown

Structural analysis of a wrench
Oct 4, 2021, 12:37:41 PM (Alice)

Structural analysis of a wrench
Oct 4, 2021, 12:32:17 PM (Alice)

Open Run

Search

3 Select the version of the original model ( [ ) and click the Open button

The Model Manager detects that there is a draft of the original model in
progress that corresponds to a draft version that is newer than the latest version
of the model. A dialog box appears, in which you can choose to open that newer

draft version instead.

Open

More recent versions found for the selected model in branch 'Main'.

rl |:| Structural analysis of a wrench -Sep 16, 2022,12:32:17 PM (Alice)
:l Structural analysis of a wrench -Sep 16, 2022,12:37:41 PM (Alice)

©

Open Cancel

4 Select the top node in the tree and click Open to open the original model. The
latest version of the model is opened in the COMSOL Desktop — neither the
Structural steel node nor the Parameters scttings is present in the model, as

expected.
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You could, at this point, continue working with the original model, thereby
implicitly discarding your draft work. The draft itself can be manually deleted from
the database at some later time.

Assume that choose to continue with your draft. Open the latest version again:
I From the File menu, sclect Open From = .

2 In the Open window, choose your database in the list of options.

3 Select the draft version ( I ) and click Open

Finish the component setup by defining boundary conditions and mesh settings:
I Right-click Solid Mechanics (solid) == and sclect Fixed Constraints & .

2 In the Graphics window, rotate the geometry and select the front surface of the
partially modeled bolt. The Boundary number in the Selection list is 35.

3 Right-click Solid Mechanics (solid) = once more and select Boundary Load & .
4 Sclect the top socket face (boundary 111) in the Graphics window.

5 In the Settings window for Boundary Load, under Force, sclect Total force as the
Load type and enter -F in the text field for the z component.

6 Sclect Mesh 1 4 . In the Settings window for Mesh, under Physics-Controlled
Mesh, sclect Finer from the Element size list.
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7 Click the Build All i button in the Settings window.

With the basic setup finished, select Save Draft [ to save a third draft version.

Messages Progress Log | Versions X
(& “"Structural analysis of a wrench": Showing & versions
Title Saved Saved By

I]|Structural analysis of awrench |Sep 16, 2022, 2:25:10 PM | Alice
I |Structural analysis of awrench  |Sep 16,2022, 219:36PM | Alice
5] |Structural analysis of a wrench  |Sep 16, 2022, 21411PM | Alice
[+]|Structural analysis of a wrench  |Sep 16,2022, 2:02:49PM | Alice
[=] [Structural analysis of a wrench  |Sep 16, 2022, 201:58PM | Alice
[+] 2D stationary solid mechanics  |Sep 16, 2022, 1:58:20PM | Alice

FINISHING YOUR DRAFT

ML

Modeling Example (Repository 1/Main]

Branch | Comments

Main
IMain
Main
IMain
Main
IMain

Draft of ‘Structural analysis of a wrench® saved by user. 6
Draft of '‘Structural analysis of a wrench' saved by user.

Draft of ‘Structural analysis of a wrench’ saved by user.

Added a description.

Added geometry for a wrench

Sctup fer a 3D solid mechanics model using a stationary study.

With the component setup finished, you can save your draft work back to the

original model:

I From the File menu, sclect [ Save as Version.

The Save window opens with your database preselected in the list. The header
reads Save version from draft as a new version of the original model that will be

saved from the draft.

2 Type Finished model for the von Mises stress in a steel wrench in

the Comments ficld.

version from draft

Title: Structural analysis of a wrench

Comments:

Finished model for the von Mises stress in a steel wrench

3 Click the Save button

Save -
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Open the Versions window to see that all draft versions are now gone from the
table. Instead, there is a fourth version of the original model and the draft itself
has been deleted.

Messages Progress Log Versions X i

@ "Structural analysis of a wrench”: Showing 4 versions Modeling Example (Repository 1/Main)
Title Saved Saved By | Branch = Comments

D Structural analysis of a wrench Sep 16, 2022, 2:28:23 PM  Alice Main Finished model for the von Mises stress in a steel wrench.

[] Structural analysis of awrench  Sep 16, 2022, 20249 PM  Alice Main  Added a description.

[5] Structural analysis of a wrench  Sep 16, 2022, 201:58 PM  Alice Main  Added geometry for a wrench

[#] 3D stationary solid mechanics | Sep 16, 2022, 1:58:20PM  Alice Main  Setup for a 3D solid mechanics model using a stationary study.

Comparing Versions

You can see all changes made to the model when you save it from your draft.
I Right-click the second row in the table in the Versions window and select
Compare ( of: ).
The Comparison Result window is opened with a comparison between the
current model in the COMSOL Desktop and the selected version.
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2 The expanded tree shows, for example, the force parameter, the steel material,
the mesh settings, and the two boundary conditions added from your draft.

Graphics | Comparison Result X T
BCeE-Ey = ‘ot
Compare with opened

"

Opened Saved version
Structural analysis of a wrench Structural analysis of a wrench (Madel)

Differences
Filter results: Exclude all matching labels ~ AT g i ch
Regular expression:
4 gy Structural analysis of a wrench

4 Py Parameters
4 gTs Variables that only exist in local file

a= F

Geometries

Views
Materials
T3 Items to be added to remote file

b 22 Structural steel (mat1)
Meshes
A Mesh1
& Attributes differ
b = Features

almm

ol

4 = Physics
4 53 Salid Mechanics (solid)
4 = Features
4 s Items to be added to remote file
I ( Fied Constraint 1
I ( Boundary Load 1

Comparing values

"
Attribute Value in opened Value in saved

s | Expression (F) 150[N]

&

You can also compare two older versions with each other:

I Select the second and third rows in the Versions window, using Ctrl+click, then
right-click either one, and select Compare . .

The Comparison Result window is updated with a comparison between these two
versions.

2 Expand the tree and select the Attributes differ child node. In the Comparing
values table, you will find the description you added in the third model version.

4 gfu Structural analysis of a wrench
iTe Attributes differ

Comparing values G
L

Attribute Value in older Value in newer
iT | Description Analysis of the mechanical stress level in a wrench

3 Close the Comparison Result window.
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Excluding Built, Computed, and Plotted Data

Let’s now run the study. First, make sure you have the latest version of the model

opened:

I In the Versions window, double-click the first row.

2 Right-click Study | ~» and select Compute = to solve the model. When the
computation finishes after a few seconds, the von Mises stress is displayed in a
default Volume plot in the Graphics window.

Storing simulation data generated by a model can require large amounts of disk

space. For such data that is reproducible — such as built, computed, and plotted
data — it may be undesirable, or even impossible due to sheer size, to save it in

the database. To control which data is saved in the database:

I Select the root node in the Model Builder window.

2 In the Settings window, in the Save section under Built, computed, and plotted
data, in the In database list, sclect Exclude.

¥ Save
Built, computed, and plotted data
On file:
Include =

In database:

Exclude - | G

Include in regular and draft versions

Include in regular versions
Include in draft versions
Exclude

I T e T e e e e e e )

Note that by using the On file list menu, you can also exclude built,
computed, and plotted data when saving to the file system.

3 From the File menu, select 1 Save as Version.

The Save window opens for your database with the message Built, computed,
and plotted data is excluded from the save under Information.

Information

Latest version:  Oct 4, 2021, 12:47:03 PM e
Saved by: Alice

Built, computed, and plotted data is excluded from the save.

@

4 Type Saved without generated simulation data. in the Comments field.
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5 Click Save

The model remains in its solved state in the COMSOL Desktop after the save. Go
to the File menu, select Revert to Saved, and click Yes in the dialog box that
appears. The latest saved version without the solution is opened. You can
reproduce the lost (by now) solution by right-clicking Study 1 ~ and selecting
Compute = .

Importing Auxiliary Data to the Database

You may have noticed that, while the model is version-controlled in the database,

the same is not true for the CAD input file. You can import the file to the database

as follows:

I From the Windows menu = in the Layout section on the Home toolbar, select
Auxiliary Data to open the Auxiliary Data window.

The Auxiliary Data window shows the input files used in the model. In this case,
a single row is shown, corresponding to the CAD file that is used in the Import

& node.
Messages Progress Log  Auxiliary Data X = Versions -n
(GRS

Node Setting Location Status
= Import 1 (imp1) (Component 1 (comp1) > Geometry 1) |Filename C:\Pragram Files\COMSOLYCOMSOLET\Multiphysics\appl... /Available on disk

o

2 Select the table row, right-click on either row, and select Import to Database = .
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3 The Import dialog box shows the file wrench.mphbin in a table.

& Import *
Target location:  Modeling Example (Repository 1/Main)

File Source
[Z] |wrench.mphbin C:\Program Files\ COMSOL\COMSOL60\Multiphysics\applications\COMSOL_Multiphysics\Structural_Mechanics\wrench....

©

1item to import.

Options
Include auxiliary files found in imported medels
Tags: Mone o
0K Cancel

4 Click OK.

Select the Import = node in the Model Builder window. The Filename ficld in the
Import section in the Settings window now shows a reference to the file that is
uploaded to the database.

Model Builder v * Settings v
- = Ev Bl E~ Import
4 G Structural analysis of a wrench (root) [ Build Selected = [E8 Build All Objects 2
4 () Global Definitions
P; Parameters 1 Label: Import1 E
2 Materials
4 |§ Component1 (comp1) v Import
[ = Definitions R
Geormnetry 1 - —
Import 1 (imp1) COMSOL Multiphysics file =
. Form Union (fin) Filename:
b 5 Materials wrench.mphbin (Modeling Example) B G

4 @ Solid Mechanics (solid)
& Linear Elastic Material 1
5= Freel Include result from virtual operations

W& Browse = [& Import

= Initial Values 1

= Fixed Constraint 1 ¥ Selections of Resulting Entities

Finish by saving the model to the database:
I From the File menu, select [ Save as Version.

2 Type Referenced CAD file from database. in the Comments field. Click Save
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The Model Manager Workspace

This concludes this quick introduction to the Model Manager. For detailed
information on using the Model Manager, see the book Model Manager
Reference Manual.

You are encouraged to further explore the Model Manager in the Model Manager
workspace. This is a dedicated workspace in the COMSOL Desktop for tasks
related to using the Model Manager.

To open the Model Manager workspace, click the Model Manager & button in the
Workspace scction of the Home toolbar. In the Model Manager workspace, you will
see the Model Manager toolbar as well as various windows belonging to the
workspace. The latest versions of your model and CAD file are displayed.

B InE & iy - Structural analysis of a wrench - COMSOL Multiphysics - O X
File Database 7]
,. & Import Open 5]z Compare % =
- A = Export =5 et Tags [c]

Model Application  Modeling _ Add Windows Reset
Builder  Builder Example - Database (=% MNew Tag Delete ~ - Desktop
Workspace Database Item Layout
Model Manag ~ 4 Settings v
ot e B S 2ef2resulsshomn Modeling Example (Repository 1/Main)
Eal| Save ¢ Reset
| Search =
~ \Version
Title Tags | Saved Saved By | Owner
[][Structural analysis of a wrench Sep 16, 2022, 2:44:26 PM Alice Alice Location: Modeling Example (Repesitory 1/Main)
[Z] wrench.mphbin Sep 16,2022, 2:42:21 PM  Alice Alice Saved: Sep 16, 2022, 2:44:26 PM
Savedby:  Alice
Saved in: 6.1
Title: Structural analysis of a wrench
Filename:
Update from: V& Browse
Description:
Analysis of the mechanical stress level in a wrench
Versions Commits References =L
o=@ [E] Fdt® =« “Structural analysis of awrench’  + contents Bt E~
Title Reference Type Saved Saved By 4 % Structural analysis of a wrench (root)
[E] wrench.mphbin Input file Sep 16,2022, 242:21PM  |Alice b @ Global Definitions
4 i@ Compoenent 1 fcomp1)
b = Definitions
b YA Geometry 1
b 28 Materials
b 51 Solid Mechanics (solid)
A Mesh 1
b e Study 1
b B Results
2.79GB|3.51 GB
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To learn more about what you can do in the workspace, you can, for example:

* Seclect the model and expand the model tree in the Content section of the
Settings window. Here, you can browse the content of a model without
opening it.

 Search for your model by applying various Item and Contents Filters. Examples
include a Physics filter for finding a Solid Mechanics interface (= ) or a
Parameter filter for the applied force 150[N].

+ Right-click the model and select References ( (2 ) to see the database
relationship between the model and the CAD file in the References window.

* Right-click the CAD file and select Versions ( 71 ) to see all versions of the
file — currently only one — in the Versions window.

* Right-click the model and select Commits ( ) ) to open the Commits window.
Double-click the third table row from the top. You will see details on the
commit in which a new version of the original model was saved from your
draft, and the draft itself was deleted.

In order to more easily test the various features of the Model Manager, you can
download a demo database by selecting, from the File menu, Help > Download
Demo Database for Model Manager.

Help v H Hep F1
7 Licensed and Used Products I! Docurnentation Ctrl+F1
Preferences @ Application Gallery
Exit = Support Center

| r:] Training

(%) Check for Product Updates
Update COMSOL Application Libraries
Update COMSOL Part Libraries

| Download Demo Database for Model Manager

=l About COMSOL Multiphysics

This demo database contains models and associated files from the Application
Libraries.
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Appendix A — Building a Geometry

This section details how to create the busbar geometry using the built-in geometry
tools in COMSOL Multiphysics. The step-by-step instructions take you through
the construction of the geometry using the parameters set up in the Global
Definitions section.

All geometry operations under the geometry node in the model tree are organized
in a parametric sequence of operations called a geometry sequence. Using
parameterized dimensions helps to produce what-if analyses and geometric
parametric sweeps.

As an alternative to building the geometry using the tools available in COMSOL
Multiphysics, you can import a geometry created with CAD software. The
optional CAD Import Module and Design Module support many CAD file
formats. Moreover, several add-on products are available that provide
bidirectional interfaces to common CAD software packages. See “Appendix E —
Connecting with LiveLink™ Add-Ons” on page 248 for a list. Note that the
Design Module, in addition to the features available in the CAD Import Module,
adds functionality for dimensions and constraints. The Design Module also
includes additional 3D geometry modeling operations such as loft, fillet, chamfer,
midsurface, and thicken.

If you have not done so already, start with “Example 2: The Busbar — A
Multiphysics Model” on page 72. Follow the steps in the section “Model Wizard”
on page 39 to add the physics and study and then follow the steps under Global
Definitions to add the parameters, which are then used in the remainder of this
section. Return to this section to learn about geometry modeling.

Alternatively, load the model busbar_geom from the Application Libraries tree
under COMSOL Multiphysics > Multiphysics. Then, in the model tree, right-click the
Geometry node and select Clear Sequence. This deletes all geometry operations
from the model tree.

The first step in the geometry sequence is to draw the profile of the busbar.
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I Under Component I, right-click
Geometry | 2 and sclect Work Plane & .

In the Settings window for Work Plane: Work Plane
: [ Build Selected + [E Build All Objects &3

- Sclect xz-plane from the Plane list (the
last option in the list).

- Click the Show Work Plane button &

Label: Work Plane 1 =

¥ Plane Definition

on the Settings window for Work Plane type: | Quick -
: -pl =
Plane toolbar. G Rlanc TR
. .. . . Offset type: Distance -
Continue by editing the axis and grid .
y-coordinates 0 m

settings in Work Plane 1.

Local Coordinate System

2 In the Model Builder window, expand
the View 2 node v and click Axis [=.

¥ Unite Objects

Unite objects

4 Geometry 1 Repair tolerance: | Automatic -
Work Plane 1 {wp1)
Plane Geornetry ¥ Selections of Resulting Entities
I_I‘Ewa. G ["] Resulting objects selection
o Axis
~; Form Union (fin) Show in physics: | Boundary selection
Color: | Mone &

Selections from plane geometry
[] Show in physics
Cumulative selection

Contribute to: | None - New
3 In the Settings window for Axis: -
Settings -t
Under Axis: e
- In the x minimum and y minimum ® Update G
fields, enter -0.01. Label:  Auis =
- In the x maximum and y maximum 6 NG
fields, enter 0.11. minimum: 0,01 "
Under Grid: xmaximum: 0.1 m
- Select the Manual Spacing check box. Y™™ %9 "
y maximum: 0.1 m
- In the x spacing and y spacing ficlds, P .
enter 5e-3. .
. > Grid
4 Click the Update button & on the _
Manual spacing
toolbar. -
xspacing:  5e-3 m
Note that the values you type will y spacing: 5e-3 m
al}tomatlcally adjust slightly after you . m [
click Update to adapt to the screen
Extra y: m k]

aspect ratio.
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You can use interactive drawing to create a geometry using the drawing tools from
the Sketch tab on the ribbon while pointing and clicking in the Graphics window.

B e > T A -

m Home Work Plane  Sketch  Developer  View 2

s - Snap to Grid| |’_| Solid| :_'_.-—I I:" !.."' 7 Quadratic ,:I @)
" " | |21 Snap to Geometry | '/, Construction 7 i = ;A Cubic ' S
Sketch - Polygon Circular Interpolation . Rectangle Circle

ﬂConstraln Arc - Curve - = Point 5
Sketch Draw Settings Draw

You can also right-click the Plane Geometry node . under Work Plane 1 = to add
geometry objects to the geometry sequence. Note that you can add geometry
objects in the same way from the Work Plane tab on the ribbon. For clarity, this
example will demonstrate the noninteractive way of creating the geometry (not

using the Sketch tab).

In the next few steps, we create a profile of the busbar.

5 In the Model Builder window under Work Plane |, right-click Plane Geometry

and select Rectangle = .

In the Settings window for Rectangle

under Size, enter: Settings
. . lectangle
- L+2*tbb in the Width field. B BuinSeIected ~ [E Build All E

- 0.1 in the Height ficld.
Click the Build Selected button g .

Label: Rectangle 1
¥ Object Type
Type: | Solid

¥ Size and Shape

6 Width:  L+2%tbb

Height: 0.1
¥ Position

Base: | Corner
pas 0

yw: 0
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6 Create a second rectangle. Under

Work Plane |, right-click Plane T
Geometry A and select Rectangle . ecang e a
d s ¥ Build Selected ~ [E§ Build All 2§
Under Size, enter:
. Label: Rectangle 2 =
- L+tbb in the Width field.
. . ¥ Object Type
- 0.1-tbb in the Height field. e e
Type: | Solid -
Under Position, enter: L
. - ~ Size and sh
- tbb in the yw field. ‘ Sool S
. . c Width:  L+tbb m
Click the Build Selected button & .
Height: 0.1-tbb m
Use the Boolean Difference operation ——
to subtract the second rectangle from -
the first one. Bose - e
KWL u m
7 Under Work Plane 1, right-click Plane tbb
W m

Geometry ¥ and sclect Booleans and

Partitions > Difference . In the

Graphics window, click r1 (the larger of the two rectangles) to add it to the
Objects to add list in the Settings window for Difference.

To help select the geometry, you can display geometry labels in the
Graphics window. In the Model Builder window under Geometry | >
WorkPlane 1, click the View 2 node. Go to the Settings window for View
and select the Show geometry labels check box.
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8 Click the Difference node. In the
Settings window for Difference, click the
Active selection button to the left of the

j i ¥ Build Selected ~ [ Build All &
Objects to subtract list. Select the uild selecte o

smaller rectangle, r2, by using the LabeEly| Difference 1 S
mouse scroll wheel or arrow keys to = B

cycle through the overlapping Objects to add:

rectangles to first highlight it and then = &
click on it to select it. 6 B= @ -
Click Build Selected = . &0
Another way to select r2 in the

Graphics window is to use the Selection 3

List feature. Go to the Home tab on the OBt D

ribbon and select Windows > Selection e H
List. In the Selection List, click to G ‘ -

highlight r2 (solid). Then, right-click
r2 (solid) in the list and select Add to
Objects to Subtract for Difference to add
it to the Objects to subtract list.
Right-click on the Selection List
window title and select Close.

After building the selected geometry, you should have a backward-facing,
L-shaped profile. Continue by rounding the corners of the L-shaped profile.

eaf- ¢l - @ @-@-BF «20- B3O 5-@8
‘ !
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9 Under Work Plane I, right-click Plane Geometry A and select Fillet .

Select point 3 (in the inner-right corner) to add it to the Vertices to fillet list.

There are different ways to add points:

- In the Graphics window, click point 3 to add it to the Vertices to fillet list.

- From the Home tab, sclect Windows > Selection List. In the Selection List
window, click 3. The corresponding point is highlighted in the Graphics
window. Click the Add to Active Selection for Fillet button -+ in the Settings
window for Fillet or right-click in the Selection List.

LA

ettings -1

® Build Selected = [E8 Build All &
Label:  Fillet 1 =]

T Poaints

Vertices to fillet:

e ‘ y diﬂ3 % u

= Radius

@ Radius: thb m

I0 Enter tbb in the Radius field. Click Build Selected & .

This creates a fillet at the inner corner.

206 |



Il For the outer corner, right-click _ _
Plane Geometry ¥ and select ettings )

Fillet 7. -
a [ Build Selected ~ [E8 Build All &8

LI B g

121n the Graphics window, click point

. . Fillet2 =
6, the outer corner, to add it to the Labet [Fllet =
Vertices to fillet list. ~ Points
I3 Enter 2*tbb in the Radius field. Click Vertices to fillet:
i - 4 fin B
Build Selected = . @ ‘ . oo
@

- Radius

G Radius:  2tbh] m
The result should match this figure:

Graphics <8
aa@r&@ b &y @ B o= 2@ T O G -@p
m o

0.17]

In the Design Module you will find tools available in the Sketch tab for
interactive drawing and dimensioning of fillets and general 2D sketches.

Next, extrude the work plane to create the 3D busbar geometry.
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I In the Model Builder window, right-click Work Plane | & and select Extrude =.
In the Settings window for Extrude, enter wbb in the Distances from Plane table
(replace the default) to extrude to the width of the profile.

+ Distances
Specify: Distances from plane =

13
Distances (m)

o -

\ -

The table allows you to enter several values in order to create sandwich

structures with different materials. In this case, only one extruded layer is
needed.

2 Click Build Selected = and then click the Zoom Extents [ button on the Graphics

toolbar. Click the Save button ©J and name the model busbar.mph (if you have
not already done so).

0.05 m

Next, create the titanium bolts by extruding two circles drawn in two work
planes.
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3 In the Model Builder window, right-click Geometry | 2 and add a Work Plane ..
A Work Plane 2 node is added. In the Settings window for Werk Plane, under
Plane Definition, sclect Face parallel as the Plane type.

Model Builder ~ #|| Settings v
- t = Ety Bl =~ \Wark Plane
4 & busbar.mph (root) E [ Build Selected = [E8 Build All Objects 2
4 () Global Definitions
Pi Parameters 1 Label: Work Plane 2 E
2 Materials e
4 [ Component 1 (comp ) * Plane Definition
b = Definitions G
Plane type: Face parallel =
- Geormnetry 1 P E
b 8 WorkPlane 1 (wp 1) Planar face:
L_,.!, Extrude 1 {ext?)
G 4 [[E] Work Plane 2 (wp2) ‘
Plane Geornetry
b=y View 3

4 In the Graphics window, click face 8, as shown in the figure below, to add it to
the Planar face list in the Settings window for Work Plane.

Face 8 is now highlighted in blue and the work plane is positioned on top of the
face.

‘ " 0.1

e
A | | ]
| 005 m

5 Click the Show Work Plane button & to start drawing the first circle representing
the position of the first bolt. Click the Zoom Extents button [ on the Graphics
toolbar.
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6 Under Work Plane 2, right-click
Plane Geometry . and sclect Circle

In the Settings window for Circle:

- Under Size and Shape, in the
Radius ficld, enter rad_1.

- Under Pesition, leave the default
xw and yw coordinates (0, 0).

Click Build Selected & .

Continue creating the bolt by adding an extrude operation.
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Label: Circle 1

¥ Object Type
Type: Solid

¥ Size and Shape
Radius: rad_1
Sectorangle: 360
¥ Position

Base: Center
w0

yw: 0
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I In the Model Builder window, right-click Work Plane 2 & and select Extrude =.
In the Settings window for Extrude, in the first row of the Distances from Plane
table, enter -2*tbb to extrude the circle.

Model Builder ¥ * | Settings v
-~ 1‘ ‘= Et - - Extrude
4 & busbar.mph (root) [ Build Selected = [E8 Build All Objects 2
4 () Global Definitions
P Parameters 1 Label: Extrude2 E
2 Materials
4 |§ Component1 (comp1) v General
’ Definitions Extrude from: Work plane =
4 4] Geometry 1
[ E Work Plane 1 {wp1) Work plane: Work Plane 2 (wp2] = E
L:"!' Extrude 1 {ext1) Input ohjects:
4 E Work Plane 2 {wp2)
- Plane Geornetry ‘ wp2 El
; O —
@ N
Extrude 2 (ext2)
4 Fo.rm Union {fin) Input cbject handling: Unite with =
2 Materials
[ +\_ Electric Currents {ec) ~ Distances
[» IIE) Heat Transfer in Solids (ht)
4 .{;3. Multiphysics Specify:  Distances from plane A
A5 Mesh 1 "
[~ Study 1 Distances (m)
b {El Results ~2'thb G

= % Elj M

2 Click the Build Selected button = to create the cylindrical part of the titanium
bolt that runs through the busbar.

Next, draw the two remaining bolts.
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3 Right-click Geometry | ¥ and select Work Plane =. A Work Plane 3 node is
added. In the Settings window for Work Plane, for Work Plane 3, sclect Face
parallel as the Plane type.

4 In the Graphics window, click face 4, as shown in the figure, to add it to the
Planar face list in the Settings window for Work Plane.

5 Click the Show Work Plane button £ on the Settings window for Work Plane and
the Zoom Extents button [ on the Graphics toolbar to get a better view of the
geometry.

To parameterize the position of the two remaining bolts, add the circles that
form the cross sections of the bolts.
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6 Under Work Plane 3, right-click Plane Geometry A and select Circle .

In the Settings window for Circle:

- Under Size and Shape, enter rad_1
in the Radius field.

- Under Position, enter
-L/2+1.5[cm] in the xw field and
-wbb/4 in the yw field.

Click Build Selected & .

Copy the circle that you just created
to generate the third bolt in the
busbar.

7 Under Work Plane 3, right-click Plane G
Geometry ¥ and sclect Transforms >

Copy (&

8 In the Graphics window, click the
circle ¢1 to select and add the circle
to the Input objects list in the
Settings window for Copy.

9 In the Settings window for Copy
under Displacement, enter wbb/2 in
the yw field.

©

W
e yw: whhb/2

Label: Circle 1
¥ Object Type
Type: | Solid
¥ Size and Shape

Radius: rad_1

Sectorangle: 360
¥ Position

Base: | Center
we -L/2+1.5[em]

yw:  -whb/4

Settings

¥ Build Selected ~ [E§ Build All 2§
Label: Copy1

¥ Input

Input chjects:

= -

Keep input objects
¥ Displacement

Specify: | Displacement vector

0

m L‘:rJ

m L‘:rJ
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10 Click Build Selected = and click the Zoom Extents button [] on the Graphics
toolbar.

Your geometry, as shown in the work plane, should match this figure so far.

L@~ CRCARE-RE K=}
| \ : . . . .
o |
0.03% I
0.0257] F
0.027] N
0.0157] F
0.017] N
0.0057] F
© . f
0.005 ] F
0.017] N
0.0157] F
0.02 N
0.0257] F
0.03 N
0.0357] F
0.05 ! 0.04 ! 0.03 ! 0.02 ! 0.01 ‘B ‘B.B] ‘B 02 ‘B 03 ‘B 04 ‘B 05 ‘B 06

Continue by extruding the circles.
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Il In the Model Builder window, right-click Work Plane 3 & and select Extrude =.
In the Settings window for Extrude, in the first row of the Distances from Plane

table, enter -2*tbb (replace the default). Click Build All Objects & .

Model Builder ~ *|| Settings v
== = Ev Bl E~ Extrude
4 & busbar.mph (root) [ Build Selected = [E8 Build All Objects 2
4 () Global Definitions
P; Parameters 1 Label: Extrude 3 E
i Materials
4 |§ Component1 (comp1) v General
b = Definitions Extrude from: Work plane -

- Geormnetry 1
[ E Work Plane 1 {wp1) Work plane: Work Plane 3 (wp3) ~ E
LC_\\‘D Extrude 1 {ext?)
I & Work Plane 2 {wp2)
LC_\\‘D Extrude 2 {ext3) E
4 2 Work Plane 3 (wp3)
- Plane Geornetry

Input ohjects:

Input cbject handling: Unite with =

¥ Distances

. Form Union (fin)

235 Materials Specify: Distances from plane i
[ +\_ Electric Currents {ec) "
I» I Heat Transfer in Solids (ht) Distances (m)

b . Multiphysics m [-Z'tbb |

The geometry and geometry sequence should match the figures below. Click

the Save button 7 and name the model busbar.mph.
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Creating Parts and Using the Part Libraries

After setting up the busbar or other geometry model, it is convenient to be able
to save it for future use, hence avoiding unnecessary work. In the steps you have
just completed, the geometry was stored directly in the COMSOL model file that
will also be used to set up the complete busbar model. Instead, you can also create
a reusable and parameterized part that can serve as a building block of a more
complex COMSOL model geometry, which is stored in a separate file accessible
through the Part Libraries.

While building the busbar geometry, you were using features from the Geometry
and Workplane tabs. A Parts menu is located in the Other group in these tabs.

@ [Tl Exctract @B

E Delete m o«

Conversions Parts |Programming Selections Colors
A Create Part | Other

&% Load Part
[fifi Part Libraries

Through the Parts menu, you can choose to create or load a part, or add a part to
the model geometry by selecting one from the Part Libraries. Several Part
Libraries are already provided with the software by default. When new parts are
created, they are added under a part’s parent node in the Global Definitions section
of the model tree. To add a part from a library, you can also right-click the
Geometry node and select Parts > Part Libraries.
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The figure below shows an Internal Helical Gear part from the part library of the
Multibody Dynamics Module. The part comes with 18 Input Parameters that
control the dimensions.

Untiedamph - COMSOL tiphycs - o x

i rotaton

For additional information on working with parts and the Part Libraries, see the
Reference Manual.

To continue with the busbar tutorial, return to the section “Materials” on
page 84.
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Appendix B— Keyboard and Mouse Shortcuts

These shortcuts are applicable to the Model Builder, Application Builder, Model
Manager, and the Graphics window.

KEYBOARD SHORTCUTS

SHORTCUT (WINDOWS, LINUX) SHORTCUT (MACOS) ACTION

FI (Fn+Fl on certain tablets) Fl Open the Help window if needed
and display context-sensitive help for
the selected node or window.

Ctri+FI Command+F| Open the COMSOL
Documentation front page in an
external window.

F2 F2 Rename the selected node, file, or
folder.

F3 F3 Disable selected nodes.

F4 F4 Enable selected nodes.

F5 F5 Update solution with respect to new

definitions without re-solving the
model. Update reduced model data.

Also, on Windows, to continue in
the Method Editor's debugging tool
in the Application Builder.

Fé Fé6 Build the preceding node in the
Geometry branch or plot the
previous plot for a time-dependent,
eigenfrequency, or eigenvalue
solution.

Also, on Windows, to step in the
Method Editor's debugging tool in
the Application Builder,
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

F7

F8

F9

Del

Escape (Esc)

Left arrow (Windows);

Shift+Left arrow (Linux)

Right arrow (Windows);
Shift+Right arrow (Linux)

Up arrow

Down arrow

F7

F8

Del

Escape (Esc)

Left arrow

Right arrow

Up arrow

Down arrow

Build the selected node in the
geometry and mesh branches,
compute the selected study step,
compute the selected node in the
solver sequence, or plot the next
plot for a time-dependent,
eigenfrequency, or eigenvalue
solution.

Also, on Windows, to step into in
the Method Editor's debugging tool
in the Application Builder.

Build the geometry, build the mesh,
compute the entire solver sequence,
update results data, update the plot,
or run a method or method call.
Also, on Windows, to create an
executable or an add-in in the
Application Builder.

On Windows, check syntax for a
method in the Application Builder.

Delete selected nodes, objects, or
rows in a table.

Cancel ongoing interactive 2D
drawing and 3D clipping operations.

Collapse a branch in the model tree.

Expand a branch in the model tree.

Move to the node above in the
Model Builder. Highlight the next
entity for a 3D geometry in the
Graphics window when it has focus.

Move to the node below in the
Model Builder. Highlight the previous
entity for a 3D geometry in the
Graphics window when it has focus.
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Alt+numbers

Alt+Left arrow

Alt+Right arrow

Ctri+A

Ctri+B

Ctrl+Shift+B

Ctr+C

Ctrl+D

Ctrl+Shift+D

Ctri+F
Ctr+G
Ctri+Shift+G
Ctri+K

Ctrl+L
Ctrl+N

See comment

Ctri+Left arrow

Ctrl+Right arrow

Command+A

Not available

Not available

Command+C

Command+D

Command+Shift+D

Command-+F
Command+G

Command+Shift+G

Command-+L

Command+N

For the Windows version only: run
the corresponding Quick Access
Toolbar command if a number is
pressed above the character
keyboard; otherwise, insert the
corresponding ASCII character
(requires use of the numeric keypad
on Windows). To enter special
ASCII characters on macOS, you
can change to a specific Unicode
Hex Input keyboard layout.

Move to the previously selected
node in the model tree.

Move to the next selected node in
the model tree.

Select all domains, boundaries,
edges, or points; Select all cells in a
table.

Enable and remove breakpoint, for
use in the Application Builder.

Enable and disable breakpoint, for
use in the Application Builder.

Copy text in fields. Copy images in
graphics and plot windows.

Clear the selection of all domains,
boundaries, edges, or points in the
Model Builder. Clear all selections in
Form Editor windows.

Duplicate the selected node in the
model tree.

Find a search string.
Group nodes.
Ungroup nodes.

Create, use, or rename a shortcut to
a model tree node (for use in the
Application Builder).

Take a quick image snapshot.

New model.
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Ctrl+0O

Ctr+Shift+O

Ctr+P

Ctrl+S
Ctrl+Shift+S

Ctrl+V
Ctrl+X
Ctrl+Y
Ctrl+Z
Ctri+ 1

Ctrl+7

Ctrl+Up arrow

Ctrl+Down arrow

Ctrl+Tab

Ctri+Shift+Tab

Ctrl+Shift+A

Ctri+Shift+]

Command+O

Command-+Shift+O

Command+P

Command+S

Command-+Shift+S

Command+V
Command+X
Ctri+Shift+Z

Command+Z

Command+Up arrow

Command+Down
arrow

Ctrl+Tab

Ctri+Shift+Tab

Open a model file from the file
system.

Open a model file from a Model
Manager database or file system.

Print the contents of the plot
window.

Save a model file to the file system.

Save a model file to a Model
Manager database or file system.

Paste copied text or object.

Cut copied text or object.

Redo the last undone operation.
Undo the last operation.

Create a local variable or correct the
type of an existing variable in
methods.

Toggle comments on and off in
methods.

Move a definitions node, geometry
node, physics node (except default
nodes), material node, mesh node,

study step node, or results node up
one step.

Move a definitions node, geometry
node, physics node (except default
nodes), material node, mesh node,
study step node, or results node
down one step.

Switch focus to the next window on
the desktop.

Switch focus to the previous
window on the desktop.

Switch to the Application Builder
workspace from the Model Builder
or Model Manager.

Switch to the Model Manager
workspace from the Model Builder
or Application Builder.
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Ctrl+Shift+M

Ctrl+Alt+Left arrow

Ctri+Alt+Right arrow

Ctri+Alt+Up arrow

Ctrl+Alt+Down arrow

Ctri+F4

Ctrl+F8
Ctrl+Alt+Left arrow

Ctri+Alt+Right arrow

Ctri+Alt+Up arrow

Ctrlt+Alt+Down arrow

Shift+F10 or
(Windows only) Menu key

Ctrl+Pause

Ctrl+Space or Ctri+/

R

+ or - keyboard button, or

Up arrow or Down arrow
button

Command+Alt+Left
arrow

Command+Alt+Right

arrow

Command+Alt+Up
arrow

Command+Alt+

Down arrow

Command+W

CommandtAlt+Left
arrow

Command+Alt+Right
arrow
Command+Alt+Up
arrow
Command+Alt+

Down arrow

Ctrl+F10

Command+.
(Command + period)

Ctrl+Space

R

+ or - keyboard
button, or

Up arrow or Down
arrow button

Switch to the Model Builder
workspace from the Application
Builder or Model Manager.

Switch focus to the Model Builder
window.

Switch focus to the Settings window.

Switch focus to the previous section
in the Settings window.

Switch focus to the next section in
the Settings window.

Close the active window in
COMSOL Desktop, if it is closable.

Test an application.

Switch focus to the Model Builder
window.

Switch focus to the Settings window.

Switch focus to the previous section
in the Settings window.

Switch focus to the next section in
the Settings window.

Open the context menu.

Stop running a method when test
running applications.

Open list of predefined quantities
for insertion in Expression fields.

Toggle between automatic and
manual rotation center for mouse
rotation in 3D.

Cycle between geometric entities in
3D (domains, boundaries, edges,
points) for selection when the focus
is in the Graphics window.
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

+, -

Multiply key
Divide key
Page Up or Page Down

+, -

Alt+Right arrow
Alt+Left arrow

Page Up or Page
Down

Highlight the next or previous entity
for a 3D geometry in the Graphics
window. Expand or collapse a
branch in the Model Builder.

Expand selected part of a tree.
Collapse selected part of a tree.

Move up or down in a window in
the COMSOL Desktop
environment.

MOUSE SHORTCUTS

SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Left-click and hold down the
mouse button while dragging
the mouse.

Right-click and hold down the
mouse button while dragging
the mouse.

Middle-click and hold down the
mouse button while dragging
the mouse.

Press Ctrl and use the scroll
wheel.

Middle-click and use the scroll
wheel.

Press Ctrl and left-click. While
holding down the key and
button, drag the mouse.

Press Ctrl and right-click. While
holding down the key and
button, drag the mouse.

Press Ctrl and middle-click.
While holding down the key
and button, drag the mouse.

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Rotate the scene around the axes
parallel to the screen’s x- and y-axes
with the origin at the scene rotation
point.

Move the visible frame on the image
plane in any direction (pan).

The scene is zoomed in/out around
the mouse position where the
action started.

The scene is zoomed in or out
around the mouse position where
the action started.

The scene is zoomed in/out around
the mouse position where the
action started with, but with
somewhat larger steps.

Tilt and pan the camera by rotating
about the x- and y-axes in the image
plane.

Move the camera in the plane
parallel to the image plane.

Move the camera into and away
from the object (dolly in or out).
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Press Ctrl and middle-click.

Press Ctrl+Alt and left-click.
While holding down the keys
and button, drag the mouse.

Press Alt and left-click. While
holding down the key and
button, drag the mouse.

Press Alt and right-click. While
holding down the key and
button, drag the mouse.

Press Alt and middle-click.
While holding down the key
and button, drag the mouse.

Middle-click on model.

Press X, Y, or Z and left-click.
While holding down the key
and button, drag the mouse.

R

+ or - keyboard button, or

Up arrow or Down arrow
button.

Same as for Windows

Same as for Windows

Same as for Windows.

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

+ or - keyboard
button, or

Up arrow or Down
arrow button

Zoom to the area around the point
on the model determined by the
mouse position.

Rotate the objects in the scene
around the camera look-at direction.

Rotate the objects in the scene
around the axis that intersects the
camera origin and the scene’s
rotation center (roll direction).

Move the scene in the plane
orthogonal to the axis between the
camera and the scene rotation
point.

Move the camera along the axis

between the camera and the scene
rotation point.

Set the center of rotation.

Rotate around the X, Y, or Z-axis,
respectively.

Toggle between manual and
automatic rotation center.

Cycle between 3D geometric
entities (domains, boundaries, edges,
points) for selection. When focus is
in the Graphics window.
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Appendix C — Language Elements and Reserved Names

Building a model tree in COMSOL Multiphysics is equivalent to graphically
programming a sequence of operations. Using the Record Code functionality in
the Application Builder or saving as a model file for MATLAB® or Java® records
and saves the sequence of operations as a list of traditional programming
statements. In this section, we will give an overview of the following element
categories as defined by the underlying COMSOL language:

¢ Constants
e Variables

e Functions
¢ Operators

» Expressions

These language elements are built in or user defined. Operators cannot be user
defined. Expressions are always user defined.

ABOUT RESERVED NAMES

Built-in elements have reserved names, names that cannot be redefined by the
user. If you try to use a reserved name for a user-defined variable, parameter, or
function, the text where you enter the name will turn orange and you will get a
tooltip error message if you select the text string. Reserved function names are
reserved only for function names, which means that such names can be used for
variable and parameter names and vice versa. In the following pages, we list the
most commonly used built-in elements and hence those reserved names. A more
exhaustive list of built-in elements can be found in the Programming Reference
Manual and the Application Programming Guide.

VARIABLES USED IN APPLICATIONS

Model parameters and variables can be used in applications. For example, you can
let the user of an application change the value of'a parameter. In addition, variables
to be used in applications can be defined in the Application Builder under the
Declarations node. Such variables are available globally in form objects and
methods but cannot be used in the Model Builder.
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Constants and Parameters

There are three different types of constants accessible from the Model Builder:
built-in mathematical and numerical constants, built-in physical constants, and
parameters. Parameters are user-defined constants, which can vary over parameter
sweeps. Constants are scalar valued. The tables below list the built-in
mathematical and numerical constants as well as built-in physical constants.
Constants and parameters can have units.

BUILT-IN MATHEMATICAL AND NUMERICAL CONSTANTS

DESCRIPTION NAME VALUE

Floating-point relative accuracy for double eps 22 (~2.2204-1 0! 6)

floating-point numbers, also known as

machine epsilon

The imaginary unit i, ] i,sqrt(-1)

Infinity, oo inf, Inf A value larger than what
can be handled with
floating-point
representation

Not-a-number NaN, nan An undefined or
unrepresentable value,
such as the result of 0/0
or inf/inf

T pi 3.141592653589793
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BUILT-IN PHYSICAL CONSTANTS

DESCRIPTION NAME VALUE

Acceleration of gravity g_const 9.80665[m/s"2]

Avogadro constant N_A const 6.02214076e€23[1/mol]
Boltzmann constant k_B_const 1.380649¢e-23[J /K]
Characteristic impedance  Z0_const 376.73031346177066[ ohm]
of vacuum (impedance of

free space)

Electron mass me_const 9.10938291e-31[kg]
Elementary charge e_const 1.602176634e-19[C]
Faraday constant F_const 96485.3365[C/mol]

Fine-structure constant
Gravitational constant

Molar volume of ideal gas
(at 273.15 Kand | atm)

Neutron mass

Permeability of vacuum
(magnetic constant)

Permittivity of vacuum
(electric constant)

Planck’s constant

Planck’s constant over 2 pi
Proton mass

Speed of light in vacuum

Stefan—Boltzmann
constant

Universal gas constant

Wien'’s displacement law
constant

alpha_const
G_const

V_m_const

mn_const

mu0_const

epsilon0_const

h_const
hbar_const
mp_const
c_const

sigma_const

R_const

b_const

7.29735298e-3
6.67384e-11[m"3/ (kg*s~2)1]
2.2413968e-2[m"3/mol]

1.674927351e-27[kg]

2*alpha_const*h_const/c_const/
e_const/e_const

1/mu0_const/c_const/c_const

6.62607015e-34[J*s]
1.05457172533629e-34[J*s]
1.672621777e-27[kg]
299792458[m/s]
5.670373e-8[W/ (M 2*K"4)]

8.3144621[J/ (mol*K) ]
2.8977721e-3[m*K]

PARAMETERS

Parameters are user-defined constant scalars in the Global Definitions branch in the
model tree. Example uses are:

o Parameterizing geometric dimensions

+ Parameterizing mesh element sizes
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* Defining parameters to be used in parametric sweeps

A parameter can be defined as an expression in terms of numbers, parameters,
built-in constants, and built-in functions of parameters and built-in constants.
Parameters should be assigned a unit, using [ ], unless they are dimensionless.

Variables

There are two types of variables used in the Model Builder: built-in and
user-defined. Variables can be scalars or fields. Variables can have units.

Note: Spatial coordinate variables and dependent variables are user-defined
variables of special interest. These variables have default names based on the space
dimension of the geometry and the physics interface, respectively. As a result of
the names chosen for these variables, a list of built-in variables will be created by
COMSOL Multiphysics: the first- and second-order derivatives with respect to
space and time. The following table contains some of the most important built-in
variables. For a complete list, see the Reference Manual.

228 |



BUILT-IN VARIABLES

NAME
curv

curvi,curv2

dom

dvol

freq

geomapproxdist

hinscribed
lambda

linearizedelem

numberofdofs

meshelement
meshelementall

meshtype

meshvol

nx,ny,nz,dnx,dny,dnz,un

X,uny,unz

phase

DESCRIPTION
The curvature of a boundary in 2D

The principal curvature components of a
boundary in 3D

The domain number for a domain, boundary,
edge, or point

Volume scale factor variable; This is the
determinant of the Jacobian matrix for the
mapping from local (element) coordinates to
global coordinates.

Frequency

For each element, this variable indicates how far a
node point in each element was moved from the
geometry.

Mesh element size (length of the longest edge of
the element)

Element inscribed diameter

Eigenvalue

Elements forced to be linear

Number of degrees of freedom

Mesh element number, per type
Mesh element number

Mesh type index for the mesh element; This is the
number of edges in the element.

Volume of the (linearized) element

Normal components for the boundary surface
normal vector. Down and up normal components
in the x-direction are dnx and unx, respectively,
and similarly for the y- and z-directions.

Phase angle

Field
Field

Field

Field

Global
variable

Field

Field

Field

Global
variable

Field

Global
variable

Field
Field
Field

Field
Field

Global
variable
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qual, qualcondition, Mesh quality measures Field
qualcurvedskewness,
qualgrowth,
qualmaxangle,
qualskewness,
qualvollength
realdetjac The determinant of the Jacobian matrix for the Field
mapping from a straight mesh element to the
possibly curved element used when solving. Use
this variable to measure the difference in shape
between a curved element and the
corresponding straight element.
realdetjacmin A scalar field variable for each element defined as  Field
the minimum value of the reldetjac variable
for the corresponding element.
A reldetjacmin value less than zero for an
element means that the element is wrapped
inside-out; that is, the element is an inverted
mesh element.
s,s1,s2 Curve and surface parameterization variables Field
t Time Global
variable
tcurvx, tcurvy,tcurvix, Tangential directions for the corresponding Field
curvly,teurviz,tourvax, curvature variables
tcurv2y,tcurv2z
tx,ty,tix,t1y,t1z, Tangent vector components correspondingto the  Field
t2x,t2y,t2z curve and surface parameterizations
qual A mesh quality measure between O (poor quality)  Field
and | (perfect quality)
USER-DEFINED VARIABLES THAT GENERATE BUILT-IN VARIABLES
DEFAULT NAME DESCRIPTION TYPE
Xy, ¥, Z Spatial coordinates (Cartesian) Field
r, phi, z Spatial coordinates (Cylindrical) Field
u, T, etc. Dependent variables (Solution) Field

Example: T is the name for the temperature in a 2D, time-dependent heat transfer
model; x and y are the spatial coordinate names. In this case, the following built-in
variables will be generated: T, Tx, Ty, Txx, Txy, Tyx, Tyy, Tt, Txt, Tyt, Txxt, Txyt,
Tyxt, Tyyt, Ttt, Txtt, Tytt, Txxtt, Txytt, Tyxtt, and Tyytt. Here, Tx
corresponds to the partial derivative of the temperature T with respect to x, Ttt
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corresponds to the second-order time derivative of T, and so on. If the spatial
coordinate variables have other names — for example, psi and chi — then Txy
would be Tpsichi, and Txt would be Tpsit. (The time variable t is built in; the
user cannot change its name.)

Functions

In the Model Builder, there are two types of functions: built-in and user-defined.
Functions can be scalar valued or field valued depending on the input
argument(s). Some functions can have units for both input and output arguments.

BUILT-IN MATHEMATICAL FUNCTIONS

These functions do not have units for their input or output arguments.

NAME DESCRIPTION SYNTAX EXAMPLE
abs Absolute value abs(x)

acos Inverse cosine (in radians) acos(x)
acosh Inverse hyperbolic cosine acosh(x)
acot Inverse cotangent (in radians) acot(x)
acoth Inverse hyperbolic cotangent acoth(x)
acsc Inverse cosecant (in radians) acsc(x)
acsch Inverse hyperbolic cosecant acsch(x)

arg Phase angle (in radians) arg(x)

asec Inverse secant (in radians) asec(x)
asech Inverse hyperbolic secant asech(x)
asin Inverse sine (in radians) asin(x)
asinh Inverse hyperbolic sine asinh(x)
atan Inverse tangent (in radians) atan(x)
atan2 Four-quadrant inverse tangent (in radians) ~ atan2(y,x)
atanh Inverse hyperbolic tangent atanh(x)
besselj Bessel function of the first kind besselj(a,x)
bessely Bessel function of the second kind bessely(a,x)
besseli Modified Bessel function of the first kind besseli(a,x)
besselk Modified Bessel function of the second kind  besselk(a,x)
binomial Binomial coefficients binomial(n,k)
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NAME

DESCRIPTION

SYNTAX EXAMPLE

ceil
conj

cos

cosh

cot

coth

csc

csch

erf
erfinv
exp
factorial
floor
gamma
gcd

imag

lcm
legendre
legendre
log
log10
log2

max

min

mod

poweps

psi

random
randomnormal
range

real

Nearest following integer
Complex conjugate

Cosine

Hyperbolic cosine
Cotangent

Hyperbolic cotangent
Cosecant

Hyperbolic cosecant

Error function
Inverse error function
Exponentia
Factorial of nonnegative integer
Nearest previous integer
Gamma function

Greatest common divisor
Imaginary part

Least common multiple
Legendre polynomials
Associated Legendre functions
Natural logarithm

Base-10 logarithm

Base-2 logarithm

Maximum of two arguments
Minimum of two arguments
Modulo operator

Power for use with derivatives of

expressions that need to be evaluated near

Zero

Psi function and its derivatives

Random function, uniform distribution

Random function, normal distribution

Create a range of numbers

Real part

ceil(x)
conj(x)
cos(x)
cosh(x)
cot(x)
coth(x)
csc(x)
csch(x)
erf(x)
erfinv(x)
exp(x)
factorial(n)
floor(x)
gamma(x)
gcd(a,b)
imag(u)
lcm(a,b)
legendre(1,x)
legendre(1l,m,x)
log(x)
log10(x)
log2(x)
max(a,b)
min(a,b)
mod(a,b)

poweps(x,n)

psi(x,k)

random(X,y,...)

randomnormal (X,y, ...

range(a,step,b)

real(u)
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NAME DESCRIPTION SYNTAX EXAMPLE
round Round to closest integer round(x), round(x,p)
sec Secant sec(x)
sech Hyperbolic secant sech(x)
sign Signum function sign(u)
sin Sine sin(x)
sinh Hyperbolic sine sinh(x)
sphericaly Spherical harmonic function sphericaly(1,m,theta,phi)
sphericalyr Real spherical harmonic function sphericalyr(1l,m,theta,phi)
sqrt Square root sqrt(x)
sqrteps Square root for use with expressions that ~ sqrteps(x)
need to be evaluated near zero
tan Tangent tan(x)
tanh Hyperbolic tangent tanh(x)
zernike Zernike polynomials zernike(n,m,r,phi)

BUILT-IN OPERATOR FUNCTIONS

These built-in functions behave differently than the built-in mathematical
functions. They may not belong in an introductory text but are listed to complete
the list of reserved names. For more information, see the Reference Manual.

NAME NAME NAME NAME

adj depends isinf sphavg

at dest linsol sphint
atlocal dflux lintotal stddev
atonly diskavg lintotalavg subst

ato diskint lintotalpeak substval
ati down lintotalrms sum

at2 dtang linzero test

at3 elemavg mean timeavg
atentO elemgpmax nif timeint
atent1 elemgpmin nojac timemax
atent2 elemint noenv timemin
atent3 emetric novar treatasconst
attimemax env noxd try_catch
attimemin error pd uflux
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NAME NAME NAME NAME

atxd frame.dt ppr up
atxdo fsens pprint var
atxdil fsensimag prev with
atxd2 gpeval reacf withparam
atxd3 if realdot withsol
ballavg integrate residual

ballint isdefined scope.atenti

bdf islinear scope.ati

bndenv isnan sens

centroid jacdepends setconst

circavg laginterp setind

circint lindev setval

circumcenter linper shapeorder

d linpoint side

USER-DEFINED FUNCTIONS

A user-defined function can be defined in the model tree under the Global
Definitions node or, for each Component, under the Definitions node. Select a
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template from the Functions menu and enter settings to define the name and

detailed shape of the function.

TEMPLATE NAME ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Analytic The function name is its identifier;
for example, ant.
The function is a mathematical
expression of its arguments.
Example: Given the arguments X
and vy, its definition is
sin(x)*cos(y).
The function has an arbitrary
number of arguments.

Interpolation The function name s its identifier;
for example, int1.
An interpolation function is defined
by a table or file containing the
values of the function in discrete
points.

The file formats are the following:
spreadsheet, grid, or sectionwise.
The function has one to three
arguments.

Piecewise The function name is its identifier;
for example, pw1.
A piecewise function is created by
splicing together several functions,
each defined on one interval. Define
the argument, extrapolation and
smoothing methods, and the
functions and their intervals.

This function has one argument with
different definitions on different
intervals, which must not overlap or
have any holes between them.

The name of the function with
comma-separated arguments within
parentheses. For example:

ani(x,y)

The name of the function with
comma-separated arguments within
parentheses. For example:

int1(x,y,2)

The name of the function with a
single argument within parentheses.
For example:

pw1(x)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Gaussian Pulse

Ramp

Rectangle

Step

Triangle

The function name is its identifier;
for example, gp1.
The Gaussian pulse function defines
a bell-shaped curve according to the
expression
—(a-xy)”
1 20°
e
oA2T

y(x)=

It is defined by the mean parameter,
Xq, and the standard deviation, ©.

The function has one argument.

The function name is its identifier;
for example, rm1.

A ramp function is a linear increase
with a user-defined slope that begins
at some specified time.

The function has one argument. It
can also be smoothed.

The function name is its identifier;
for example, rect1.

A rectangle function is 1 in an
interval and O everywhere else.

The function has one argument.

The function name is its identifier;
for example, step1.

A step function is a sharp transition
from 0 to some other value
(amplitude) at some location.

The function has one argument. It
can also be smoothed.

The function name is its identifier;
for example, trif.

A triangle function is a linear
increase and linear decline within an
interval and 0 everywhere else.
The function has one argument. It
can also be smoothed.

The name of the function with a
single argument within parentheses.
For example:

gp1(x)

The name of the function with a
single argument within parentheses.
For example:

rm1 (x)

The name of the function with a
single argument within parentheses.
For example:

rect1(x)

The name of the function with a
single argument within parentheses.
For example:

step1(x)

The name of the function with a
single argument within parentheses.
For example:

tri1(x)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Waveform

Normal
Distribution

Random

External (Global
Definitions only)

The function name is its identifier;
for example, wv1.

A waveform function is a periodic
function with one of several
characteristic shapes: sawtooth, sine,
square, or triangle.

The function has one argument. It
can also be smoothed.

The function name is its identifier;
for example, nd1.

Defines the probability density
function, cumulative distribution
function, and quantile function for a
normal distribution.

The function name is its identifier;
for example, rnt.

A random function generates white
noise with uniform or normal
distribution and has one or more
arguments for simulating white
noise.

The function has arbitrary number
of arguments.

An external function defines an
interface to one or more functions
written in the C language (which
can be a wrapper function
interfacing source code written in,
for example, Fortran). Such an
external function can be used, for
example, to interface a user-created
shared library. Note that the
extension of a shared library file
depends on the platform: .dll
(Windows), .so (Linux), or .dylib
(macOs).

The name of the function with a
single argument within parentheses.
For example:

wv1(X)

The name of the function with a
single argument within parentheses.
For example:

nd1(x), nd1_cum(x), and
nd1_cum_inv(x)

The name of the function with
comma-separated arguments within
parentheses. For example:
rn1(x,y)

The arguments x and y are used as
random seeds for the random
function.

The name of the function and the
appropriate number of arguments
within parentheses. For example:
myextfunc(a,b)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

MATLAB®
(Global
Definitions only)

Elevation

Image

Least-Squares Fit

A MATLAB® function interfaces
with one or more functions written
in the MATLAB® language. Such
functions can be used as any other
function defined in COMSOL
Multiphysics®, provided that
LiveLink™ for MATLAB® and
MATLAB® are installed. (MATLAB®
functions are evaluated by
MATLAB® at runtime.)

The function name is its identifier,
for example, elev1.

Used to import geospatial elevation
data from digital elevation models
and map the elevation data to a
function of x and y. A DEM file
contains elevation data for a portion
of the Earth’s surface. The resulting
function behaves essentially like a
grid-based interpolation function.

The function name is its identifier,
for example, im1.

Used to import an image (in BMP,
JPEG, PNG, or GIF format) and map
the image's RGB data to a scalar
(single-channel) function output
value. By default, the function’s
output uses the mapping
(R+G+B)/3.

The function name is its identifier,
for example, 1sq1_fun1.

Used for least-squares function
approximation. Defines a
least-squares fit of one or more
parameterized functions with
respect to the input data. The input
data can be a file, a local table, or a
results table.

The name of the function and the
appropriate number of arguments
within parentheses. For example:
mymatlabfunc(a,b)

The name of the function with
comma-separated arguments within
parentheses. For example:

elevi(x,y)

The name of the function with
comma-separated arguments within
parentheses. For example:

imt(x,y)

The name of the function with
comma-separated arguments within
parentheses. For example:
1sg1_funt(x1,x2)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Gaussian Process

Function Switch

The function name is its identifier,
for example, gpm1.

Used for multidimensional
interpolation. Defines one or more
functions trained on input data
through a Gaussian process
regression method. The input data
can be a file or a result table.

Note: Training a Gaussian
Process function requires the
Uncertainty Quantification Module.
Using a model that already contains
a trained Gaussian Process
function does not require any
add-on products.

The function name is its identifier,
for example, sw1.

A switch is used to switch between
global functions during a solver
sweep. You add the functions as
subnodes under the Switch node.
The switch for functions acts
essentially as a switch statement in a
programming language; that is, it
dynamically chooses one of its
underlying branches depending on a
parameter that can be controlled
from the solvers using a Function
Sweep study. You can also add a
Switch node under Materials and
then use a Material Sweep to
sweep over a discrete set of
materials.

The name of the function with
comma-separated arguments within
parentheses. For example:

gpm1 (x1,x2)

Switch is a container node for
functions.
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Unary and Binary Operators

In the Model Builder, the following table contains the unary and binary operators
that can be used in expressions.

PRECEDENCE LEVEL SYMBOL DESCRIPTION

| O {3} . Grouping, Lists, Scope

2 ~ Power

3 I -+ Unary: Logical NOT, Minus, Plus

4 [1] Unit

5 * |/ Multiplication, Division

6 + - Binary: Addition, Subtraction

7 < <= > >= Comparisons: Less-Than, Less-Than or
Equal, More-Than, More-Than or Equal

8 == I= Comparisons: Equal, Not Equal

9 && Logical AND

10 || Logical OR

[ , Element Separator in Lists

Expressions

PARAMETERS

A parameter expression can contain: numbers, parameters, built-in constants,
built-in functions of parameter expressions, and unary and binary operators.
Parameters can have units.

VARIABLES

A variable expression can contain: numbers, parameters, constants, variables,
functions of variable expressions, and unary and binary operators. Variables can
have units.

FUNCTIONS

A function definition can contain: input arguments, numbers, parameters,
constants, functions of parameter expressions, including input arguments, unary
and binary operators.
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Appendix D — File Formats

COMSOL File Formats

The COMSOL Model MPH-file type, with the extension .mph, is the default file
type containing the entire model tree and application tree from the Model Builder
and Application Builder, respectively. The file contains both binary and text data.
The mesh and solution data is stored as binary data, while all other information is
stored as plain text.

The COMSOL binary and text file types, with the extension .mphbin and
.mphtxt, respectively, contain either geometry objects or mesh objects that can be
imported directly to the Geometry or Mesh nodes in the model tree. Note that if
the CAD Import Module, Design Module, or one of the LiveLink™ add-on
products for CAD was used to create a geometry model, then the same product
may be required to open the corresponding file. This is because the geometry
model may require features that are only available in one of the add-on products.

The Physics Builder file type, with the extension .mphphb, contains one or more
user-defined physics interfaces that you can access from the Model Builder. See the
Physics Builder Manual for more information.

See Supported External File Formats for more information about all the other
formats supported by COMSOL Multiphysics.

FILE TYPE EXTENSION READ WRITE
COMSOL Model and Application .mph Yes Yes
COMSOL Binary Data .mphbin Yes Yes
Physics Builder .mphphb Yes Yes
COMSOL Text Data .mphtxt Yes Yes

Supported External File Formats

CAD

The CAD Import Module and Design Module allow for the import of a range of
industry-standard CAD file types. Additional file types are available through the
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bidirectional functionality of the LiveLink products for CAD as well as with the
File Import for CATIA® V5 add-on.
The DXF (2D), VRML (3D), STL (3D), PLY (3D), and 3MF (3D) file types are
available for import with COMSOL Multiphysics and do not require any add-on
products. Unless noted otherwise in the table below, import of the listed file types

is available on all supported versions of Linux

®

, macOS, and Windows® operating

systems.

FILE TYPE EXTENSION READ  WRITE
AutoCAD® 23 .dwg Yes Yes’
|r1ventor®| 2.3 .ipt,.iam Yes Yes9
Nx®! 4 .prt Yes  No
PTC® Creo® Parametric™ |3 prt,.asm Yes Yes’
PTC® Pro/ENGINEER® 3 .prt, .asm Yes  Yes
Revit® 3 .rvt Yes”  Yes’
Solid Edge®>® .par, .asm Yes”  Yes’
SOLIDWORKS®! 23 .sldprt, .sldasm Yes  Yes’
DXF 3D and 2D) .dxf Yes  Yes!O
Parasolid®I x_t,.xmt_txt,.x_b,.xmt_bin Yes Yes
ACIS®! .sat,.sab, .asat,.asab Yes Yes
STEPI .step, .stp Yes Yes
IGES! .iges, .igs Yes  Yes
CATIA® v527 .CATPart, .CATProduct Yes  No
VRML, v|8 .vrml, .wrl Yes No
STL .stl Yes Yes
3MF .3mf Yes No
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FILE TYPE EXTENSION READ WRITE

PLY .ply Yes No

|Requires one of the LiveLink™ products for AutoCAD®, Revit®, PTC® Creo® Parametric™,
Inventor® PTC® Pro/ENGINEER®, Solid Edge®, SOLIDWORKS®, the CAD Import Module, or
the Design Module

2Impor“t supported on Windows® operating systems only

3Synchronization of files between COMSOL Multiphysics and a linked CAD program supported
on Windows® 7, 8, 8.1, and 10 operating systems only

4Impor“t supported on Windows® and Linux operating systems only

5Requires LiveLink™ for Revit®

6Requires LiveLink™ for Solid Edge®

7Requires the CAD Import Module (or the Design Module or one of the LiveLink™ products
for AutoCAD®, PTC® Creo® Parametric™, Inventor®, PTC Pro/ENGINEER®, Solid Edge®, or
SOLIDWORKS®) and the File Import for CATIA® V5

8 imited to a single geometric domain

IFrom/To file using linked CAD package, provided the original CAD geometry is created in the
CAD package

IO\/\/riting to file is supported for 2D geometry only

ECAD

The ECAD Import Module allows for import of 2D layout files with automatic
conversion to 3D CAD models. The Touchstone file type is used for exporting
S-parameters, impedance, and admittance values from simultaneous port and
frequency sweeps. The SPICE Circuit Netlist file type is converted at import to a
series of lumped circuit element nodes under an Electrical Circuit node.

FILE TYPE EXTENSION READ  WRITE
IPC-2581 .cvg, .xml Yes  No
ODB++ .zip,.tar,.tgz,.tar.gz Yes No
GDS! .gds Yes No
Touchstone? .s2p, .s3p,.s4p, ... No Yes
SPICE Circuit Netlist® .cir Yes  Yes

|Requires the ECAD Import Module
2Requires either the AC/DC Module, RF Module, MEMS Module, or Wave Optics Module

3Requires either the AC/DC Module, RF Module, MEMS Module, Plasma Module, or
Semiconductor Module
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MATERIAL DATABASES

From the Materials node, in the model tree, you can import material data on the
MPH-file format as well as on a COMSOL-native XML format. You can also
export material data on the COMSOL-native XML format. When importing
material data from an MPH-file, only the material contents of the file are
considered. For exporting material data on the MPH-file format, you simply save
the MPH-file using the options on the File menu.

The Chemical Reaction Engineering Module and the Plasma Module can read
CHEMKIN® files for simulating complex chemical reactions in the gas phase. The
Plasma Module can read LXCAT files for sets of electron-impact collision cross
sections. The Metal Processing Module import material properties from the
software ]MatPr0®.

FILE TYPE EXTENSION READ WRITE
COMSOL Model and Application .mph Yes Yes
COMSOL Model XML .xml Yes Yes
CHEMKIN®! .dat, .txt, .inp’ Yes  No
CAPE-OPEN! (direct connection) n/a n/a n/a
LXCAT file? .1xcat, . txt Yes  No
Jl\/la‘[Pro®4 .xml Yes No

|Requires the Chemical Reaction Engineering Module or the Plasma Module. The Plasma
Module only supports thermodynamic and transport data.

2Requires the Plasma Module.
3Any extension is allowed: these are the most common extensions.
4Requires the Metal Processing Module.

MESH

The NASTRAN® Bulk Data file types are used to import a volumetric mesh. The
VRML, STL, PLY, and 3MEF file types are used to import a triangular surface mesh
that can serve as a starting point for creating a volumetric mesh.

FILE TYPE EXTENSION READ  WRITE
3MF .3mf Yes Yes
NASTRAN® Bulk Data .nas, .bdf,.nastran,.dat  Yes  Yes
PLY .ply Yes Yes
COMSOL Sectionwise .txt,.csv,.dat Yes Yes
STL .stl Yes Yes
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FILE TYPE EXTENSION READ WRITE

VRML, v .vrml, .wrl Yes No
VTK .vtu No Yes

IMAGES AND MOVIES

Results visualization can be exported to a number of common image file types; See
the table below. Images can also be read and used as interpolation functions for
physics modeling. Animations can be exported to one of the Animated GIF, AVI,
and WebM file types.

FILE TYPE EXTENSION READ  WRITE
Animated GIF .gif No Yes
AV .avi No  Yes
BMP .bmp Yes Yes
EPS (1D graphs only) .eps No Yes
GIF .gif Yes Yes
gITF™ .glb No Yes
JPEG -1Pg, - jpeg Yes  Yes
MP42 .mp4 Yes  No
oGV? .ogV Yes  No
PNG .png Yes Yes
TIFF Ltif, L tiff No Yes
WEBM .webm Yes No

| Available for Windows® only
2Available in the Application Builder, for Windows® only, in the video form object

PROGRAMMING LANGUAGES AND SPREADSHEET

Model files for ]ava® are editable files with the extension . java that contain
sequences of COMSOL commands as Java® code. Edit the files in a text editor to
add additional commands. You can compile these ]ava® files into ]ava® Class files
with the extension .class and run them as separate applications. Program code
used in model files for Java® is essentially identical to that of the Method Editor
in the Application Builder. However, the Method Editor comes with an integrated
Java® compiler.

Model files for MATLAB® are editable script files (M-files), similar to the model
files for Java®, for use with MATLAB®. These model files, which have the
extension .m, contain a sequence of COMSOL commands as a MATLAB® M-file.
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You can run the model files in MATLAB® like any other M-file scripts. It is also
possible to edit the files in a text editor to include additional COMSOL
commands or general MATLAB® commands. Running model files in the M-file
format requires LiveLink™ for MATLAB®.

With a license for LiveLink™ for Excel®, you can save models on the Visual Basic
for Applications (VBA) format for use with Excel®.

Compiled C-code can be linked with a model or application in several ways
including the External Material and External Function interfaces in the Model
Builder and as the External Library interface in the Application Builder.

FILE TYPE EXTENSION READ WRITE
MATLAB®: Model file for MATLAB® .m No Yes
MATLAB®: Function' .m Yes No
Java®: Archive file . ar‘(’ Yes No
Java®: Compiled model file forJava® .class Yes No
Java®: Model file forJava® .java No Yes
C: Function .d113,. so4,.dylib5 Yes No
Fortran: Function .d113,. so? Yes No
Excel®? .x1sx,.vba Yes Yes

|Requires LiveLink™ for MATLAB®

2Requires LiveLink™ for Excel®, available for Windows® only

3Available for Windows® only

“4Available for Linux® only

>Available for macOS only

éCan be linked to a method in an application using the Application Builder

7Requires a C-wrapper to the Fortran code and to include the C-code DLL as an External C
Library in the Application Builder. Alternatively, you can include a Fortran DLL directly as an
External C Library in the Application Builder. Note: You need to consider the naming
convention for exported Fortran function names. For example, in Windows®, it is typically
required that Fortran function names are in uppercase.

NUMERICAL AND INTERPOLATION DATA FORMATS

The grid, sectionwise, and spreadsheet file types can be read for defining
interpolation functions. Furthermore, the sectionwise and spreadsheet file types
can be read and used for defining interpolation curves and written for exporting
results. In addition, tables can be copied and pasted on the spreadsheet format.

Parameters and variables can be imported and exported to the plain text,
comma-separated values, or data file types.
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The continuous and discrete color table text file types are used for user-defined

color tables for results visualization.

Digital elevation model (DEM) files can be read and used as a parametric surface

for defining a geometry.

FILE TYPE EXTENSION READ WRITE
Copy and paste spreadsheet format n/a Yes Yes
Excel® spreadsheetl .x1sx Yes Yes
Table .txt,.csv,.dat Yes Yes
Grid Ltxt Yes Yes
Sectionwise .txt,.csv,.dat Yes Yes
Spreadsheet .txt,.csv,.dat Yes Yes
Parameters .txt,.csv,.dat Yes Yes
Variables .txt,.csv,.dat Yes Yes
Continuous and Discrete color table Ltxt Yes No
Point data for Cut Point datasets Ltxt Yes No
DEM .dem Yes No
VTK .vtu No Yes

! Requires LiveLink™ for Excel®, available for Windows® only
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Appendix E— Connecting with LiveLink™ Add-Ons

The following table shows the options to start COMSOL and the different linked
partner software using the LiveLink™ add-on products.

COMSOL® Can Start COMSOL Can Start Partner Software Can Connect
Software from Partner Software  from COMSOL Running Sessions
LiveLink™ Yes! Yes? No
for Excel®

LiveLink™ Yes® Yes® Yes®
for MATLAB®

LiveLink™ No Yes® No
for Simulink®

LiveLink™ No No Yes
for AutoCad®

LiveLink™ No No Yes
for Revit®

LiveLink™ No No Yes
for PTC®Creo®

Parametric™

LiveLink™

for Inventor®

- Bidirectional No No Yes
Mode

- One Window Yes No No
Mode

LiveLink™ No No Yes
for PTC®

Pro/ENGINEER®

LiveLink™ No No Yes
for Solid Edge®

LiveLink™

for SOLIDWORKS®

- Bidirectional No No Yes
Mode

- One Window Yes No No
Mode

'"When you open a model from E><ce|®, a model window starts and a link is established
automatically. The model window is an output window that displays geometry, mesh, and results.
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2A model that includes a table reference to an Excel® spreadsheet automatically starts an Excel®
process in the background when the model is run in the COMSOL Desktop environment.

3You can start a COMSOL Multiphysics server from a MATLAB® session using the system
command and then connect to it using mphstart in the MATLAB® command prompt.

*The cOMSOL Multlphysms with MATLAB® desktop shortcut starts a COMSOL Muttiphysics
server and MATLAB® , then connects them automatically. When you run a COMSOL Multiphysics
model in the COMSOL Desktop interface that includes a MATLAB® function (Global Definitions
> Functions), a MATLAB® engine and connection is started automatically.

>You can connect a MATLAB® seSS|on to a running COMSOL Multiphysics server using the
command mphstart in the MATLAB® command prompt.

The COMSOL Mul‘uphysms with Simulink® desktop shortcut starts a COMSOL Multiphysics
server and MATLAB® , then connects them automatically. You can then start Simulink® and add a
COMSOL Cosimulation block where you load a cosimulation file to run a cosimulation.

| 249



250 |



AC/DC Module 73, 96
accuracy
convergence analysis 63
Add Material window
busbar model 84
opening 44, 84
Add Multiphysics
button 97
window 97
add-in 119
add-on modules
AC/DC Module 73, 94, 96
Application Libraries 33
CAD Import Module 201, 241
Chemical Reaction Engineering Mod-
ule 244
Design Module 201, 207, 241
ECAD Import Module 243
MEMS Module 137
physics list 40, 75
Plasma Module 244
Structural Mechanics Module 38, 49
study types 76
advanced topics 128
all combinations
parametric sweep 6/
analysis
convergence 63
example, parametric sweep 68
animation 24, 171
application 13, 109
Application Builder 6,8, 11, 13,31, 110,
225
Application Gallery 35
Application Libraries |7

examples 33

file types 34
MPH-files 10, 33
window 35
Application Library update 35
autocompletion
parameter and variable names 68
parameters and variables 78

average temperature /63

Basic template /21
Blank form template /22
blank model, creating /8, 20
boundaries 93
adding to selection 95
variables scope 3/
boundary condition 90
automatically defined 49
boundary load 48
busbar, setting 90
electric current 90, 94
fixed constraint 47
free 46
ground, electrical 96
heat transfer 90
insulating 93
material interface 49
settings window 8
boundary load 48
boundary number, graphics display 5/
boundary section
context menu 92
boundary selection, busbar model 93
boundary surface normal direction, up
and down 52, 229
Browse 42

Browse From 42
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Build All button
geometry 81
meshes 55, 100
built-in
constants, functions, and variables 33
materials 44, 84
variables 103
button object /14
Button, Form Objects I 16

CAD files, storing in database 197
CAD Import Module 201, 241
Cancel button 10, 29
case, parameter 27, 161
chamfer 201
Chemical Reaction Engineering Module
244
clip plane 53
cloud computing /71
Cluster Computing node 172, 175
cluster job 175
Cluster Sweep node 172, 175
color theme 15
coloring
materials 88
selections 88
command sequence |17, 125
Compact MPH-files 34
compiler |3
component coupling 163
Component node, adding materials 84
computing studies 68
COMSOL Client 12
COMSOL Compiler 13
COMSOL Desktop environment
customizing 27
on Linux 22
on macOS 22
overview 6

COMSOL Muttiphysics 12

native CAD format 42
opening 39
COMSOL Server |2
constants
mathematical and physical types 33
constraints 20/
context menu
domain and boundary sections 92
contextual tab 2/
contributing node 145
convergence analysis 63, 70
Convergence plot 9, 100
cooling
air stream 72
natural convection 77
coupling operator 63
Create Selection 32
button 140
custom settings window [ /9

customized desktop 27

dark theme 15
datasets, defined 24
default feature 91
degrees of freedom 63, 70
derivatives 33
Derived Values 70, 108
defined 24
Global Evaluation 69
Volume Maximum 64, 69, 108
Design Module 201, 207, 241
dimensions 201
DirectX 14
discretize 54
documentation, models 10, 33
domain level 92
domain section
context menu 92
domains

materials 87



remove from selection 87

variables scope 3/
down, surface normal direction 52, 229
draft, Model Manager 188
draft, saving as version 193

dynamic help 11, 29

ECAD Import Module 243
edges
variables scope 3/
Editor Templates window 116
eigenfrequency analysis 24
Electric Currents interface
defining boundary conditions 92
multiphysics 76, 96
overview 9/
electric potential 73
physics node 94
voltage drop, parameter 77
electrical heating 72
empty
selection 48
environment reflections 88
equation
built-in 91
user-defined 6/
evaluating
volume maximum 64, 106, 108
von Mises stress 64
Evaluation Group 70, 108
automatic re-evaluation 70
example
advanced, electrical heating 72
basic, structural mechanics 38
Excel® 246, 248
exclude data, Model Manager 196
exclusive node |44
executable /3
Export node 24
exporting images 109

expressions
Boolean 62
manual entry 65, 77
replacing 62, 103, 106
units, specifying 64
user-defined 6/

External Process window 9

file import 42
File menu 16
fillet 201, 207
find
parameters and variables 79
finite element
mesh 54
preconditioning 68
tetrahedra 54
Fixed Constraint node 47
Floating Network License /72
Form Editor I'1, 114
form objects 110
form union, geometry 81
frequency response 25
frequency-domain study 24
functions
advanced topics /28
built-in 33
mathematical 33
scope 77

Functions node 77

geometric dimensions
parameters, and 10, 26, 216
parametric sweep 77
geometry
building 77
CAD format 4
importing 41
in Application Libraries 80
loading from file 77, 80
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operations 20/

parameterized 10, 26, 77,81, 216
sequence 20/

settings window 8

Geometry node 36

Global Definitions node 23, 27
functions 77
parameters 77
scope 31, 77
variables 30

global parameters 27, 45, 66, 77
expression 26

gl TF-file format 109

graphics
rendering and hardware 4

Graphics menus 22

graphics object 113, 115, 124

Graphics toolbar
default view button 47, 58 96, 105
image snapshot button 109
zoom extents button 82, 102

Graphics window 7, 9, 22, 29
geometry, and 42
plot 56
rotate geometry 47, 101, 102
selecting boundary 47, 48, 96
toolbar 7
using 43, 83
zoom box 48

Ground, boundary condition 95

grouping
nodes 3/

Heat Transfer in Solids interface
defining boundary conditions 92
multiphysics 76, 96
overview 9|

Help window [ |
opening 23

high performance computing 171

Home tab 21/
HPC 171
hybrid parallelism /173

Image Snapshot button 109
images, creating thumbnails 109
importing
file 42
geometry 4/
information windows 7, 9, 29
initial conditions 8
Initial Values node
Electric Currents interface 92
Heat Transfer in Solids interface 92
Solid Mechanics interface 46
input fields /12
Input Parameters
for part 217
Isosurface plot 101, 170
iterative solver

preconditioning 68

Java file 37, 245

Joule heating
equations 9/
multiphysics coupling 96
multiphysics interface 75

Laminar Flow interface 149
Linux

clusters 175

version 22
Livelink™ add-ons 248
local database 178
loft 201
Log window 9, 56

macOS version 22
Material Browser
defined 10
material contents section 44, 85

material color and texture 88



material interface
mechanical contact 49
material rendering 88
materials
copper 72
domains, assigning 86
model tree 36
settings window 8
steel 44, 61
titanium alloy 72
Materials node 44, 84
mathematical constants and functions
33
MATLAB® 246
Max/Min Volume plot 65
Maximum and minimum values table
107
MEMS Module
thermal expansion, and /37
mesh
convergence analysis, and 63
density 66
finite element 54
model tree, and 36
parameterizing 66, 98
physics-controlled, default 98
refining 66
settings 54
unstructured tetrahedral 98
user-controlled 66, 98
mesh element size
parameters, defining 26, 99
settings 55
Message Passing Interface (MPI) 173
Messages window 9, 56
method 120
model 31
Method Call 120
Method editor |/, 120

M-file 37, 245

midsurface 201

modal tab 21

Model Builder 6, 110, 122
defined ||
example 36
expanding sections 9/
geometry import 4/
keyboard shortcuts 222
node sequence example 46
the ribbon, and 21/
toolbar 6
window 28

model history 37

Model Manager 6, 12, 17, 178
draft 188
exclude data 196
Open From 178
Save To 178
search 200
Versions window 186
workspace 99

model method 31

model tree 6, 28
building 23
defined 77
example 36
geometry 36
Global Definitions node 23,
Materials node 36, 44
Model Builder I/
nodes 23
Results node 24
ribbon 21
root node 23
Study node 24, 36

Model Wizard

45,77

adding physics 24, 40, 75, 182

Component node, and 24
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creating a new model /8
General Studies 40
More Studies 40
opening 39, 74
preset studies 76, 182
space dimension 39, 74
study 24, 75
models
defining 1|
discretization 54
documentation /0, 33
saving 83, 196
structural mechanics 38
symmetry 103
workflow 36
MPHBIN-file 24/
MPH-file 241
excluding data when saving 196
full and compact 34
saving 83, 109
MPHPHB-file 241
MPHTXT-file 241
MPI 173
multicore processors |71
multiphysics interface 76
multiphysics models 72
Multiphysics node 91, 92, 97, 139
multiphysics phenomena 72

Multislice plot 101

New 16
New Form wizard /10
Ribbon buttons tab 125
no solutions stored, message 35
node groups 3/
nodes 23
default feature 46

reordering 37

O Open 6
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Open From 7
Model Manager 178
OpenGL 14, 89
Override and Contribution 46, 145

parallel computing 171
parameter case 27, 161
parameter switch

parametric sweep 6/
parameters 26, |13, 124

adding 49

defining 66, 77

displaying value 50

editing 49, 81

expression 26, 66

global 27

meshes, and 66

name 66

range of values 67

results 30, 169

scope /7

using, referencing 94
Parameters node 77, 128
parametric geometry model 20/
parametric study 77
parametric sweep 26

all combinations 161

example 67

meshes, and 66

parameter switch 6/

range, defining 67

specified combinations 161
part 10, 216

Input Parameters 217
Part Libraries 216
physics

adding 75

boundary conditions 90

electromagnetic heating 75

heat transfer 75



Joule heating 72, 91
laminar flow 149
model tree 36
physics interface 18, 76
Electric Currents 76
Heat Transfer in Solids 76
Joule Heating 75
Laminar Flow 149
Solid Mechanics 40, 182
Plasma Module 244
player 71
plot
regenerate after solving 7|
plot group 24
3D, adding 6/
Plot window 29
plots
expression, user-defined 6/
max/min volume 65
model tree 36
regenerating 65
windows 9
points, variables scope 3/
Poisson'’s ratio 86
polynomial functions 54
preconditioning 68
preferences 4
preset studies 76
Preview MPH-files 35
principal stress 144
program code
model file for Java 37
model M-file 37
progress bar 10, 29

Progress window 9, 56

Quick Access Toolbar 6, 8, 22, 28

Recent |7
Record Code 121/

renaming plot groups 62
rendering options /4
reports, defined 24
reserved name 33
Reset Window Layout 125
resizable graphics window 2/
resolution of curvature, mesh 99
results
color table range 101, 103
derived values 64, 69, 108
displaying 57
parameters 30, 169
surface settings, modify 102
units, changing 57
Results node
3D plot group 65, 103, 143
busbar defaults 10/
subnodes 24
surface node, adding 103, 143
Revert to Saved |7
ribbon 7, 28
Add Material 44, 90, 148
Build All 82
Build Mesh 100
Compute 68, 142, 158
defined 8 21
example 7
importing geometry 4/
Model Builder 21
Physics tab 47, 139
Windows 10, 57, 205
Work Plane 203
Ribbon buttons 125
Ribbon buttons tab, New Form wizard
125
root node
default units 162
defined 23

model thumbnails 109
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Model Wizard 39
Run Application /6

running simulations /00

Save |7
Save As |7
Save To 17
Model Manager 78
saving files 83, 109
scheduler
Grid Engine 175
Open Grid Scheduler 175
PBS 175
SLURM 175
Windows HPC Server 175
scope
global definitions 77
parameters and variables 3/
parameters and variables, defined 26
variable name 32
search
parameters and variables 79
search, in Model Manager database 200
Select Study window 20
selecting
boundaries 50
multiple boundaries /40
using the graphics window context
menus 52
selecting internal surfaces 51/
Selection 32, 51, 88
empty 48
selection /40
Selection List window 10, 205
selection of geometry objects, domains,
boundaries, edges, and points 5/
Settings Form 120
Settings Forms 120
Settings window 6, 8, 23, 28

customized 119

settings window
keyboard shortcut 222
shared memory parallelism 71
Show Material Color and Texture 88
Show Selection Colors 88
simulation, running 100
Single form template /11, 122
skybox image 89
software rendering |4
Solid Mechanics interface 40, 182
add-on modules /37
Solved MPH files 34
solvers
configurations 68
iterative 67
stationary 56, 68
using 56
space dimension /8
specified combinations
parametric sweep 6/
Stationary study 40, 56, 182
steady-state study 24
Streamline Multislice plot 101
structural analysis 38
structural displacement field 54
structural mechanics
design 63
plastic deformation 61
stresses and strains 72, 86
von Mises stress 57
Structural Mechanics Module
application library 38
mechanical contact 49
thermal expansion 37
studies
computing solutions 68, 100
defining 56
example, multigrid iterative 68

example, stationary 56



model tree 36
preset 76
types 24
Study node 24
solution sequence 100
Suppress Selection Highlight 88
surface normal direction, graphics dis-
play 51
surface normal direction, up and down
52,229
Surface plot
busbar results /01
color table range 104
deformation 57
electrical current density 103
replace expression 103
settings 62
updating 102, 103

table

Maximum and minimum 107
Table window 9

graph plot 69

wrench results 64
Tables node 24
tables, evaluating 69
temperature 10/, 159
temperature, average /63
Test Application 116, 126
tetrahedron, polynomial functions 54
thermal expansion 72, 86
thicken 201
thumbnail image 109
time-dependent study 24
torque, applied 38

unit, changing 57, 143

up, surface normal direction 52, 229

update COMSOL Application Libraries
35

Update Solution 168

user interface
COMSOL Desktop 6
overview 6

user-controlled mesh 66

variables
advanced topics /28
built-in 33
example, built-in 69
expression 30
scope 77
scope, limit 31
Variables node 30, 77
version
control 182
opening 187
saving 182
Versions window, Model Manager |86
visualization 9
color table 10/, 103
Volume Maximum, evaluating 64, 106,
108
Volume plot 101

von Mises stress 57, 144

Window Layout /25
Windows list 57, 205
wizard

New Form /10
workflow 33

Workspace 110, 122

yield stress 38, 61

Young's modulus 86

zoom 59

Zoom Extents command | /8
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